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   Legal information 
Warning notice system 
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Proper use of Siemens products 
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WARNING  
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended 
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maintenance are required to ensure that the products operate safely and without any problems. The permissible 
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owner. 

Disclaimer of Liability 
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information in this publication is reviewed regularly and any necessary corrections are included in subsequent 
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Preface 

Preface 

Structure of the documentation 
The SINUMERIK documentation is organized in 3 parts: 
● General documentation 
● User documentation 
● Manufacturer/service documentation 
 
Information on the following topics is available at 
http://www.siemens.com/motioncontrol/docu: 
● Ordering documentation 

Here you can find an up-to-date overview of publications 
● Downloading documentation 

Links to more information for downloading files from Service & Support. 
● Researching documentation online 

Information on DOConCD and direct access to the publications in DOConWeb. 
● Assemble documentation individually on the basis of Siemens content with the  

My Documentation Manager (MDM), see http://www.siemens.com/mdm 
The My Documentation Manager offers you a range of features for creating your own 
machine documentation. 

● Training and FAQs 
Information on the range of training courses and FAQs (frequently asked questions) are 
available via the page navigation. 

Target group 
This document is designed for machine tool manufacturers. The present documentation 
provides all information required by the manufacturer to start up the software HMI sl. 

http://www.siemens.com/motioncontrol/docu:
http://www.siemens.com/mdm
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Standard version 
This documentation only describes the functionality of the standard version. Extensions or 
changes made by the machine manufacturer are documented by the machine manufacturer. 
Other functions not described in this documentation might be executable in the control. 
However, no claim can be made regarding the availability of these functions when the 
equipment is first supplied or in the event of servicing. 
Further, for the sake of simplicity, this documentation does not contain all detailed 
information about all types of the product and cannot cover every conceivable case of 
installation, operation or maintenance. 

Technical Support  
If you have any technical questions, please contact our hotline: 
 
 Europe / Africa 
Phone +49 180 5050 222 
Fax +49 180 5050 223 
Internet http://www.siemens.com/automation/support-request 

 

 
 America 
Phone +1 423 262 2522 
Fax +1 423 262 2200 
E-mail techsupport.sea@siemens.com 

 

 
 Asia / Pacific 
Phone +86 1064 719 990 
Fax +86 1064 747 474 
E-mail mailto:adsupport.asia@siemens.com 

 
 

 Note 
National telephone numbers for technical support are provided under the following Internet 
address: 
http://www.siemens.com/automation/service&support  

 

http://www.siemens.com/automation/service&support
http://www.siemens.com/automation/support-request
mailto:sea@siemens.com
mailto:adsupport.asia@siemens.com
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Questions about this documentation 
If you have any queries (suggestions, corrections) in relation to this documentation, please 
send a fax or e-mail to the following address:  
 
Fax +49 9131- 98 2176 
E-mail mailto:docu.motioncontrol@siemens.com 

A fax form is available in the appendix of this document. 

SINUMERIK Internet address 
http://www.siemens.com/sinumerik 

CompactFlash cards for users 
● The SINUMERIK CNC supports the file systems FAT16 and FAT32 for 

CompactFlash cards. You may need to format the memory card if you want to use a 
memory card from another device or if you want to ensure the compatibility of the 
memory card with the SINUMERIK. However, formatting the memory card will 
permanently delete all data on it. 

● Do not remove the memory card while it is being accessed. This can result in damage to 
the memory card and the SINUMERIK as well as the data on the memory card. 

● If you cannot use a memory card with the SINUMERIK, it is probably because the 
memory card is not formatted for the control system (e.g. Ext3 Linux file system), the 
memory card file system is faulty or it is the wrong type of memory card. 

● Insert the memory card carefully and the right way round into the memory card slot 
(observe indicators such as arrow or similar). This way you avoid mechanical damage to 
the memory card or the device. 

● Only use memory cards that have been approved by Siemens for use with SINUMERIK. 
Even though the SINUMERIK complies with the general industry standards for memory 
cards, it is possible that memory cards from some manufacturers will not function 
perfectly in this device or are not completely compatible with it (you can obtain 
information on compatibility from the memory card manufacturer or supplier). 

● The "CompactFlash® 5000 Industrial Grade" CompactFlash card from SanDisk has been 
approved for SINUMERIK (Order Number 6FC5313-5AG00-0AA0). 

EC Declaration of Conformity 
The EC Declaration of Conformity for the EMC Directive can be viewed/downloaded from the 
Internet at: 
http://support.automation.siemens.com 
under the Product Order No. 15257461or at the relevant branch office of the A&D MC 
Division of Siemens AG.  

mailto:docu.motioncontrol@siemens.com
http://www.siemens.com/sinumerik
http://support.automation.siemens.com
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Introduction 1
1.1 Commissioning manuals for SINUMERIK 840D sl 

Introduction 
The commissioning manuals for SINUMERIK 840D sl are divided into: 
● IBN CNC: NCK, PLC, drive 
● IBN CNC: Base software and HMI-Embedded 
● IBN CNC: Base software and HMI-Advanced 
● IBN CNC: Base software and HMI sl 
● IBN CNC: ShopMill 
● IBN CNC: ShopTurn 

Basic steps for commissioning SINUMERIK 840D sl 
Commissioning a SINUMERIK 840D sl is performed in 2 basic steps: 
1. Step 1 (described in IBN CNC: NCK, PLC, drive) 

– PLC commissioning 
– Drive commissioning 
– NCK commissioning 

2. Step 2 (described in IBN CNC: Base software and HMI-Embedded, IBN CNC: Base 
software and HMI-Advanced, IBN CNC: Base software and HMI sl, IBN CNC: ShopMill, 
IBN CNC: ShopTurn) 
– Commissioning functions in NCK/PLC 

References 
The SINUMERIK Safety Integrated Function Manual describes commissioning for 
SINUMERIK 840D sl/SINAMICS S120 Safety Integrated.  
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Commissioning overview 
The following figure is a schematic representation of the commissioning steps that are 
described in the first step (1) and in step (2): 

 
Figure 1-1 Commissioning overview  
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1.2 Principle representation of SINUMERIK 840D sl components for 
commissioning 

Introduction 
In principle, an NCU 7x0 contains the following components: 
● HMI 
● NCK 
● PLC 
● Drive 
● CP 
The HMI contained in the NCU is designated as internal HMI or as 
HMI-Embedded/ShopMill/ShopTurn/HMI sI.  
In addition, a PCU 50.3 can be connected to each NCU, on which the HMI-Advanced then 
runs (additional optional ShopMill/ShopTurn, HMI sl). This HMI is then designated as 
external HMI.  
For commissioning, the HMI Advanced Software is required or the commissioning tool 
derived from it. 
For the commissioning of the PLC, a PG/PC with 
SIMATIC STEP7 Version 5.3 Service Pack 3 is required. 
In order to connect multiple communication partners to socket X120, a network switch or hub 
(e.g. DMC20) is required.  

Commissioning components for internal HMI's 
Commissioning of an internal HMI requires a PG/PC. This PG/PC is connected via Ethernet 
to socket X120. 
The internal HMI displays its user interface via TCU (Thin Client Unit), which is connected 
via the Ethernet machine control panel (e.g. MCP 310) to socket X120. 

Commissioning components for external HMI's 
External HMIs are connected to socket X120. 
A PC/PG is required for commissioning of the PLC of the external HMI. This PG/PC is 
connected via Ethernet to socket X127. 

 

 Note 
To use the external HMI (PCU 50.3) without TCU, the internal HMI must be switched off. 
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Commissioning NCU 7x0 with internal HMI  
The following figure illustrates an example of a hardware and software arrangement for the 
commissioning of an NCU 7x0 with internal HMI.  

 
Figure 1-2 Principle representation SINUMERIK 840D sl  
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Commissioning NCU 7x0 with external HMI  
The following figure illustrates an example of a hardware and software arrangement for the 
commissioning of an NCU 7x0 with PCU 50.3 with external HMI.  

 
Figure 1-3 Principle representation of SINUMERIK 840D sl with PCU 50.3 
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Schematic representation of the NCU 7x0 
The following figure is a schematic representation of the NCU 7x0: 

 
Figure 1-4 Schematic representation of NCU 7x0 
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1.3 Initial commissioning procedure 

Introduction 
The mechanical and electrical installation of the system must be completed. At the start of 
installation and start-up, it is important for the control and its components to run-up properly 
and essential that the system complies with the application EMC Guidelines. 

Commissioning steps 
The steps required for installation and start-up are described below. The order is 
recommended but not mandatory: 
1. Checking the SINUMERIK 840D sl boot 
2. Making a communication connection to the PLC 
3. PLC installation and start-up 
4. Commissioning SINAMICS drives 
5. Commissioning communication NCK<->Drive 
6. NCK commissioning 

– Assigning NCK machine data for communication 
– Scaling machine data 
– Parameterizing axis data 
– Parameterizing spindle data 
– Parameterizing the measuring systems 

7. Drive Optimization 

See also 
NCK and PLC general reset (Page 35) 
Setting up the communication (Page 40) 
Creating a SIMATIC S7 project (Page 41) 
Commissioning SINAMICS drives (Page 65) 
Commissioning communication NCK<->Drive (Page 103) 
Overview Commissioning NCK (Page 109) 
Further optimization options (Page 222) 
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Safety information 2
2.1 Danger notices 

The following notices are intended firstly for your personal safety and secondly to prevent 
damage occurring to the product described or any connected devices and machines. Non-
observance of the warnings can result in severe personal injury or property damage. 

 

DANGER  
Only appropriately qualified personnel may commission/start-up SINUMERIK equipment. 
The personnel must take into account the information provided in the technical customer 
documentation for the product, and be familiar with and observe the specified danger and 
warning notices. 
When electrical equipment and motors are operated, the electrical circuits automatically 
conduct a dangerous voltage. 
When the system is operating, dangerous axis movements may occur throughout the entire 
work area. 
A potential fire hazard exists due to the energy being transferred in the equipment and the 
work materials used. 
All work on the electrical system must be performed after the system has been switched off 
and disconnected from the power supply. 

 

DANGER  
Proper transportation, expert storage, installation and mounting, as well as careful 
operation and maintenance are essential for this SINUMERIK device to operate correctly 
and reliably.  
The details in the catalogs and proposals also apply to the design of special equipment 
versions. 
In addition to the danger and warning information provided in the technical customer 
documentation, the applicable national, local, and system-specific regulations and 
requirements must be taken into account. 
Only protective extra-low voltages (PELVs) that comply with EN 61800-5-1 can be 
connected to all connections and terminals between 0 and 48 V.  
Should it be necessary to test or take measurements on live equipment, then the 
specifications and procedural instructions defined in Accident Prevention Regulation VBG 
A2 must be adhered to, in particular § 8 "Permissible deviations when working on live 
components". Suitable electric tools should be used. 
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WARNING  
Operating the equipment in the immediate vicinity (< 1.5 m) of mobile telephones with a 
transmitting power of > 1 W may lead to incorrect functioning of the devices. 
Connecting cables and signal lines should be installed so that inductive and capacitive 
interference does not in any way impair the automation and safety functions. 
SINAMICS equipment with three-phase motors conforms to EMC Directive 89/336/EEC in 
the configurations specified in the associated EC Certificate of Conformity. 

 

DANGER  
Repairs to devices that have been supplied by our company may only be carried out by 
SIEMENS customer service or by repair centers authorized by SIEMENS.  
When replacing parts or components, only use those parts that are included in the spare 
parts list. 
EMERGENCY STOP devices EN 60204-1 (VDE 0113 Part 1) must remain active in all 
modes of the automation equipment. Resetting the EMERGENCY STOP device must not 
cause an uncontrolled or undefined restart. 
Anywhere in the automation equipment where faults might cause physical injury or major 
material damage, in other words, where faults could be dangerous, additional external 
precautions must be taken, or facilities must be provided, that guarantee or enforce a safe 
operational state, even when there is a fault (e.g. using an independent limit value switch, 
mechanical locking mechanisms, EMERGENCY STOP devices) 
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2.2 ESD notices 
 

CAUTION  
The modules contain electrostatically sensitive devices. Discharge yourself of electrostatic 
energy before touching the components. The easiest way to do this is to touch a 
conductive, grounded object immediately beforehand (for example, bare metal parts of 
control cabinet or the protective ground contact of a socket outlet). 

 

NOTICE  
Handling ESD-modules: 
• When handling electrostatically sensitive devices, make sure that operator, workplace 

and packing material are properly grounded. 
• Generally, electronic modules must not be touched unless work has to be carried out on 

them. When handling PCBs make absolutely sure that you do not touch component pins 
or printed conductors. 

• Touch components only if: 
– You are permanently grounded via an ESD armband 
– You are wearing ESD shoes or ESD shoe-grounding-strips, if ESD flooring is 

available 
• Modules may only be placed on electrically conductive surfaces (table with ESD top, 

conductive ESD foam plastic, ESD packaging bags, ESD transport containers). 
• Keep modules away from visual display units, monitors or TV sets (minimum distance 

from screen 10 cm). 
• Do not bring ESD-sensitive modules into contact with chargeable and highly-insulating 

materials, such as plastic, insulating table tops or clothing made of synthetic materials. 
• Measurements on modules are allowed only if: 

– The measuring instrument is properly earthed (e.g., protective conductor) or 
– Before measuring with a floating measuring instrument, the probe is briefly 

discharged (e.g., touch the bare metal parts of the control housing). 
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Requirements for commissioning 3
3.1 General prerequisites 

General 
All components are dimensioned for defined mechanical, climatic and electrical 
environmental conditions. No limit value may be exceeded, neither during operation, nor 
during transportation. 

Limit values 
In particular, the following must be observed: 
● Power supply conditions 
● Pollution burden 
● Function-impairing gases 
● Ambient environmental conditions 
● Storage/transport 
● Shock stressing 
● Vibration stressing 
● Ambient temperature 

Prerequirements for components involved 
The complete system is connected mechanically and electrically, and has been verified in 
the following points: 
● When handling the components, all ESD measures are observed. 
● All screws are tightened with their prescribed torque. 
● All connectors are plugged correctly and locked/screwed. 
● All components are grounded and connected to shields. 
● The load capacity of the central power supply is taken into account. 
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Literature 
● All information about the structure of SINAMICS S120 drive components are contained in: 

SINAMICS S120 Equipment Manual 
● You can find all the instructions on how to connect the Ethernet interface here: 

Equipment Manual NCU 
● To initialize an Ethernet, see also: 

HMI commissioning; TCU commissioning 
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3.2 Software and hardware requirements 

Requirements 
For the commissioning of SINUMERIK 840D sl, the following points are required: 
● Connection to NCU 

– Network switch or hub to socket X120 
– Ethernet connection of PG/PC to socket X120 or socket X127 when commissioning 

the HMI PLC external 
– Ethernet machine control panel to socket X120 
– Ethernet connection from TCU for internal HMI internal to Ethernet machine control 

panel or 
– Ethernet connection from PCU 50.3 for HMI external to Ethernet machine control 

panel 
● Software prerequisites 

– SIMATIC STEP 7 as of Version 5.3 Service Pack 3 on PG/PC (SIMATIC Manager) 
– STEP7 package for NCU7x0 on PG/PC (Toolbox)  
– GSD file (Toolbox) 
– CompactFlash Card with software for internal HMI, NCK, PLC and drive 
– External HMI on PCU 50.3 or commissioning tool on PG/PC for the commissioning of 

internal HMI 
 

 
 

Note 
The order numbers of the SINAMICS drives, motors and encoders should be at hand. 
These are used for parameterization. 

 

● Hardware prerequisites 
– CompactFlash Card with software for internal HMI, NCK, PLC and drive attached in 

NCU 
– Dual ventilator fan/battery module (MLFB 6FC5348-0AA02-0AA0) to NCU (see 

following figure) 
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Figure 3-1 Dual fan/battery module 

 

 
 

Note 
Please dispose of used batteries in the specially provided collection points on site. 
This will ensure they are reused in the correct manner or treated as special waste. 
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3.3 Communication interfaces 

Introduction 
The figure below identifies the interfaces on the NCU that can be used for communication 
with the components involved in the installation and startup phase. They are: 
● X120 Ethernet interface for TCU and/or PCU (a network switch or hub enables 

expansion) 
● X130 Ethernet interface for factory network 
● for PG/PC 

– currently X120 Ethernet interface, internal for HMI 
– X127 Ethernet interface, external for HMI (PLC commissioning) 

● X126 PROFIBUS interface for machine control panel, for example 

 
Figure 3-2 Interfaces on the NCU for installation and startup 
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Network configuration characteristics 
For the individual, participating components that are connected with the NCU, the following 
properties are available for the network configuration.  

Table 3- 1 Network configuration 

Component socket Which network? IP address Subnet ID 
TCU/PCU 50.3 and 
currently PC/PG for 
commissioning of 
internal HMI 

X120 Ethernet 192.168.214.1 255.255.255.0 

Factory network X130 Ethernet Assigned by DHCP 
server, for example 
10.10.255.200 

 

PG/PC for 
commissioning of PLC 
external HMI 

X127 Ethernet 192.168.215.1 
or DHCP Server 

255.255.255.248 

 
 

3.4 Commissioning tool on PG/PC 

Precondition 
If a SINUMERIK 840D sl (internal HMI), consisting of a TCU, NCU 7x0 and SINAMICS S120 
drive components is commissioned, the commissioning tool on the PG/PC is required. 
To carry out a commissioning with PG/PC with the commissioning tool, the following points 
are required: 
● Commissioning tool is installed and started on the PG/PC. 
● There is an Ethernet connection to NCU (currently X120). 
● Since the standard Ethernet IP address is pre-assigned in the commissioning tool for 

X120 (192.168.214.1), there are no additional requirements. 
● If another Ethernet interface is used, e.g. connected to socket X127, then this must be 

adapted accordingly in the commissioning tool by selecting "Commissioning" > "HMI" > 
"NCU connection" > "Standard address" (for example, 192.168.215.1 for socket X127). 
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Example configuration 4
 

Overview 
The commissioning described in this manual orientates itself on an example configuration of 
the SINAMICS drive line-up.  
The following figure roughly shows the components. 
● An NCU 710 with: 

– A Single Motor Module for a motor with SMI (Sensor Module Integrated) 
– A Double Motor Module for two motors each with an SMC 20 (Sensor Module 

Cabinet) 
● An NX 15 with: 

– A Single Motor Module for a motor with two SMC 20 for the encoder 
● An Active Line Module 
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Figure 4-1 Example configuration 

Reference 
For further available DRIVE-CLiQ components of the SINAMICS drive line-up, see 
Catalog NC 61, Edition 2007/2008, SINUMERIK & SINAMICS; Order 
No.: E86060-K4461-A101-A2 
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Power on and boot up 5
5.1 Operating and display elements for run-up 

Introduction 
The figure below shows the operating and display elements of the NCU, which are important 
for switch-on and run-up of the SINUMERIK 840D sl: 
● Various error and status LEDs 
● Status display (seven-segment display) 
● RESET button 
● NCK start-up switch (left) 
● PLC mode selector switch (right) 
● CompactFlash slot 

 
Figure 5-1 Operating and display elements for installation and start-up at the NCU 

 

 
 

Note 
When you turn the start-up switch or operating mode switch, then the status display 
indicates the selected number/letters! 
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LED display 
The following LED displays indicate states at the NCU 
● RDY (yellow) -> Write/read access to the CompactFlash card, 

RDY (red) -> Watchdog (no NCK ready),  
RDY (green) -> NCK has powered up and is in cyclic operation 

● RUN (green) -> PLC running 
● STOP (yellow) -> PLC stopped 
● SU/PF (yellow) -> Force PLC active 
● SF (red) -> general PLC error, see diagnostic buffer 
● DP1 (red) -> Error on PROFIBUS (X126) 
● DP2 (red) -> Error on PROFIBUS (X136) 
● OPT (red) -> Error on option module 
● All yellow -> power up not possible (CompactFlash Card not plugged in or empty) 

NCK start-up switch 
The following switch settings are assigned: 
● 0 -> NCK in the operating mode 
● 1 -> NCK in the initial clear mode (standard MD) 
● 7 -> NCK is not started during run-up 
● 8 -> Display IP address for the factory network at X130 

– Turn the NCK start-up switch to "8" 
– Trigger RESET. 
– The individual values of the IP address are displayed as individual digits with points to 

separate the individual values. The last digit does not have a point. The IP address is 
displayed again after a short delay. In this state, no NCK operation is possible. 

PLC mode selector switch 
The following switch settings are assigned: 
● 0 -> NC in operating mode 
● 1 -> NC in operating mode, protected 
● 2 -> NC in operating mode 
● 3 -> PLC general reset 
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5.2 NCK and PLC general reset 

Introduction 
On initial startup of the PLC, a general reset of the PLC has to be performed after the NCU 
has been switched on and booted. 
To obtain a defined output state of the complete system (NCK and PLC), the NCK must also 
be deleted. 
● PLC general reset 

General reset puts the PLC in a defined initial state by deleting and initializing all system 
and user data. 

● Delete NCK data 
After a request to delete NCKs, all user data is deleted and the system data is 
reinitialized on the next NCK boot, e.g., after NCK Reset. 

Operating sequence for NCK and PLC general reset for initial boot 
If you want to boot the control for the first time, then the following operating sequence is to 
be executed for an NCK and PLC general reset: 
1. On the NCU, turn the startup switch and mode selector to the following positions: 

– NCK startup switch (SIM/NCK label) to "1" 
– PLC mode selector (PLC label) to "3" 

2. Execute a POWER ON (switch on control). 
3. Wait until the NCU displays the following continuously: 

– STOP LED flashes 
– SF LED is lit. 

4. Turn the PLC-mode selector to the following switch positions in succession: 
– Briefly to "2" 
– Back to "3" 

LED STOP first flashes with about 2Hz and then illuminates. 
5. Turn the switch for NCK and PLC back to position "0". 
6. After an error-free boot, the system generates the number "6" and a flashing point on the 

status display of the NCU. 
– LED RUN illuminates GREEN continuously. 

7. Re-execute a POWER ON. 
⇒ PLC and NCK are in cyclic operation. 
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Notes 
 

 Note 
If a hardware RESET or POWER ON is triggered in switch position "3" on the PLC mode 
selector, then the complete SRAM of the PLC is initialized and the diagnostic buffer is not 
deleted. All user data must be transferred again. 
If position "3" is selected for less than three seconds, no general reset is requested. 
Furthermore, the STOP LED remains unlit if the sequence "2"-"3"-"2" is not completed 
winthin three seconds after requesting general reset.  

 

 Note 
For the first startup, module replacement, battery failure, general reset request via the PLC 
and PLC upgrade, the PLC general reset is absolutely required. 

 

 Note 
Since no PLC start is executed after PLC general reset, the following alarms are displayed: 
• Alarm: "120201 Communication failed" 
• Alarm: "380040 PROFIBUS DP: Configuring error 3, parameter" 
• Alarm: "2001 PLC not booted" 
These alarms have no influence on how to continue. 

 

See also 
Separate NCK and PLC general reset (Page 280) 
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5.3 Boot completed 

Introduction 
After an error-free boot of the NCU, it displays the following: 
● Number "6" and a flashing point 
● LED RUN illuminates GREEN continuously 
To resume commissioning on the user interface of the HMI, the following operating 
sequence is necessary: 

Operating sequence for entry into commissioning 

1. Press <Menu Select>  , or the <F10> key on the PG/PC. 
2. Press "Commissioning". 

 
Figure 5-2 "Commissioning" menu 

3. Press "Password...". 
4. Press "Set password". 
5. Enter the manufacturer's password "SUNRISE". 
6. Press "OK". 
Run-up has been completed.  
In the following step, commissioning of the PLC is done with the SIMATIC Manager. 

See also 
Triggering a reset (warm restart) for NCK and drive system  (Page 61) 
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Connect PG/PC with the PLC 6
6.1 Start SIMATIC Manager 

Introduction 
SIMATIC Manager is a GUI for online/offline editing of S7 objects (projects, user programs, 
blocks, hardware stations and tools). 
The SIMATIC Manager lets you 
● manage projects and libraries, 
● call STEP 7 tools, 
● access the PLC online. 

Start SIMATIC Manager 
After installation, the SIMATIC Manager icon appears on the Windows desktop, and in the 
Start menu a "SIMATIC Manager" program item appears under "SIMATIC". 
1. Run SIMATIC Manager by double-clicking the icon, or from the Start menu (same as with 

all other Windows applications). 

User interface 
A corresponding editing tool is started up when you open the relevant objects. Start the 
program editor by double-clicking the program block you want to edit. 

Online help 
The online help for the active window is always called by pressing F1. 
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6.2 Setting up the communication 

Introduction 
To load the configuration into the PLC, the communications connection (Ethernet) from 
PG/PC to the PLC required for the loading must be secured. 

Operating sequence for establishing a communications connection to the PLC 
The communications connection to the PLC may be set from PG/PC via SIMATIC Manager 
with the following operating sequence: 
1. Select menu command: "Extras" > "Set PG/PC interface..." 
2. On the "Access Mode" tab, look for the interface used in the "Interface parameterization 

used" selection field, for instance: "TCP/IP -> Realtek RTL8139/810x F…" 
3. Confirm the parameterization with "OK". 

 

 
 

Note 
Parameterization of the PG/PC interface can be performed or changed from the SIMATIC 
Manager at any time. 
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PLC commissioning 7
7.1 Creating a SIMATIC S7 project 

Introduction 
It is necessary to create an S7 project for the basic commissioning of the PLC, the Ethernet 
and PROFIBUS communication as well as the input/output data areas of the NCK. To do this 
you will have to perform the following operations:   
● Create a project 
● Insert a SIMATIC station 300 
● Insert NCU 7x0 in HW Config 
● Configure the properties of the network interfaces 
● Insert machine control panel and hand wheel 

 

 
 

Note 
The toolbox must have been installed. 

 

What do you need to be aware of? 
Loading the PLC via network interface X130 is also possible if the IP address of the Ethernet 
interface is known. 
Loading an archive may always be carried out if the communication HMI-NCK is available. 

 

 Note 
Loading the PLC (CP840) is essential for the configuration of the data path for 
saving/restoring the drive data. See Section "Terminating hardware configuration and 
loading to PLC" (Page 54)  

 

Reference 
The PLC interface signals are described in "Parameter Manual 2"  
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7.1.1 Creating a project 

Introduction 
You have started the SIMATIC Manager. 

Operating sequence 
1. To create a new project, select the "File" > "New" menu command in the SIMATIC 

Manager. 
2. Enter the following project data in the dialog box: 

– Name (for example: PLC-Erst-IBN 840D sl) 
– Storage location (path) 
– Type 

3. Confirm the dialog with "OK". 
The SIMATIC Manager opens and displays the project window with an empty structure of 
the S7 project. 
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7.1.2 Inserting a SIMATIC station 300 

Introduction 
Before you introduce required hardware to the S7 project, the following steps are needed: 
● Insert a SIMATIC station 300 in the project 
● Starting HW-Config 

Operating sequence 
1. Select <right mouse button> "Insert new object" > "SIMATIC 300-Station" menu. 

 
Figure 7-1 Inserting a SIMATIC station 300 

2. Double-click on the symbol <SIMATIC 300 (1)>. 
3. Double-click on the symbol <Hardware>. 

The HW config for introducing required hardware is started. 
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4. In the menu, select "View" > "Catalog". The catalog with the modules is displayed (see 
following picture). 

 
Figure 7-2 HW-Config 
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7.1.3 Insert NCU 7x0 in HW config 

Introduction 
The user interface of "HW config" mostly displays (see the following figure):   
● Station window: 

The station window is split. The upper part displays the structure of the station 
graphically, and the lower part provides a detailed view of the selected module.   

● Hardware catalog 
In this catalog, the NCU 7X0 that you need for configuring the hardware is also included.  

Use the operating sequence described below to insert an NCU 720.1 as an example. 

Operating sequence 
1. Select "View" > "Catalog". 
2. Search for the module in the catalog under "SIMATIC 300" > "SINUMERIK" > "840D sl" > 

"NCU 720.1" (see following figure). 

 
Figure 7-3 NCU 720.1 in the catalog 

3. Select NCU 720.1 with the left mouse button, hold the mouse button down and drag to 
the "Station design" station window. 
After you release the mouse button, configure in the dialog box the interface properties of 
processor CP 840D sl located on NCU 720.1 (see next chapter). 
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7.1.4 Configuring the properties of the network interfaces 

Introduction 
In the STEP7 project, configure the following network interfaces you want to use to reach the 
NCU 7X0: 
● PROFIBUS DP, only with machine control panel for PROFIBUS (see PROFIBUS 

machine control panel on the HMI (Page 304)) 
● Ethernet 
● integrated PROFIBUS 
When creating a new project using the catalog, the configuration of the PROFIBUS interface 
is called automatically. 

Operating sequence for PROFIBUS DP 
1. You used the left mouse button to select NCU 720.1 and while holding down the mouse 

button you dragged it to the "Station design" station window. 
2. After you release the mouse button, configure the properties of PROFIBUS DP interface 

for socket X126 (machine control panel) in the dialog box (see figure below). 

 
Figure 7-4 Properties of PROFIBUS DP 

3. This is an Ethernet machine control panel, which does not require configuration. Select 
"Cancel". 

4. Module NCU 720.1 with SINAMICS S120 is inserted into the HW config (see figure 
below). 

 

 
 

Note 
With the <F4> key and confirmation of the question regarding "Reorganize", you can 
reorganize the display in the station window. 
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Figure 7-5 HW config with NCU 720.1 

Next, specify the properties for the Ethernet interface. 
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Operating sequence for Ethernet interface 
 

 Note 
Use socket X127 for commissioning of the PLC for the external HMI. No configuration of the 
Ethernet interface is required for this. This interface is set with IP address 192.168.215.1 as 
a default. 

 

For the first commissioning of a HMI with a PG/PC, it is necessary to configure an Ethernet 
interface. In our example, this involves the interface to socket X120. 
1. Double-click on "CP 840D sl" in the basic rack of the NCU 720.1. The dialog "Properties -

 Ethernet Interface CP 840D sl" is opened (see figure below). 

 
Figure 7-6 General properties of the CP 840D sl 
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2. After clicking on the "Properties" button, a new Ethernet interface can be created. 

 
Figure 7-7 Properties of the Ethernet interface 

The interface for socket X120 is used to commission the internal HMI. You will have to 
change the IP address. 

3. For socket X120, enter the IP address "192.168.214.1" and the Subnet screen form 
"255.255.255.0". 

4. Create the Ethernet interface using "New" and then "OK". 
5. Click on "OK" twice. 
Next, specify the properties for the integrated PROFIBUS. 
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Operating sequence for integrated PROFIBUS  
The integrated PROFIBUS for communication with the SINAMICS S120 requires a common 
Subnet ID. This Subnet ID has to be introduced to the external HMI in the MMC.ini. 
1. In the station window, click on the bus of the integrated "PROFIBUS 

PROFIBUS Integrated: DP Master System" and use the right mouse button to select the 
menu item "Object properties". 

2. Click on "Properties" on the "General" tab. 
Enter the ID "0046-0010" in field "S7 Sub-network ID". 

 
Figure 7-8 Integrated PROFIBUS subnet ID 

3. Click on "OK" twice. 

Telegram lengths and I/O addresses  
The telegram lengths and input/output addresses for communication between the PLC and 
the drive (can be viewed via the object properties of the integrated SINAMICS) are pre-
assigned by default and do not require any configuration.  
As the next step insert a NX component. 

See also 
Configuring the communication between the PLC and the drive (Page 282) 
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7.1.5 Insert NX in HW Config 

Introduction 
A NX component is contained in the example configuration, for the axis to control the 
spindle. This component must also be inserted in the HW Config when creating the 
SIMATIC-S7 project. 

Operating sequence 
1. Look for the NX module (NX10, NX15) in the hardware catalog under 

"PROFIBUS DP" > "SINAMICS" > "SINUMERIK NX…". 
2. Click with the left mouse button to select the "SINUMERIK NX ..." module and drag it to 

the "PROFIBUS Integrated DP master system" bus in the "Station design" station 
window. 

3. The "DP Slave Properties" dialog box opens. 

 
Figure 7-9 DP Slave Properties for NX15 

Enter the address for the integrated PROFIBUS in this dialog. 
The default value for the first NX15 is "15".  

 

 
 

Note 
The NX must be wired to the NCU via the DRIVE-CLiQ. A fixed DRIVE-CLiQ socket is 
provided for the relevant address. 
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The following table contains the wiring: 
 
Integrated PROFIBUS address DRIVE-CLiQ Socket 

NCU720 
DRIVE-CLiQ Socket 
NCU710 

10 X100 X100 
11 X101 X101 
12 X102 X102 
13 X103 X103 
14 X104 - 
15 X105 - 

1. Enter the address and press "OK". 

 
Figure 7-10 Insert NX 

2. Confirm the wiring notification with "OK". 
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3. After releasing the mouse button, the NX module is added (see figure below). 

 
Figure 7-11 NX in HW Config 

 

 
 

Note 
When deleting and re-inserting NX modules in the hardware config., new slot addresses 
are issued during addressing. In order to create a unique, and always the same 
configuration, we would recommend arranging addressing as shown in the following 
table: 

 

 
Integrated PROFIBUS 
address 

DRIVE-CLiQ socket, 
e.g.: NCU720 

Start address of first 
control slot 

Start address of last 
control slot 

15 X105 4340 4540 
14 X104 4580 4780 
13 X103 4820 5020 
12 X102 5060 5260 
11 X101 5300 5500 
10 X100 5540 5740 
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7.1.6 End hardware configuration and load to the PLC 

End hardware configuration and load to the PLC 
To end the overall configuration and generate the system data for the PLC, the project must 
be saved and compiled. 
1. Select the menu "Station" > "Save and compile". 
2. Click on the button "Load in module", to load the configuration to the PLC. 

The "Select target module" dialog mask automatically displays both configured 
communication partners (see figure below). 

 
Figure 7-12 Selecting target module 

3. Confirm with OK to load into these two modules. 
4. Confirm the dialog boxes displayed subsequently with "OK" or "No" for the query 

"…Should the module be started now (restart)?". 
 

 
 

Note 
You can test the communication interface at "Target system > Diagnosis > Operating 
mode". 

 

5. Close the "HW config" window. 
The next step is to create the PLC program. 
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7.2 Creating a PLC program 

Introduction 
The operating sequence for the creation of a PLC program describe how to create a basic 
program. 
The SIMATIC STEP7 documentation describes how to modify and extend an application 
program.  

7.2.1 Insert PLC basic program 

Introduction 
You have performed hardware configuration, have saved and compiled the project ad have 
created the system data for the PLC. 
You have installed the toolbox software, which also contains the libraries for the PLC basic 
program of an NCU 7x0. 
You are on the main screen of the SIMATIC Manager. 

Operating sequence to open library and copy sources, symbols and blocks 
1. Select the "File" > "Open" menu and then click on the "Libraries" tab (see figure below). 

 
Figure 7-13 Opening the library 

2. Select the library for the PLC basic program, e.g. "bp7x0_26" and confirm the dialog with 
"OK". 
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You have inserted the library and selected the PLC program under "PLC-Erst-IBN 840D 
sl" > "SINUMERIK" > "PLC 317 2DP" > "S7 Program" (see figure below). 

 
Figure 7-14 Copy the PLC program 

3. Copy the sources, modules and symbols to the PLC program 

Overwriting OB 1 
Inserting blocks overwrites the existing organization block OB1. Confirm the query as to 
whether you want to overwrite the block with "Yes". 
You have now created the PLC basic program. 
In the next section you will modify some of the data for the machine control panel in OB100. 
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7.2.2 Modifying Ethernet machine control panel in OB100 

Introduction 
The PLC basic program automatically transfers the machine control panel signals (MCP 
signals) and the addresses of the MCP in the HW config if the configuration is set up as laid 
out below. 

Operating sequence 
● Under "Blocks", double-click on "OB100" to open it. 

In OB100, the parameters below have to be preset: 
 MCPNum := 1 
 MCP1IN := P#E 0.0 
 MCP1OUT := P#E 0.0 
 MCP1StatSend := P#E 8.0 
 MCP1StatREc := P#E 12.0 
 MCPBusAddress := 192 
 MCPBusType = B#16#55 
You have completed the configuration of the PLC basic program. 
In the next step, you will load the project to the PLC. 
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7.3 Loading the project to the PLC 

Introduction 
For loading the configured PLC project, the following prerequisites must be fulfilled: 

Requirement 
● An Ethernet network connection exists between STEP7 and the PLC. 
● The configuration to be loaded corresponds to the actual station configuration. 
● NCU 7x0 is active 

– NCK is in cyclic mode 
– PLC in RUN or STOP mode 

Supplementary condition 
The following supplementary conditions regarding the system data blocks must be observed 
when the configuration is loaded: 
● HW Config 

When loading the configuration via HW Config, only the system modules and their 
associated system data blocks selected in HW Config when loading the configuration are 
loaded into the module. However, global data defined in SDB 210 is not loaded from the 
HW Config, for example. 
You have loaded the HW config to the module in the previous chapter "End hardware 
configuration and load to the PLC". 

● SIMATIC Manager 
When loading the configuration via the SIMATIC manager all the system data blocks are 
loaded into the module.  

 

 
 

Note 
When the PLC program is loaded in the "RUN" mode, each block loaded becomes active 
immediately. This can result in inconsistencies when executing the active PLC program. It 
is therefore advised to place the PLC in the "STOP" mode before loading the 
configuration, if this has not already been done. 
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Operating sequence for loading system blocks into the module 
1. To load the configuration of the system blocks change to the SIMATIC Manager. 
2. In the SIMATIC Manager in the PLC directory, select the directory "Blocks" > right mouse 

button> "Target system" > "Load" (see figure below), or the "Load" symbol. 

 
Figure 7-15 Loading system blocks  

3. If there is no connection to the destination system, you must confirm in sequence the 
following dialog requests with: 
– "OK" for "Check the required sequence of blocks for correct functioning" 
– "Yes" for "Do you want to load system data?" 
– "Yes" for "Must system data be deleted on the module and replaced by off-line system 

data?" 
– "No" for "The module is in STOP mode. Do you want to start the module (cold 

restart)?" 
You have loaded the PLC program to the PLC; the PLC is in "STOP" mode. 
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 Note 
If the PLC is stopped via the SIMATIC Manager, then it also has to be started via the 
SIMATIC Manager. Starting via the PLC mode selector is also possible. 

 

NOTICE  
A reset (warm restart) of the NCK is required for the PLC-NCK synchronization. 

 

7.4 Configuring an Ethernet machine control panel 
 

 Note 
If you have an Ethernet machine control panel with Ethernet hand wheel, a "7" for "Ethernet" 
must be entered for the hand wheel in the general machine data MD11350[0] 
$MN_HANDWHEEL_SEGMENT. 
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7.5 Triggering a reset (warm restart) for NCK and drive system 

Introduction 
On the HMI the "Commissioning" menu contains: 

 
Figure 7-16 "Commissioning" menu 

The STOP condition of the PLC which is taken by the PLC for a short time on loading is 
interpreted by the NC as a PLC failure with an appropriate alarm response.  

Alarm response 

● Press the button  and select the "Diagnostics > Alarms" menu. 
The system may display the following alarms on the HMI (see figure below): 

 
Figure 7-17 Alarm responses 

A "reset" (warm restart) is required for the PLC-NCK synchronization. 



PLC commissioning  
7.5 Triggering a reset (warm restart) for NCK and drive system 

 IBN CNC: NCK, PLC, drive 
62 Commissioning Manual, 03/2009, 6FC5397-2AP10-5BA0 

Operating sequence for initiating an NCK reset 

1. Press the key  and select the "Commissioning" menu. 
2. Press the "Reset..." softkey. 
3. Answer the question "Do you want to trigger a reset (warm restart) for the NCK and the 

entire drive system (all drive units)?" with the "Yes" softkey. 
The PLC goes to RUN mode. 

See also 
Drive diagnostics (Page 268) 
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7.6 First commissioning of the PLC completed 

First commissioning of the PLC completed 
You have completed the first commissioning of the PLC.  
The PLC and NCK are in the following state: 
● LED RUN illuminates GREEN continuously. 
● Status display shows a "6" with a flashing point. 

⇒ PLC and NCK are in cyclic operation. 
Continue with the steps for commissioning the SINAMICS drives.  
You can access the HMI as follows: 

 
Figure 7-18 PLC commissioning complete 
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Commissioning SINAMICS drives 8
 

Introduction 
You have completed commissioning of the PLC. 

Startup sequence 
The basic commissioning of the SINAMICS drives should be carried out in the following 
sequence: 
1. Creating factory settings (if commissioning has been completed) 
2. Configure the drive unit (including transfer of the DRIVE-CLiQ topology to the drive unit) 
3. Update the component firmware (if necessary) 
4. Parameterization of the infeed (if available) 
5. Parameterization of the drives (SERVOs) 
6. Optimize the drives 

 

 
 

Note 
Prior to starting commissioning, switch off all drive enables. 
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8.1 Introduction to commissioning of SINAMICS drives 

Introduction 
Commissioning of the SINAMICS drives is done in the operating area "Commissioning". 

Introduction to commissioning of SINAMICS drives 
1. After having completed commissioning of the PLC, you proceed from the following 

operating interface. 

 
Figure 8-1 "Commissioning" menu 

2. Press the "Drive system" softkey. 
There are two different ways to start in the "Commissioning" > "Drive system" menu: 
– The drive system has not yet been commissioned (see following figure). 

 
Figure 8-2 "Drive system" menu 
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This shows an NCU with factory settings that is ready for the first commissioning.  
A message appears that a first commissioning is required. 

 

 
 

Note 
Perform the first commissioning. Start with the operating sequences described in 
Section "First commissioning of the drive units (Page 71)". 

 

– The drive system has already been commissioned. 
Then start, for example, with the following user interface: 

 
Figure 8-3 Drive system has already been commissioned 

Infeed and drives (SERVOs) can be commissioned with the drive wizard (Page 79).  
The factory settings can be restored for the drive system with the vertical softkey "Factory 
settings...". A first commissioning must then be performed again for the drive units. 

 

 Note 
If commissioning is to be performed using the factory settings, then start with the operating 
sequence described in the Section "Restoring factory settings" (Page 68). 
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8.2 Activate the factory settings 

Introduction 
If a commissioning has already been performed, then the drive system can be reset to the 
factory settings with the "Factory settings..." function. 

 

NOTICE  
Before restoring the factory settings, ensure that the EP terminal (Enable Pulses) of the 
infeed (booksize: X21, chassis: X41) is de-energized. 

 

Procedure for activating factory settings   
1. You are in the "Commissioning" > "Drive system" menu. 

 
Figure 8-4 "Commissioning > Drive system" menu 
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2. Press the "Factory settings..." softkey. 

 
Figure 8-5 Question 

3. Press "Drive system" to restore the factory settings for all drive units used in the system 
(the NCU and NX modules). 

 
Figure 8-6 Switch factory settings off/on 
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4. Switch the control (NCU and NX) off (de-energized drive system) and then on again. 
Wait until communication has been established again with the NC. 

 
Figure 8-7 Communication re-established 

A message appears that a first commissioning is required.  
Start the first commissioning with the operating sequence described in the next section. 



 Commissioning SINAMICS drives 
 8.3 First commissioning of the drive units 

IBN CNC: NCK, PLC, drive 
Commissioning Manual, 03/2009, 6FC5397-2AP10-5BA0 71 

8.3 First commissioning of the drive units 

Introduction 
The following unit configuration is performed during the first commissioning of the drive units:  
● Transfer of the DRIVE-CLiQ topology to the drive unit 

With the transfer of the topology, all components connected on the DRIVE-CLiQ are 
detected and the drive-internal data traffic is initialized. 

● Drive-object assignment for PROFIBUS connection. 
The PROFIBUS connection via the relevant message frames has been specified with the 
configuration in the HW Config. 

Requirement 
● The drive unit is in the first commissioning state. 

Note the following: 
 

NOTICE  
 

Up to SINAMICS V2.5 
It must be ensured that compatible firmware has been loaded on all components. If 
necessary, stop the operation and first load the firmware from the CompactFlash card to 
all components of the drive unit(s). 

 

The operating sequence for loading the firmware are described in Section "Update of the 
component firmware". 

 

 
 

Note 
As of SINAMICS V2.5, an automatic firmware update is undertaken when powering up if 
required.  
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Operating sequence 
1. Press the "Drive units" softkey in the "Commissioning" > "Drive system" menu. 

 
Figure 8-8 "Commissioning" > "Drive system" > "Drive units" menu 

You are reminded once again that the drive unit is in the first commissioning state and 
that a unit configuration must be performed for the drive system. 
In the example for first commissioning it is assumed that compatible firmware has been 
loaded on all components. 

2. Press the "Drive system" vertical softkey. 
During the unit configuration there are a succession of messages containing information 
on the respective configuration of the individual drive components. 
Depending on the size of the drive system, this can take several minutes.  
Before the configuration is completed, the HMI displays the following query: 

 
Figure 8-9 Unit configuration, warm restart 
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3. Press "Yes" to perform an NCK power on restart (warm restart). 

 
Figure 8-10 Message after the unit configuration has been completed 

The unit configuration for the drive units and drive components of the NCU has been 
completed.  
If necessary check and correct the settings in the "PROFIBUS connection" dialog. 

4. Press "OK". 
If you have selected the NCU, then the drive components of the NCU are displayed. 

 
Figure 8-11 Unit configuration completed, NCU unit configuration 
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5. Press "Drive unit +". 
If you have selected the NX, then the drive components of the NX are displayed. 

 
Figure 8-12 NX unit configuration 

If necessary you can correct and/or modify the settings in the "PROFIBUS connection" 
dialog. 

6. Press "PROFIBUS connection" > "Change...". 

 
Figure 8-13 PROFIBUS NX connection 
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Figure 8-14 PROFIBUS NCU connection 

Check and, if required, correct the settings. 
7. Press <RECALL>. 

 
Figure 8-15 Overview of drive system 

The following section describes how you can perform an update of the component firmware 
using the "Load firmware..." function.  
In the example for first commissioning it is assumed that compatible firmware has been 
loaded on all components. 
In our example, skip this step and continue with the operating sequence for the 
Commissioning of the drive components (Page 79) (infeed, drive, encoder).  

See also 
Updating the component firmware (Page 76) 
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8.4 Updating the component firmware 

Loading firmware update for SINAMICS V2.5 and higher 
 

 Note 
SINAMICS V2.5 and higher 
As of SINAMICS V2.5, an automatic firmware update is undertaken when powering up the 
drive system if required.  
Manual updates for the individual components are not needed in such cases. 
After powering up and when operating the control, the drive firmware can however always be 
loaded from the CompactFlash card.  
You activate the "Load firmware ..." function from the "Commissioning > Drive system" 
menu. 

 

Loading firmware update for up to SINAMICS V2.4 
Prior to initial startup, all SINAMICS components should have the same firmware version. 
The software required for this forms part of the SINAMICS software and is stored on the 
CompactFlash card. An update of individual components may become necessary, after 
component replacement for example, and is required if the drive-specific alarm A01006 
"Firmware update required for DRIVE-CLiQ component <No.>“ appears. 

 

 Note 
If a firmware update is run before configuring the device, once this is complete continue with 
the "First commissioning of drive units (Page 71)" operating sequence. 

 

Requirement 
All components of the NCU/NX accessible (connected via DRIVE-CLiQ). 
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Operating sequence 
1. You are in the "Commissioning" > "Drive system" > "Drive units" > "Configuration" menu. 

 
Figure 8-16 Loading firmware 

2. Select the next drive module, the NCU or NX with the vertical softkey "Drive unit+/Drive 
unit-". 

3. Press the vertical sotfkey "Load firmware ...". 
4. The "Load all" softkey loads the firmware from the CompactFlash card to all DRIVE-CLiQ 

components of the drive unit (NCU or NX). 
 

 
 

Note 
Depending on the design of the SINAMICS drive group, a complete update of component 
firmware can take about 30 minutes. 
The component, on which a firmware update is performed, is indicated by a flashing LED.

 

5. Answer the query "Must firmware from the CompactFlash card be loaded to the 
component?" with "Yes". 

6. After the firmware update has been completed, the entire control (NCU, all NX and all 
DRIVE-CLiQ components (motor modules, encoder interfaces, etc.)) must be switched off 
(de-energized) and then switched on again so that the firmware update can take effect. 
Follow the instructions displayed on the HMI after the firmware update has been 
completed. 

You can now continue with the commissioning of the drive components (infeed, motor 
modules, encoders).  
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Loading firmware for the entire drive system 
The "Commissioning" > "Drive system" menu contains the option for activating a complete 
component firmware update for the entire drive system. 

 

 Note 
Depending on the design of the SINAMICS drive group, a complete update of component 
firmware can take about 30 minutes. 
The component, on which a firmware update is performed, is indicated by a flashing LED. 

 

 
Figure 8-17 Load firmware using the "Commissioning" > "Drive system" menu  
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8.5 Commissioning using a drive wizard 

Introduction 
Drive configuration is done with a drive wizard on the HMI. The following drive components 
are to be configured: 
● Active Line Module (infeed) 
● Motor module, motor and encoders (drives) 

Operating sequence for drive configuration  
The drive configuration can be opened by selecting "Commissioning" > "Drive system" in the 
menu. 

 
Figure 8-18 Overview of first commissioning 

1. Press the corresponding softkey for the drive object to be configured. 
– "Infeeds" 
– "Drives" for drive controls (SERVO) 

2. Configuration is performed in the following sequence: 
– You select the component with the vertical softkey "Infeed+/Infeed-" or "Drive+/Drive-" 
– Press the vertical softkey "Change" and follow the drive wizard with the horizontal 

softkey "Next >". 
– Parameterize the appropriate configuration in the dialog box that appears. 
The following chapters "Parameterization of infeed" and "Parameterization of drive 
components" list the dialog in detail. 
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8.5.1 Parameterization of infeed 

Introduction 
You want to configure/parameterize the Active Line Module of your SINAMICS> You have 
selected the menu "Commissioning" > "Drive system" > "Infeed". You are in the following 
menu: 

 
Figure 8-19 Menu "Infeed" > "Configuration" 
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Operating sequence 
1. If multiple infeeds are present, select the infeed with "Infeed+/Infeed-". 

The system detects that the infeed has not been commissioned and that a commissioning 
is required (see above figure). 

 

 
 

Note 
If necessary, check the network data using the "Network data" vertical softkey function 
(see section "Checking/setting network data settings for power supply (Page 274)"). 

 

The commissioning is performed with the "Change" vertical softkey. 
2. Press the vertical softkey "Change". 

 
Figure 8-20 Menu "Infeed" > "Configuration - names" (Change) 

3. If required, assign a drive object name or accept the default settings. 
4. Follow the drive wizard with the horizontal softkey "Next >". 
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5. The default values in the following dialogs are standard values and can be taken over 
with "Next >". 

 
Figure 8-21 Menu "Infeeds > "Configuration" with recognized ALM (Next 1) 

 
Figure 8-22 Menu "Infeed" > "Configuration - additional data" (Next 2) 
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Figure 8-23 Menu "Infeed" > "Configuration - terminal wiring" (Next 3) 

 
Figure 8-24 Menu "Infeed" > "Configuration - summary" (Next 4) 

6. This completes the configuration for the infeed. You can check the configuration in the 
summary. 
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7. Press the "Finish >" softkey. 

 
Figure 8-25 Saving a configuration 

8. Press "Yes". 
The data is saved as non-volatile data. 

 
Figure 8-26 Menu "Infeed" > "Configuration" > "Finish" 

9. Press the <RECALL> key in order to parameterize/configure the drives in the next step. 
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8.5.2 Parameterization of the drives 

Introduction 
The following components are parameterize/configured with the drive wizard: 
● Motor 
● encoder 
● Interface signals 

Parameterizing/configuring 
You are in the "Commissioning" > "Drive system" menu. 
ALL drives (SERVOs) are configured via the "Drives" softkey. 

 

 Note 
Motors with SMI (DRIVE-CLiQ) are automatically configured by the drive unit during the 
device configuration with a drive data set (DDS), but only with the motor measuring system; 
i.e. motors with SMI only have to be configured with the drive wizard when more than one 
drive/motor/encoder data set (DDS/MDS/EDS) or a second (direct) measuring system is 
required. 

 

If a motor module (power section) is connected to a motor of which the encoder is controlled 
via the SMC (Sensor Module Cabinet), i.e. not with a SMI (Sensor Module Integrated), then 
you have various configuration options at your disposal.  
● Standard motors, listed with corresponding motor data. 
● Third-party motors where the motor data can be freely configured. 
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Figure 8-27 Overview of first commissioning 

1. Press the "Drives" softkey in order to configure the following drives (SERVOs): 
– Drive with listed motor and encoder via SMC (without DRIVE-CLiQ) 
– Drive with third-party motor and additional second encoder via SMC (without DRIVE-

CLiQ) 
The drive wizard identifies the relevant design of the drives and guides you through the 
configuration in the dialog. 
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8.5.2.1 Commissioning of listed motor and encoder via SMC 

Introduction 
In our example a power section is to be configured with a listed motor and encoder. You 
have selected the "Commissioning" > "Drive system" > "Drives" menu. You are in the 
following menu: 

 
Figure 8-28 "Drives" > "Configuration" menu 

Operating sequence 
1. Select the drive with the vertical softkey "Drive+/Drive-". 

The system detects that the drive object has not been commissioned and that a new 
commissioning is required (see above figure). 
The new commissioning is performed with the "Change" vertical softkey. 

2. Press the vertical softkey "Change". 
 

 
 

Note 
If commissioning has already been performed, press "New commissioning" and "OK". 
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Figure 8-29 Menu "Drives" > "Configuration - motor module" (Change) 

3. The drive wizard identifies the power section (Motor module). You can assign a new drive 
object name or accept the default setting. 

4. Follow the drive wizard with the horizontal softkey "Next >". 
5. The following dialog boxes are displayed in succession for the configuration: 

 
Figure 8-30 Menu "Drives" > "Configuration - motor" (Next 1) 

6. In this dialog box, select the "Select standard motor from list" button. 
7. Select the motor with the "Cursor up / Cursor down" keys. 
8. Press "Next >". 
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Figure 8-31 Menu "Drives" > "Configuration - motor holding brake" (Next 2) 

9. You can select brake control in the "Configuration - motor holding brake" dialog. 
If a connected brake is detected during the unit configuration, the system will 
automatically activate the brake control and will by default display "Brake control 
according to procedural control" here. 

10. Press "Next >". 

 
Figure 8-32 Menu "Drives" > "Configuration - encoder" (Next 3) 

11. Press "Next >". 
An identification of the selected encoders is triggered (Encoder 1). 
The drive unit can identify encoders with EnDat protocol. These encoders are selected in 
the encoder list in the follow-up dialog boxes ("Configuration - Encoder 1" menu).  
The entry "No encoder" is selected in the encoder list for encoders that the drive unit 
cannot identify. 
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Figure 8-33 Selecting an encoder (Next 4) 

The encoder connected via SMC20 must be configured. 

 
Figure 8-34 Selecting an encoder from the list 

12. Select the motor encoder from the list: Select the encoder with the "Cursor up / Cursor 
down" keys. 

 

 
 

Note 
You can specify the following data using the "Details..." function: 
• Inversion of the actual speed value 
• Inversion of the actual position value 
• External zero mark 

 

Alternatively, the encoder system can be parameterized manually using the "Enter data" 
softkey. 
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13. Press "Enter data". 

 
Figure 8-35 Enter data 

Configure the encoder in the following fields: 
– Encoder type 
– Incremental tracks 
– Zero marks 
– Synchronization 

14. Press "OK". 
15. Press "Next >". 

 
Figure 8-36 Menu "Drives" > "Configuration - control type/setpoints" (Next 5) 

16. Set the number of required drive data sets (DDS). The default setting is the maximum 
possible number (8) of drive data sets. For optimal utilization of the drive unit, the number 
of drive data sets should be reduced to the number actually required. 
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17. Select the control type and the PROFIBUS message frame type. 
The default setting is the PROFIBUS message frame 116 for solution line / SINAMICS. 

18. Press "Next >". 

 
Figure 8-37 Menu "Drives" > "Configuration - BiCo interconnection" (Next 6) 

19. Select the assignment for the terminal for Input 2. OFF2 (Page 294). 
20. Press "Next >". 

 
Figure 8-38 Menu "Drives" > "Configuration - summary" (Next 7) 

21. The configuration of the drive (SERVO) with listed motor is completed. You can check the 
configuration in the summary. 

22. Press the "Finish >" softkey. 
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Figure 8-39 Menu "Drives > Configuration - summary" >"...save permanently..." (Finish) 

23. Confirm the query with "Yes". 
24. The next section describes how you can configure a drive (SERVO) with a third-party 

motor and a second encoder. 
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8.5.2.2 Commissioning of third-party motor and additional second encoder via SMC 

Introduction 
In our example a power section is to be configured with third-party motor and encoder. You 
have selected the "Commissioning" > "Drive system" > "Drives" menu. You are in the 
following menu: 

 
Figure 8-40 Menu "Drives" > "Configuration" (external motor) 

Operating sequence 
1. Select the drive with the vertical softkey "Drive+/Drive-". 

The system detects that the drive object has not been commissioned and that a new 
commissioning is required (see above figure). 
The new commissioning is performed with the "Change" vertical softkey. 

2. Press the vertical softkey "Change". 
 

 
 

Note 
If commissioning has already been performed, press "New commissioning" and "OK". 
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Figure 8-41 Menu "Drives" > "Configuration - motor module" (Change) 

3. The drive wizard identifies the power section (Motor module). You can assign a new drive 
object name or accept the default setting. 

4. Follow the drive wizard with the horizontal softkey "Next >". 
5. The following dialog boxes are displayed in succession for the configuration: 

 
Figure 8-42 Menu "Drives" > "Configuration - motor with externally supplied motor" (Next 1) 

6. Select "Enter motor data" and the motor type. 
7. Press "Next >". 
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Figure 8-43 Menu "Drives" > "Configuration - motor holding brake" (Next 2) 

8. You can select brake control in the "Configuration - motor holding brake" dialog. 
If a connected brake is detected during the unit configuration, the system will 
automatically activate the brake control and will by default display "Brake control 
according to procedural control" here. 

9. Press "Next >". 

 
Figure 8-44 Menu "Drives" > "Configuration - motor data 2" (Next 3) 

10. Use the "Cursor Up/Cursor Down" keys to select the parameters that need to be changed 
from the list of motor data. 

11. Enter the motor data. 
12. Press "Next >". If you have activated "Replacement circuit diagram data" and you select 

"Next >", the following dialog will appear: 
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Figure 8-45 Menu "Drives" > "Configuration - motor" > "Replacement circuit diagram data". (Next 

4) 

13. You can enter additional motor data. 
14. Press "Next >". 

If more than one encoder has been selected (see following figure), then the 
parameterization is run through for each individual encoder in succession with "Next > ". 

 
Figure 8-46 Menu "Drives" > "Configuration - encoder" (Next 5) 

15. Press "Next >". 
An identification of the selected encoders is triggered (Encoder 1/2). 
The drive unit can identify encoders with EnDat protocol. These encoders are selected in 
the encoder list in the follow-up dialog boxes ("Configuration - Encoder" menu).  
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Figure 8-47 Menu "Drives > Configuration" "Encoder 1" (Next 6) 

The encoder has been identified. 
 

 
 

Note 
You can specify the following data using the "Details..." function: 
• Inversion of the actual speed value 
• Inversion of the actual position value 
• External zero mark 
Alternatively, the encoder system can be parameterized manually using the "Enter data" 
softkey. 

 

16. Press "Next >". 

 
Figure 8-48 Menu "Drives > Configuration" "Encoder 2" (Next 7) 
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The second encoder has been identified. 
 

 
 

Note 
If EnDat encoders are detected, no further encoder parameterization need be performed. 
Parameterizations for the pole position ID/synchronization can be found at "Enter data". 

 

17. Press "Next >". 

 
Figure 8-49 Menu "Drives > Configuration" "Control type..." (Next 8) 

18. Set the number of required drive data sets (DDS). The default setting is the maximum 
possible number (8) of drive data sets. For optimal utilization of the drive unit, the number 
of drive data sets should be reduced to the number actually required. 

19. Select the control type and the PROFIBUS message frame type. 
The default setting is the PROFIBUS message frame 116 for solution line / SINAMICS. 

20. Press "Next >". 

 
Figure 8-50 Menu "Drives > Configuration" "BICO interconnection" (Next 9) 
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21. Select the assignment for the terminal for Input 2. OFF2 (Page 294). 
22. Press "Next >". 

 
Figure 8-51 Menu "Drives > Configuration" "Summary" (Next 9) 

23. The configuration of the drive (SERVO) with third-party motor is completed. You can 
check the configuration in the summary. 

24. Press the "Finish >" softkey. 

 
Figure 8-52 Menu "Drives > Configuration" "...save permanently..." (Finish) 

25. Confirm the query with "Yes". 
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Figure 8-53 Menu "Drives > Configuration"  

26. Select the drive with the vertical softkeys "Drive+ / Drive-" in order to configure additional 
drives (SERVOs). 
The configuration is again started with the vertical softkey "Change". 
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8.6 First commissioning of SINAMICS drive ended 

First commissioning of SINAMICS drive completed 
You have completed the first commissioning of the SINAMICS drives. 
The unit configuration and parameterization has been completed successfully: 
● All upper LEDs of the drives (SERVOs) are GREEN. 
● The lower LEDs of the drives (SERVOs) are always YELLOW. 
Continue with the steps for commissioning the NCK. You have chosen the "Commissioning" 
operating area. 
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Commissioning communication NCK<->Drive 9
 

Introduction 
The first commissioning of the PLC and SINAMICS drives is completed.  

What will be configured next? 
You will configure the NCK machine data, which communicates with the drive. These are: 
● General machine data 

General machine data required for communication with the drive via PROFIBUS, which 
have been preset with default values. These values may be taken over during first 
commissioning. These are:  
– The message frame type for transfer 
– The logical addresses for the PLC 

 

 
 

Note 
Up to software 1.5/2.5 
For an NX module, the logical address "6516" for the PLC must be entered in the 
general machine data MD13120[1] CONTROL_UNIT_LOGIC_ADDRESS. 

 

● Axis-specific machine data 
The axis component for transfer of the setpoints and actual values for the relevant axis, is 
set in the axis machine data. 
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Assigning general and axis-specific machine data   
The following table illustrates using the example of an SINAMICS S120 module structure 
(one NCU (CU), one ALM, three motor modules (MM)) the assignment of the NCK machine 
data for input/output address/telegram/message frame/actual value: 

 
SINAMICS 
S120 

STEP7 (HW-config) DP slave 
properties 

NCK machine data  
General MD 

NCK machine data  
Axis MD2) 

Component Message frame 
type/length1) 

I/O 
address1) 

MD13120[0] 
Control Unit 
I/O address 

MD13050 
[0-5]  
Axis I/O 
address 1) 

MD13060 
[0-5] 
Message 
frame type 1) 

MD30110/3
0220 
setpoint/act
ual value 
assignment 

MD30130 
Type of 
output 
Setpoint 

MM1 116. PZD-11/19 4100  4100 116 1 1 
MM2 116. PZD-11/19 4140  4140 116 2 1 
MM3 116. PZD-11/19 4180  4180 116 3 1 
X (not 
available) 

116. PZD-11/19 4220  4220 116 - 0 

X (not 
available) 

116. PZD-11/19 4260  4260 116 - 0 

X (not 
available) 

116. PZD-11/19 4300  4300 116 - 0 

CU 391. PZD-3/7 6500 6500     
ALM 370. PZD-1/1 6514      

1)Default value, do not change 
2) The axis-specific machine data for configuring setpoints and actual values are pre-
assigned using the "Assign axis" function (see section "Configuration of setpoint and actual 
value" (Page 106)) 
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9.1 Configuration input/output address and telegram 

Introduction 
The following general machine data are pre-assigned with a standard value for the 
PROFIBUS connection between the axes and drive (also see previous table). 
● MD13050 $MN_DRIVE_LOGIC_ADDRESS (axis address)) 
● MD13060 $MN_DRIVE_TELEGRAM_TYPE (telegram type) 
● MD13120 $MN_CONTROL_UNIT_LOGIC_ADDRESS (CU address) 

 

 
 

Note 
No adjustment is necessary here since these values correspond to those preassigned 
values in HW Config. 

 

PROFIBUS connection 
 
The connection between the relevant axes and drive via PROFIBUS can be viewed and 
sorted on the HMI in the "Commissioning" > "Drive system" > "Drive units" > "PROFIBUS 
connections" menu. 
The following diagram shows an example of the connection between the relevant axes and 
drive for an NCU. 

 
Figure 9-1 PROFIBUS NCU connection 
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9.2 Configuration setpoint/actual value 

Introduction 
The axis component for transfer of the setpoints and actual values for the relevant axis, is 
set in the axis machine data. The following axis machine data is to be adjusted for each axis 
(also see previous table): 
● MD30110 $MA_CTRLOUT_MODULE_NR (setpoint channel) 
● MD30220 $MA_ENC_MODUL_NR (actual value channel) 
● MD30130 $MA_CTRLOUT_TYPE (setpoint type of output) 
● MD30240 $MA_ENC_TYPE (actual value sensing) 
These axis/machine data can be automatically adapted using the "Assign axis" function or 
directly using the "Axis MD" function.   

Operating sequence in the "Assign axis" menu 
1. Select the "Commissioning" > "Drive system" > "Drives" menu. 

 
Figure 9-2 "Commissioning" > "Drive system" > "Drives" menu 

 

 
 

Note 
The "Assign axis" function can also be activated in the "Commissioning > Drive system" 
function using the vertical softkey bar. You must have selected a servo drive before doing 
this. 

 

2. Press the "Assign axis" horizontal softkey 
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Figure 9-3 Assignment of setpoints and actual values for axes to drive 

3. Use "Drive +"/"Drive -"/"Direct selection" to select the corresponding servo. 
4. Press "Change". 

 
Figure 9-4 "Assign axis" > "Change" menu 

5. Use the cursor keys to select the selection boxes for the setpoint or actual value. 
6. Use the <INPUT> key to open the selection box. 
7. Use the cursor keys to select the component. 
8. Press "Transfer". 
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Operating sequence in the "Commissioning" > "Machine data" > "Axis MD" menu  
1. Select the "Axis MD" softkey in the "Commissioning > Machine data" in the operating 

range. 
2. Select the corresponding axis using "Axis+". 
3. For the setpoint channel, search for MD30110 $MA_CTRLOUT_MODULE_NR. 
4. Enter the drive number. 
5. For the actual value channel, search for MD30220 $MA_ENC_MODUL_NR. 
6. Enter the drive number. 
7. For the setpoint type of output, search for MD30130 $MA_CTRLOUT_TYPE. 
8. Enter "1". 
9. For the actual value sensing, search for MD30240 $MA_ENC_TYPE. 
10. Enter "1" for incremental encoder or "4" for absolute value encoder. 
11. Select the next axis in each case with Axis+ and continue with Step 3 for the next drive. 

9.3 Commissioning communication NCK<->Drive completed 

Commissioning communication NCK<->PLC completed 
You have placed the following in operation: 
● PLC 
● SINAMICS drives 
● Communication NCK-PLC 
The basic commissioning is completed. Now you can move the axes. 
The next chapter, "Commissioning NCK", describes the parameterization of NCK regarding 
the connected machine by setting system variables. 
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NCK start-up 10
10.1 Overview Commissioning NCK 

Introduction 
The parameterization of NCK regarding the connected machine occurs by setting system 
variables.  
These system variables are called: 
● Machine data (MD) 
● Setting data (SD). 

See also 
Machine and setting data (Page 357) 
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10.2 System data 

10.2.1 Resolutions 
The following types of resolution, e.g. resolution of linear and angular positions, velocities, 
accelerations and jerk, must be differentiated as follows:    
● the input resolution, i.e. the input of data from the user interface or using the parts 

programs. 
● the display resolution, i.e. the display of data on the user interface. 
● the computational resolution, i.e. the internal representation of the data input through the 

user interface or the parts program. 

Input and display resolution 
The input and display resolution is specified via the control panel being used, whereby the 
display resolution of position values can be changed with MD9004 
$MM_DISPLAY_RESOLUTION (display resolution).    
MD9011 $MM_DISPLAY_RESOLUTION_INCH (INCH measuring system display resolution) 
can be used to configure the display resolution for position values with inch setting. This 
allows you to display up to six decimal places with the inch setting. 
For the programming of parts programs, the input resolutions listed in the Programming 
Guide apply. 

Computational resolution 
The computational resolution defines the maximum number of effective decimal places for all 
data the physical unit of which is referred to a length or an angle, e.g. position values, 
velocities, tool offsets, zero offsets, etc.   
The desired computational resolution is defined using the machine data 
● MD10200 $MN_INT_INCR_PER_MM (computational resolution for linear positions) 
● MD10210 $MN_INT_INCR_PER_ DEG (computational resolution for angular positions) 
.  
The default assignment is: 
● 1000 increments/mm 
● 1000 increments/degrees 
The computational resolution thus also determines the maximum achievable precision for 
positions and selected offsets. However, it is essential that the measuring system is adapted 
to this degree of precision. 

 

 Note 
Although the computational resolution is generally independent of the input/display 
resolution, it should have at least the same resolution. 
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Rounding 
The precision of angle and linear positions is limited to the computational resolution by 
rounding the product of the programmed value with the computational resolution to an 
integer number. 
Example of rounding: 
Computational resolution: 1000 increments/mm 
Programmed path: 97.3786 mm 
Effective value = 97.379 mm 

 

 Note 
To keep rounding easily understandable, it is better to use powers of 10 for the 
computational resolution (100, 1000, 10,000). 

 

Display resolution 
In MD9004 $MM_DISPLAY_RESOLUTION (display resolution), you can set the number of 
decimal places after the decimal point for the position values on the operator panel.   

Input and display limit values 
Limitation of the input values depends on the display features and on the input options on 
the operator panel. The limit is ten digits plus comma and sign.   
Example of programming in the 1 /10 - μm range: 
All the linear axes of a machine are to be programmed and traversed within the range of 
values 0.1 to 1000 mm. 
In order to position accurately to 0.1 μm, the computational resolution must be set to ≥ 104 

incr./mm. 
MD10200 $MN_INT_INCR_PER_MM = 10000 [incr./mm]: 
Example of related parts program: 
N20 G0 X 10000 Y 10000 
;Axes move to position X=10000 mm, Y=10000 mm 
N25 G0 X 50002 Y 20003 
;Axes move to position X=50002 mm, Y=20003 mm 
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Machine data 

Table 10- 1 Resolutions: Machine data 

Number Name of identifier Name / remarks  
General ($MM_ ... ) 
9004 DISPLAY_RESOLUTION Display resolution  
9011 DISPLAY_RESOLUTION_INCH Display resolution for INCH system of measurement  

 

 
General ($MN_ ... ) 
10200 INT_INCR_PER_MM Computational resolution for linear positions  
10210 INT_INCR_PER_DEG Computational resolution for angular positions  

Literature 
Function Manual Basic Functions; Velocities, traversing ranges, accuracy: Input/display 
resolution, computational resolution 



 NCK start-up 
 10.2 System data 

IBN CNC: NCK, PLC, drive 
Commissioning Manual, 03/2009, 6FC5397-2AP10-5BA0 113 

10.2.2 Normalization of phys. units of machine data and setting data 

Standard 
Machine and setting data having a physical unit are interpreted in the input/output units listed 
in the table "Scaling physical units of machine and setting data" by default, depending on the 
scaling system (metric/inch).    
The internally used units which the NC uses are independent and fixed.  

Table 10- 2 Normalization of phys. units of machine data and setting data 

Physical unit Input/output units for the standard basic system Internally used unit 
 Metric Inch  
Linear position 1 mm 1 inch 1 mm 
Angular position 1 degree 1 degree 1 degree 
Linear velocity 1 mm/min 1 inch/min 1 mm/s 
Angular velocity 1 rpm 1 rpm 1 deg./s 
Linear acceleration 1 m/s2 1 inch/s2 1 mm/s2 
Angular acceleration 1 rev/s2 1 rev/s2 1 degree/s2 
Linear jerk 1 m/s3 1 inch/s3 1 mm/s3 
Angular jerk 1 rev/s3 1 rev/s3 1 degree/s3 
Time 1 sec 1 sec 1 sec 
Position controller servo gain 1 s-1 1 s-1 1 s-1 
Rev. feedrate 1 mm/rev 1 inch/rev 1 mm/degree 
Compensation value linear position 1 mm 1 inch 1 mm 
Compensation value angular position 1 degree 1 degree 1 degree 

User-defined 
The user can define different input/output units for machine and setting data. 
For this purpose, 
● MD10220 $MN_SCALING_USER_DEF_MASK (activation of standardizing factors) and 
● MD10230 $MN_SCALING_FACTORS_USER_DEF[n] (standardizing factors of the 

physical quantities) 
allow you to set the adaptation between the newly selected input/output units and the 
internal units. 
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The following applies: 
Input/output unit selected= 
MD10230 $MN_SCALING_FACTORS_USER_DEF[n] * internal unit 
The selected I/O unit, expressed in the internal units 1 mm, 1 degree and 1 s must therefore 
be entered in MD10230 $MN_SCALING_FACTORS_USER_DEF[n]. 

Table 10- 3 Bit number and index for user definition 

Physical unit MD10220 bit number MD10230 index n 
Linear position 0 0 
Angular position 1 1 
Linear velocity 2 2 
Angular velocity 3 3 
Linear acceleration 4 4 
Angular acceleration 5 5 
Linear jerk 6 6 
Angular jerk 7 7 
Time 8 8 
KV factor 9 9 
Rev. feedrate 10 10 
Compensation value linear position 11 11 
Compensation value angular position 12 12 
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Example 1: 
Machine data input/output of the linear velocities is to be in m/min instead of mm/min (initial 
state). The internal unit is mm/s. 
MD10220 $MN_SCALING_USER_DEF_MASK Bit2 = 1 is used to enter the scaling factor for 
linear velocities as a user-defined value. 
The scaling factor is calculated using the following formula: 

 
Index 2 specifies the "linear velocity" (see above). 
Example 2: 
In addition to the change in example 1, the machine data input/output of linear accelerations 
is to be performed in ft/s2, instead of m/s2 (initial state). (the internal unit is mm/s2). 

 
Index 4 specifies the "linear acceleration" (see above). 
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Machine data 

Table 10- 4 Normalization of phys. units of machine data and setting data: Machine data 

Number Name of identifier Name / remarks Reference
General ($MN_ ... ) 
10220 SCALING_USER_DEF_MASK Activation of scaling factors  
10230 SCALING_FACTORS_USER_DEF[n] Scaling factors of physical quantities  
10240 SCALING_SYSTEM_IS_METRIC Basic system metric  
10250 SCALING_VALUE_INCH Conversion factor for switchover to inch system  
10260 CONVERT_SCALING_SYSTEM Basic system switchover active  
10270 POS_TAB_SCALING_SYSTEM System of measurement of position tables T1 
10290 CC_TDA_PARAM_UNIT Physical units of the tool data for CC  
10292 CC_TOA_PARAM_UNIT Physical units of the tool edge data for CC  
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10.2.3 Modifying scaling machine data 
The scaling of machine data having physical units is defined by the following machine data:   
● MD10220 $MN_SCALING_USER_DEF_MASK (activation of standardizing factors) 
● MD10230 $MN_SCALING_FACTORS_USER_DEF (standardizing factors of the physical 

quantities) 
● MD10240 $MN_SCALING_SYSTEM_IS_METRIC (basic system metric) 
● MD10250 $MN_SCALING_VALUE_INCH (conversion factor for switchover to INCH 

system) 
● MD30300 $MA_IS_ROT_AX (rotary axis) 
When scaling machine data are modified, all machine data affected by this modification due 
to their physical unit are converted with the next NCK reset. 
Example: Redefining an A1 axis from linear to rotary axis. 
The control has been started up with default values. Axis A1 is declared as a linear axis. 
● MD30300 $MA_IS_ROT_AX[A1] = 0 (no rotary axis) 
● MD32000 $MA_MAX_AX_VELO [A1] = 1000 [mm/min] (max. axis velocity). 
Axis A1 is now declared as a rotary axis containing the following machine data: 
● MD30300 $MA_IS_ROT_AX[A1] = 1 (rotary axis) 
● MD32000 $MA_MAX_AX_VELO [A1] = 1000 [mm/min] (max. axis velocity). 
With the next NCK reset, the control system recognizes that axis A1 is defined as a rotary 
axis and standardizes MD32000 $MA_MAX_AX_VELO to [rev./min] with reference to a 
rotary axis. 
● MD30300 $MA_IS_ROT_AX[A1] = 1 (rotary axis) 
● MD32000 $MA_MAX_AX_VELO [A1]= 2.778 [rev./min] 

 

 
 

Note 
If a scaling machine data item is altered, then the control outputs alarm "4070 Scaling 
data changed". 

 

Modifying manually 
The following procedure is recommended when modifying scaling machine data manually: 
1. Set all scaling machine data 
2. Carry out NCK reset 
3. Set all dependent machine data after the NC has powered up. 
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10.2.4 Loading default machine data 
The default machine data can be loaded in different ways.   

HMI startup 
HMI startup via the HMI standard user interface: Operating area menu  "Diagnostics" > 
"NC/PLC" 
● Button: "Delete NCK Data" 
● Button: "NCK RESET" 

 

NOTICE  
 

With deleting the NCK data, all user data are lost. 
To avoid data loss, a series commissioning file should be created before the NCK data 
are deleted. The way to create a series machine start-up file is laid out in the Chapter 
"Creating a series machine start-up file". 

 

MD11200 $MN_INIT_MD 
Using the entry values listed below in MD11200 $MN_INIT_MD (loading the standard 
machine data for the "next" NC boot), you can load various data storage areas with default 
values at the next NC boot. 
After setting the machine data, an NCK reset must be carried out: 
1. NCK RESET: The machine data is activated. 
2. NCK RESET: Depending on the entry value, the corresponding machine data is set to its 

standard values and the MD11200 $MN_INIT_MD is reset to value "0". 

Input values 
MD11200 $MN_INIT_MD = 1 
At the next NC power-up, all machine data (with the exception of the memory configuring 
data) are overwritten with default values. 
MD11200 $MN_INIT_MD = 2 
At the next NC boot, all memory-configuring machine data are overwritten with default 
values. 
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10.2.5 Switching over the measuring system 
The measuring system is switched over for the entire machine using a softkey in the 
"Machine" HMI-Advanced operating area. The switchover is only accepted if:   
● MD10260 $MN_CONVERT_SCALING_SYSTEM=1. 
● Bit 0 of MD20110 $MC_RESET_MODE_MASK is set in every channel. 
● All channels are in the Reset state. 
● Axes are not traversing with JOG, DRF or PLC control. 
● Constant grinding wheel peripheral speed (GWPS) is not active. 
Actions such as parts program start or mode change are disabled for the duration of the 
switchover. 
If the switchover cannot be performed, this is indicated by a message in the user interface. 
These measures ensure that a consistent set of data is always used for a running program 
with reference to the system of measurement. 
The actual switchover of the system of measurement is performed internally by writing all the 
necessary machine data and subsequently activating them with a Reset. 
MD10240 $MN_SCALING_SYSTEM_IS_METRIC and the corresponding 
G70/G71/G700/G710 settings in MD20150 $MC_GCODE_RESET_VALUES are switched 
over automatically and consistently for all configured channels. 
The value of machine data: MD20150 $MC_GCODE_RESET_VALUES[12] varies between 
G700 and G710. 
This process takes place independently of the protection level currently set. 

System data 
When changing over the measuring system, from the view of the user, all length-related 
specifications are converted to the new measuring system automatically. This includes: 
● Positions 
● Feed rates 
● Acceleration rates 
● Jerk 
● Tool offsets 
● Programmable, settable and work offsets external and DRF offsets 
● Compensation values 
● Protection zones 
● Machine data 
● Jog and hand wheel factors 
After switching, all above mentioned data is available in the physical units according to 
Chapter "Standardizing of physical units of machine and setting data". 
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Data for which no unique physical units are defined, such as: 
● R parameters 
● GUDs (Global User Data) 
● LUDs (Local User Data) 
● PUDs (Program global User Data) 
● Analog inputs/outputs 
● Data exchange via FC21 
are not converted automatically. The user is prompted to take the current valid measuring 
system MD10240 $MN_SCALING_SYSTEM_IS_METRIC into consideration.  
The current system of measurement setting can be read at the PLC interface via the "inch 
system" signal DB10.DBX107.7. DB10.DBB71 can be used to read out the "system of 
measurement change counter". 

Machine data 

Table 10- 5 Switching over the unit system: Machine data 

Number Name of identifier Name / remarks Reference
General ($MN_ ... ) 
10240 SCALING_SYSTEM_IS_METRIC Basic system metric  
10250 SCALING_VALUE_INCH Conversion factor for switch-over to inch system  
10260 CONVERT_SCALING_SYSTEM Basic system switch-over active  

 

 
axis spec. ($MA_ ... ) 
32711 CEC_SCALING_SYSTEM_METRIC System of measurement of sag compensation G2 

Literature 
Function Manual; speed, setpoint/actual-value systems, control: Metric/inch measuring 
system 
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10.2.6 traversing ranges 

Computational resolution and traversing ranges 
The range of values of the traversing ranges directly depends on the selected computational 
resolution (see Subsection "Resolutions" (Page 110)).   
With the default assignment of the machine data for the computational resolution 
● 1000 inc./mm 
● 1000 inc./deg. 
the following traversing ranges result: 

Table 10- 6 traversing ranges 

 Traversing range in the metric system Traversing range in the inch system 
Linear axes ± 999,999.999 [mm; deg.] ± 399,999.999 [inch; deg.] 
Rotary axes ± 999,999.999 [mm; deg.] ± 999,999.999 [inch; deg.] 
Interpolation parameters I, J, K ± 999,999.999 [mm; deg.] ± 399,999.999 [inch; deg.] 

10.2.7 Positioning accuracy of the control system 

Computational resolution and traversing ranges 
The positioning accuracy depends on:  
● the computational accuracy (internal increments/(mm or degrees)) 
● the actual-value resolution (encoder increments/(mm or degrees)). 
The rougher resolution of both determines the positioning accuracy of the NC. 
The input resolution, the position control and interpolation clock do not affect the accuracy. 

Machine data 

Table 10- 7 Positioning accuracy: Machine data 

Number Name of identifier Name / remarks Reference
General ($MN_ ... ) 
10200 INT_INCR_PER_MM Computational resolution for linear positions G2 
10210 INT_INCR_PER_DEG Computational resolution for angular positions G2 
Axisspecific ($MA_ ... ) 
31020 ENC_RESOL[n] Encoder pulses per revolution  
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10.2.8 Cycle times 
On the SINUMERIK 840D sl the system clock cycle, the position controller cycle, and the 
interpolation cycle of the NC are based on the DP cycle time configured in STEP 7 HW 
config. See Chapter "SIMATIC create S7 project".   

System basic cycle 
The system clock cycle is set fixed to the ratio of 1:1 with regard to the DP cycle time. The 
active value is displayed in the machine data MD10050 $MN_SYSCLOCK_CYCLE_TIME 
(system cycle). It cannot be changed.   

Position controller cycle 
The position controller cycle (MD10061 $MN_POSCTRL_CYCLE_TIME) is set to the fixed 
ratio 1:1 with respect to the system clock cycle. It cannot be changed.   

Position control cycle offset 
The position control cycle offset TM is automatically determined in the default setting 
(MD10062 $MN_POSCTRL_CYCLE_DELAY=0).  
The effective position controller offset is displayed in the MD10063[1]. 
The following values can be read out via the 
MD10063 $MN_POSCTRL_CYCLE_DIGNOSIS: 
● MD10063[0]= TDX 
● MD10063[1]= TM 
● MD10063[2]= TM + TLag max 
The following conditions must be met for explicit specification of the position controller cycle 
offset (MD10062 $MN_POSCTRL_CYCLE_DELAY!=0): 
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● The cyclic communication with the DP slaves (drives) must be completed before the 
position controller is started. 
Condition: TM > TDX 

● The position controller must be completed before the DP cycle/system clock is 
completed. 
Condition: TM + TPosition control max < TDP 

 
Figure 10-1 Position control cycle offset compared to PROFIBUS DP cycle 

Key to Fig. above: 
TLag:CPU time required by position controller 
TDP:DP cycle time: DP cycle time 
TDX:Data Exchange Time: Total transfer time for all DP slaves 
TM:Master time: Offset of the start time for NCK position controller 
GC: Global Control: Broadcast message for cyclic convergence of the equidistance between 
DP master and DP slaves 
R: CPU time 
Dx: Useful data exchange between the DP master and DP slaves 
MSG: Acyclic services (e.g. DP/V1, pass token) 
RES: Reserve: "Active pause" until the isochronous (equidistant) cycle has expired 
Error response 
● Alarm: "380005 PROFIBUS DP: Bus access conflict, type t, counter z" 
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Cause of errors/error handling 
● t = 1 

The position-control cycle offset selected is too small. The cyclic PROFIBUS 
communication with the drives was not yet completed with the start of the position 
controller. 
– Remedy: Increase the position-control cycle offset. 

● t = 2 
The position-control cycle offset selected is too large. The cyclic PROFIBUS 
communication with the drives started before the position controller had finished. The 
position controller requires more CPU time than available within the DP cycle. 
– Remedy: Decrease the position-control cycle offset 
Or 
– Remedy: Increase the DP cycle time. 

The DP cycle time is set using STEP7 "HW-Config". See Chapter "SIMATIC create S7 
project". 

Interpolation cycle 
The interpolator cycle may be chosen freely as a whole multiple of the position control cycle.   
● MD10070 $MN_IPO_SYSCLOCK_TIME_RATIO (factor for the interpolation cycle) 
Error response 
● Alarm: "4240 CPU time overflow on the IPO or position controller level" 
Cause of errors/error handling 
The DP cycle time/position controller cycle, the interpolation cycle, or the NC CPU time 
share is set in such a way that not enough CPU time is available for one of the two cyclic 
levels of the NCK (position controller or interpolator). 
Remedial action: 
Calculate the maximum values for Tpos max and TIPO max (see above) and adapt the following 
machine data: 
● MD10185 $MN_NCK_PCOS_TIME_RATIO (CPU time share NCK) 
● MD10070 $MN_IPO_SYSCLOCK_TIME_RATIO (factor for the interpolation cycle) 
● MD10050 $MN_SYSCLOCK_CYCLE_TIME (system clock cycle) 

 

 
 

Note 
You must adjust the system clock cycle by changing the DP cycle time using STEP7 
"HW-Config".  

 

Literature 
Function Manual special functions; cycle times 
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Machine data 

Table 10- 8 Cycle times: Machine data 

Number Identifier Name / remarks Reference
General ($MN_ ... ) 
10050 SYSCLOCK_CYCLE_TIME System clock cycle/only display data; is always 

equal to the equidistant PROFIBUS DP cycle. 
Note: For SINUMERIK solution line for display 
only! 

 

10060 POSCTRL_SYSCLOCK_TIME_RATIO Factor for the position control cycle/is set fixed to 
the factor 1. 

 

10061 POSCTRL_CYCLE__TIME Position Controller cycle  
10062 POSCTRL_CYCLE_DELAY Position control cycle offset  
10063 POSCTRL_CYCLE_DIAGNOSIS [0] = DP cycle time 

[1] = Position controller cycle offset 
[2] = Position controller cycle offset + max. 
computation time needed by the position controller 

 

10070 IPO_SYSCLOCK_TIME_RATIO Factor for the interpolator cycle/can be freely 
selected in integer multiples. 

 

10185 NCK_PCOS_TIME_RATIO Computation time ratio NCK  

 
 

CAUTION  
If you change the cycle times, check the behavior of the controller in all operating modes 
before you finish commissioning. 

 

 
 

 Note 
The smaller the cycle times (PROFIBUS DP cycle) chosen, the greater the control quality for 
the drive and the better the surface quality on the workpiece. 
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10.2.9 NCK utilization 

Introduction 
You can view utilization of system resources for the NCK on the HMI under the menu 
"Diagnostics > Service displays > System resources".   

 
Figure 10-2 NC utilization   

 The following machine data is taken into consideration for displayed runtimes (see Chapter 
Cycle times (Page 122)): 
● MD1061 $MD_POSCTRL_CYCLE_TIME = MD10050 $MN_SYSCLOCK_CYCLE_TIME 

(System basic cycle)   
● MD1070 $MD_IPO_SYSCLOCK_TIME_RATIO (factor for the interpolation cycle)  
● MD1071 $MD_IPO_CYCLE_TIME (interpolation cycle)  

What will be displayed? 
In the display of the "System resources" menu, the values have the following meaning: 
● Area "Nett runtime (purely CPU time)": 

Active times (current, minimum and maximum) are displayed in the nett values.  
The relation to the machine data can be seen from the displayed values.  

● Area "Gross runtime (time from start to end)": 
The corresponding total utilization of the system (position controller + interpolator) is 
displayed, based on the net values.  
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● Line "NCU load by position controller and interpolator": 
 

 
 

Note 
The current, minimum and maximum utilization of the NCK is displayed.  
In order to have sufficient reserves for program processing, maximum utilization in reset 
condition when pressing the <Reset> key should be in the range of 60-65%.  

 

● Line "Capacity of interpolator buffer": 
The capacity indicator MD28060 $MC_NUM_IPO_Buffer_SIZE is indicated in %.  
This display indicates whether batch preparation for batch processing can commence.  
Jerky processing in continuous-path mode, if for instance a number of short traversing 
blocks have been programmed in succession, is a typical indicator of the IPO buffer 
idling.  
Capacity indication is channel-specific. 
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10.2.10 Velocities 

Max. axis velocity or spindle speed 
The maximum possible axis velocities and spindle speeds depend on the machine design, 
drive dynamics and the encoder limit frequency of the individual drives.  

Max. progr. tool path velocity 
The maximum programmable tool path velocity results from the maximum axis velocities of 
the axes involved in the path programmed. 

Max. tool path velocity 
The maximum tool path velocity at which traversing is possible within a parts program block 
results as follows:  
 

 
 

Upper limit 
To guarantee that parts program blocks are executed continuously (control margin), the NC 
limits the tool path velocity within a parts program block to 90% of the max. possible tool 
path velocity as follows:  
 

 
 
For example, in the case of parts programs generated by means of CAD system, which 
contain extremely short blocks, this limiting of the path velocity can result in a strong 
reduction of the path velocity over several parts program blocks. 
The function "Online compressor" can help to avoid such sudden velocity dips. 

Literature 
Programming Manual Work Preparation: Compressor COMPON/COMPCURVE 
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Voltage limit 
The minimum tool path or axis velocity at which traversing is possible results from:  
 

 
 
(for the computational resolution, see Chapter "Resolutions" 
If Vmin is not reached, no traversing movement is carried out. 

Literature 
Function Manual Basic Functions; Velocities, traversing ranges, accuracy: Velocities 
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10.3 Memory configuration 

Introduction 
On the SINUMERIK 840D sl, the persistent data are divided into various independent areas: 
● SIEMENS 
● Vendor 
● Users 

SRAM 
For historical reasons, SRAM is still named as the memory medium at various points in 
relation to persistent data. For SINUMERIK solution line, this only applies insofar as SRAM 
is also sometimes used in the context of persistent data management. However, when a 
SINUMERIK solution line control system is in continuous operation, the data are physically 
stored in the much more powerful DRAM. Only when the control system is switched off are 
the data saved to a persistent data storage area. SRAM is also used for specific control 
systems. 
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Memory division 
The figure below shows how NCK persistent data is divided: 

 
Figure 10-3 Memory division 

 
Legend Description User 
1 Part programs and OEM cycles can be set via 

MD 18352 $MN_U_FILE_MEM_SIZE 
User 

2 In addition to part programs and OEM cycles, can be set via 
MD 18353 $MN_M_FILE_MEM_SIZE 

User 

3 SIEMENS cycles Siemens AG 
4 Reserved Siemens AG 
5 RAM in NCK User 
6 RAM in NCK, contains the system and user data accessed by the 

NCK during program execution. 
Numbers for tools, frames, etc., are set by default. 

User 

7 Additional memory (optional) Available to users as an option and 
can be used for RAM in NCK or for 
part programs and cycles. 

Memory display 
The memory available in the NCK is displayed on the user interface, e.g., HMI Advanced, 
under: Operating area "Commissioning" > "NC" > "NC memory". 

See also 
Import licensing terms (Page 311) 
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10.4 Parameter sets of axis/spindle 
Per machine axis, six parameter sets are available. They are used as follows    
● on an axis: 

for accommodation of the own dynamic response to another machine axis, e.g. when 
tapping or thread cutting on the relevant spindle. 

● on a spindle: 
for accommodation of the position controller to modified properties of the machine during 
operation, e.g. when switching the gearbox. 

Tapping, thread cutting 
The following applies to axes:   
● For a machine axis that is not involved in tapping or thread cutting, the 1st set of 

parameters (index=0) is active in all cases. 
The further parameter sets need not be considered. 

● Machine axes involved in tapping or thread cutting: the parameter set is activated in 
accordance with the current gear stage. 
All parameter sets must be parameterized in accordance with the gear stages of the 
spindle. 

The following applies to spindles: 
● With spindles, each gear stage is assigned a parameter set of its own. 

For instance Gearbox step 1 - Parameter set 2 (Index 1). Spindles in axis operation 
(DB31, ... DBX60.0 = 0) use Parameter set 1 (Index 0).  
The active gearbox step can be read in the PLC via the signals DB31, ... DBX82.0-2 
(Gearbox step setpoint)." The parameter set is selected from the PLC using the interface 
signal DB31, ... DBX16.0 - 16.2 (actual gear stage). 
All parameter sets must be parameterized in accordance with the gear stages of the 
spindle. 

For example, in HMI-Advanced, the active parameter set of a machine axis is displayed in 
the "Diagnosis" control area in the "Service axis" screen. 
The active parameter set can be read in the PLC via the signals DB31, ... DBX69.0-2 
(Controller parameter set)." 
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Figure 10-4 Validity of parameter sets for axis and spindle modes 

Remarks on the "Axis" column: Switch-over applies to G33 as well as for G34, G35, G331 
and G332. 

Machine data 
The following machine data of a machine axis depend on the parameter set: 
n = parameter set number (0 ... 5) 

Table 10- 9 Parameter-set-dependent machine data 

Number Identifier Name Reference
Axis/spindlespecific ($MA_ ... ) 
31050 DRIVE_AX_RATIO_DENOM[n] Denominator load gearbox  
31060 DRIVE_AX_RATIO_NUMERA[n] Numerator load gearbox  
32200 POSCTRL_GAIN [n] KV factor  
32810 EQUIV_SPEEDCTRL_TIME [n] Equivalent time constant, of speed control loop for 

feed forward control 
 

32910 DYN_MATCH_TIME [n] Time constant for dynamic matching  
35110 GEAR_STEP_MAX_VELO[n] Maximum speed for gear change  
35120 GEAR_STEP_MIN_VELO[n] Minimum speed for gear change  
35130 GEAR_STEP_MAX_VELO_LIMIT[n] Maximum speed of gear stage  
35140 GEAR_STEP_MIN_VELO_LIMIT[n] Minimum speed of gear stage  
35200 GEAR_STEP_SPEEDCTRL_ACCEL[n] Acceleration in speed control mode  
35210 GEAR_STEP_POSCTRL_ACCEL[n] Acceleration in position control mode  
36200 AX_VELO_LIMIT [n] Threshold value for velocity monitoring  
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10.5 Parameterize axis data 

Reference 

See also 
Axis data (Page 366) 
Axis assignment (Page 370) 
Axis names (Page 373) 

10.5.1 Incremental measuring system settings 

Rotary measuring system 
The diagrams below show the general possibilities of arranging a rotary incremental 
measuring system with regard to motor and load, as well as the resulting values for the 
appropriate machine data. 
Figures equally apply to rotary axes, modulo axis and spindles.  

Linear axis with encoder on the machine 

 
Figure 10-5 Linear axis with encoder on motor 
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Linear axis with sensor on load 

 
Figure 10-6 Linear axis with sensor on load 

Rotary axis with encoder on motor 

 
Figure 10-7 Rotary axis with encoder on motor 
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Linear axis with encoder on the machine 

 
Figure 10-8 Linear axis with encoder on the machine 

Machine data 

Table 10- 10 Incremental measuring systems: Machine data 

Number Identifier Name / remarks Reference
Axisspecific ($MA_ ... ) 
30240 ENC_TYPE[n] Actual value acquisition modes 

1=incremental raw signal encoder 
 

30242 ENC_IS_INDEPENDENT[n] Encoder is independent  
30300 IS_ROT_AX Rotary axis R2 
31000 ENC_IS_LINEAR[n] Direct measuring system (linear scale)  
31020 ENC_RESOL[n] Encoder pulses per revolution  
31030 LEADSCREW_PITCH Leadscrew pitch  
31040 ENC_IS_DIRECT[n] Encoder is connected directly to the machine  
31050 DRIVE_AX_RATIO_DENOM[n] Denominator load gearbox  
31060 DRIVE_AX_RATIO_NUMERA[n] Numerator load gearbox  
31070 DRIVE_ENC_RATIO_DENOM[n] Denominator of resolver gearbox  
31080 DRIVE_ENC_RATIO_NUMERA[n] Numerator of resolver gearbox  

Linear measuring system 
The diagram below shows the general possibilities of arranging a linear incremental 
measuring system with regard to motor and load, as well as the resulting values for the 
respective machine data.  
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Linear axis with linear scale 

 
Figure 10-9 Linear axis with linear scale 

Machine data 

Table 10- 11 Linear measuring systems: Machine data 

Number Identifier Name / remarks Reference
axisspecific ($MA_ ... ) 
30240 ENC_TYPE[n] Actual value acquisition modes 

1=incremental raw signal encoder 
 

30242 ENC_IS_INDEPENDENT[n] Encoder is independent  
30300 IS_ROT_AX Rotary axis R2 
31000 ENC_IS_LINEAR[n] Direct measuring system (linear scale)  
31010 ENC_GRID_POINT_DIST[n] Distance between reference marks on linear scales  
31030 LEADSCREW_PITCH Leadscrew pitch  
31040 ENC_IS_DIRECT[n] Encoder is connected directly to the machine  
31050 DRIVE_AX_RATIO_DENOM[n] Denominator load gearbox  
31060 DRIVE_AX_RATIO_NUMERA[n] Numerator load gearbox  
32110 ENC_FEEDBACK_POL[n] Sign actual value (feedback polarity)  
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10.5.2 Parameterization of absolute measuring systems 

Encoder types 
The following encoder types are currently supported:    
● Single-turn absolute value encoder 
● Multi-turn absolute value encoder 
with EnDat protocol and incremental sinusoidal encoder signals A and B, e.g. Haidenhain 
EQN 1325. 

EQN 1325 
The absolute value encoder EQN 1325 from Heidenhain has the following properties:   
● EnDat protocol 
● PPR count: 2048 = 211 (encoder fine resolution) 
● Positions/revolution: 8192 (13 bits) 
● Differentiable revolutions: 4096 (12 bits) 
● Encoder signals A/B: 1Vpp sin/cos 

Calibration 
Convergence of the measuring system with the machine positions is performed by 
calibration of the absolute value encoder in absolute measuring systems. For calibration of 
the absolute value encoder, see Chapter "Axis homing" (Page 166). 

Linear axis with absolute value encoder on motor 

 
Figure 10-10 Linear axis with absolute value encoder on motor 
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Rotary axis, modulo axis and spindle with absolute value sensor on motor 

 
Figure 10-11 Rotary axis, modulo axis and spindle with absolute value sensor on motor 

Machine data 

Table 10- 12 Measuring systems: Machine data 

Number Identifier Name / remarks Reference
axisspecific ($MA_ ... ) 
30240 ENC_TYPE[n] Actual-value acquisition modes  
30242 ENC_IS_INDEPENDENT[n] Encoder is independent  
30260 ABS_INC_RATION[n] Encoder fine resolution (absolute value encoder)  
30300 IS_ROT_AX[n] Rotary axis R2 
31000 ENC_IS_LINEAR[n] Direct measuring system (linear scale)  
31030 LEADSCREW_PITCH[n] Leadscrew pitch  
31040 ENC_IS_DIRECT[n] Encoder is connected directly to the machine  
31050 DRIVE_AX_RATIO_DENOM[n] Denominator load gearbox  
31060 DRIVE_AX_RATIO_NUMERA[n] Numerator load gearbox  
31070 DRIVE_ENC_RATIO_DENOM[n] Measuring gearbox denominator  
31080 DRIVE_ENC_RATIO_NUMERA[n] Measuring gearbox numerator  
34200 ENC_REFP_MODE[n] Referencing mode  
34210 ENC_REFP_STATE[n] Status of absolute value encoder  
34220 ENC_ABS_TURNS_MODULO[n] Absolute value encoder range for rotary encoders 

(multi-turn resolution) 
R2 
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10.5.3 DSC (Dynamic Servo Control) 
The DSC function eliminates the deadtime that necessarily exists at the speed-setpoint 
interface normally used between the NCK and drive due to relocation of the position 
controller into the drive.    
This results in the following advantages for an axis operated with DSC: 
● Considerably improved fault response/stability of the position control loop 
● Improved command behavior (contour precision) if the loop gain (KV factor) that can be 

set higher in conjunction with DSC is used. 
● A reduction of the cyclic communication load on the PROFIBUS, if the position controller 

cycle/PROFIBUS cycle is reduced by adjusting the above parameters, even if the control 
loop performance is the same. 

 

 
 

Note 
The speed feedforward control can be used in conjunction with DSC. 

 

Requirements 
Before you can activate DSC mode, the following preconditions must be fulfilled: 
● DSC-capable drive 
● A DSC-capable message frame type has been parameterized in the S7 project for the 

drive. 

Switch ON/OFF 
The DSC function is switched on via the following axis-specific NCK machine data: 
● MD32640 $MA_STIFFNESS_CONTROL_ENABLE (dyn. Stiffness control) 
If DSC operation is switched ON or OFF, it might be necessary to adjust the following 
machine data: 
● MD32200 $MA_POSCRTL_GAIN (servo gain factor) 
● MD32610 $MA_VELO_FFW_WEIGHT (feedforward control factor) 
● MD32810 $MA_EQUIV_SPEEDCTRL_TIME (substitute time const. of the closed speed 

control loop) 
 

NOTICE  
 

Before you can switch off DSC operation you might have to adapt (reduce) the KV factor 
of the axis. Otherwise, instability of the position control loop might result. 
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Actual value inversion during DSC operation   
 

 Note 
Actual value inversion during DSC operation (MD32640=1) is undertaken as follows: 
• Set the p0410 parameter (encoder inversion actual value) in the drive. 
• In the NC in the machine data, set MD32110 $MA_ENC_FEEDBACK_POL = 0 or 1 (no 

inversion!). 
Actual value inversion via MD32110=-1 is not possible during activated DSC operation. 
If MD32110=-1 is to be set, the "26017 axis%1 machine data 32110 value not permitted" 
alarm is output when DSC operation is activated. 

 

 

Speed setpoint filter 
If you use DSC, a speed setpoint filter for rounding the speed setpoint steps is no longer 
necessary. The speed setpoint filter is then only of any use with differential connection to 
support the position controller, for example, to suppress resonance. 

Machine data 

Table 10- 13 DSC: Machine data 

Number Identifier Name Reference
Axisspecific ($MA_ ... ) 
32640 STIFFNESS_CONTROL_ENABLE Dyn. stiffness control DD2 
32200 POSCRTL_GAIN KV factor G2 
32642 STIFFNESS_CONTROL_CONFIG The dynamic stiffness control is configured. 

0->standard case: DSC in drive operates with 
indirect measuring system 
1->DSC in the drive operates using direct 
measuring system 

DD2 
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10.5.4 Rotary axes 

Rotary axes 
A machine axis is parameterized as a rotary axis in   
● MD30300 $MA_IS_ROT_AX (rotary axis) = 1 
The machine data is a scaling machine data. A change results in a conversion of all machine 
data of the machine axis with length-related units. 
For the recommended procedure with respect to scaling machine data, please refer to 
Subsection "Modifying Scaling Machine Data" . 

Modulo display 
The display of the rotary axis position modulo 360 degrees is displayed via the following 
machine data:   
● MD30320 $MA_DISPLAY_IS_MODULO (modulo 360 degrees display for rotary axes) 

Endlessly rotating rotary axis/modulo axis   
The traversing of the rotary axis modulo 360 degrees is displayed via the following machine 
data:  
● MD30310 $MA_ROT_IS_MODULO (modulo conversion for rotary axis) 

The limit switches are not monitored during this process. The rotary axis can thus rotate 
endlessly.   
The limit switch monitoring can be activated by the PLC interface. 
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Machine data 

Table 10- 14 Rotary axes: Machine data 

Number Identifier Name Reference
general ($MN_ ... ) 
10210 INT_INCR_PER_DEG Computational resolution for angular positions G2 
axisspecific ($MA_ ... ) 
30300 IS_ROT_AX Axis is rotary axis  
30310 ROT_IS_MODULO Modulo conversion for rotary axis   
30320 DISPLAY_IS_MODULO Actual value display modulo  
36100 POS_LIMIT_MINUS Minus software limit switch A3 
36110 POS_LIMIT_PLUS Plus software limit switch  A3 

Setting data 

Table 10- 15 Rotary axes: Setting data 

Number Identifier Name Reference
General ($SN_ ...) 
41130 JOG_ROT_AX_SET_VELO JOG speed for rotary axes H1 
Axisspecific ($SA_ ... ) 
43430 WORKAREA_LIMIT_MINUS Working area limitation minus A3 
43420 WORKAREA_LIMIT_PLUS Working area limitation plus A3 

Literature 
Function Manual Expanded Functions; Rotary axes 
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10.5.5 Positioning axes 
Positioning axes are channel axes traversing parallel to the path axes without interpolating 
with them.   
Positioning axes can be traversed either from the parts program or from the PLC. 

Concurrent machine axes 
A channel axis is neutrally defined by default with the following machine data. As a result no 
REORG takes place if the axis/spindle is traversed by the PLC (FC18) or by synchronous 
actions. 
● MD30450 $MA_IS_CONCURRENT_POS_AX (concurr. positioning axis) = 1 

Positioning axis feedrate 
If a positioning axis is programmed in the part program without specifying an axis-specific 
feedrate, the feedrate entered in the following machine data is automatically applicable to 
this axis: 
● MD32060 $MA_POS_AX_VELO (initial setting for positioning axis velocity) 
This feedrate will apply until an axis-specific feedrate is programmed in the parts program for 
this axis. 

Machine data 

Table 10- 16 Positioning axes: Machine data 

Number Identifier Name Reference
Channelspecific ($MC_ ... ) 
22240 AUXFU_F_SYNC_TYPE Output timing of F functions H2 
axisspecific ($MA_ ... ) 
30450 IS_CONCURRENT_POS_AX Concurrent positioning axis  
32060 POS_AX_VELO Feedrate for positioning axis  

Interface signals 

Table 10- 17 Positioning axes: Interface signals 

DB number Bit, byte Name Reference
Axis/spindle-specific Signals from PLC to axis/spindle 
31,... 0 Feedrate override, axis-specific  
31,... 2.2 Delete distance-to-go, axis-specific  
 Signals from axis/spindle to PLC 
31,... 74.5 Positioning axis  
31,... 78-81 F function (feedrate) for positioning axis  

Literature 
Function Manual Expanded Functions; Positioning axes 
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10.5.6 Indexed axes/"Hirth" axes 
Indexed axes are rotary or linear axes, which can be traversed to indexed positions by index 
program instructions.  
These indexed positions are approached in JOG mode.  
In "normal" positioning, every position can be approached.  

 

 Note 
Traversing to indexing positions using the parts program or manually is only effective if the 
corresponding machine axis has been successfully referenced. 

 

Hirth axes are indexing axes with Hirth tooth system. These axes are rotary or linear axes, 
which may only be traversed to defined positions, the indexing positions, within the 
traversing range (MD30505  $MA_HIRTH_IS_ACTIVE).    
The indexing positions are stored in tables. 

Indexing axis 
The following machine data assigns the machine axis the relevant table of indexing positions 
and also defines the machine axis as an indexing axis: 
● MD30500 $MA_INDEX_AX_ASSIGN_POS_TAB[n] (axis is indexing axis) 
 

Indexing position tables 
The indexing positions are stored in one of the 2 tables.   
● MD10900 $MN_INDEX_AX_LENGTH_POS_TAB_1  

(number of positions of indexing table 1) 
● MD10910 $MN_INDEX_AX_POS_TAB_1 [n]  

(indexing position table 1) 
● MD10920 $MN_INDEX_AX_LENGTH_POS_TAB_2  

(number of positions of indexing table 2) 
● MD10930 $MN_INDEX_AX_POS_TAB_2 [n] (indexing position table 2) 
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Machine data 

Table 10- 18 Indexing axes: Machine data 

Number Identifier Name Reference
general ($MN_ ... ) 
10260 CONVERT_SCALING_SYSTEM Basic system switch-over active G2 
10270 POS_TAB_SCALING_SYSTEM Measuring system of position tables  
10900 INDEX_AX_LENGTH_POS_TAB_1 Number of indexing positions used in Table 1  
10910 INDEX_AX_POS_TAB_1[n] Indexing position table 1  
10920 INDEX_AX_LENGTH_POS_TAB_2 Number of indexing positions used in Table 2  
10930 INDEX_AX_POS_TAB_2[n] Indexing position table 2  
Axis/spindlespecific ($MA_ ... ) 
30300 IS_ROT_AX Rotary axis R2 
30310 ROT_IS_MODULO Modulo conversion for rotary axis R2 
30320 DISPLAY_IS_MODULO Position display is modulo 360 degrees R2 
30500 INDEX_AX_ASSIGN_POS_TAB Axis is indexing axis  
30501 INDEX_AX_NUMERATOR Numerator for indexing axes with equidistant positions  
30505 HIRTH_IS_ACTIVE Axis is an indexing axis with Hirth toothing  

Interface signals 

Table 10- 19 Indexing axes: Interface signals 

DB number Bit, byte Name Reference
Axis/spindle-specific Signals from axis/spindle to PLC 
31,... 60.4, 60.5 Referenced/synchronized 1, referenced/synchronized 2 R1 
31,... 76.6 Indexing axis in position  

Literature 
Function Manual Expanded Functions; Indexing axes 
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10.5.7 Position controller 

Control loops 
The closed-loop control of a machine axis consists of the cascaded closed-loop control 
circuits of current controller, speed controller and position controller.  

 
Figure 10-12 Control loops 

Traversing direction 
If the axis does not traverse into the desired direction, the appropriate adaptation is made in 
the following machine data:   
● MD32100 $MA_AX_MOTION_DIR (travel direction) 
The value "-1" reverses the direction of motion. 

Control direction 
If the control direction of the position measuring system is incorrect, it can be adjusted with 
the following machine data:   
● MD32110 $MA_ENC_FEEDBACK_POL (sign of actual value) 

 

 
 

Note 
When DSC is activated on the incorrect position measuring system, the control direction 
must also be adjusted in SINAMICS parameter p410. 
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Servo gain 
To obtain high contour accuracy, a high loop gain (KV factor) of the position controller is 
required. However, an excessively high KV factor causes overshoot, instability and 
impermissibly high machine loads.   
The maximum permissible KV factor is dependent on the dynamic response and the use of 
the feedforward control or DSC, of the drive and the mechanical system of the machine. 

 

 Note 
The first commissioning is performed without feedforward control. 

 

A KV factor of "0" leads to the position controller being cut. 

Definition of the KV factor 
The KV factor is defined as the ratio of velocity in m/min and the resulting following error in 
mm   

 
This means for a KV factor of 1 that at a velocity of 1m/min, a following error of 1mm results. 
The KV factor of the machine axis is entered via the following machine data: 
● MD32200 $MA_POSCTRL_GAIN (servo gain factor) 

 

 
 

Note 
To adapt the input/output unit of the KV factor selected by default to the internal unit [1/s], 
the following machine data is assigned pre-assigned: 
• MD10230 $MN_SCALING_FACTORS_USER_DEF[9] = 16.666667 
• MD10220 $MN_SCALING_USER_DEF_MASK = 'H200'; (bit no. 9 as hex value) 

 

When entering the KV factor it is important to note that the gain factor of the whole position 
control loop is still dependent on other parameters of the controlled system (speed setpoint 
alignment). 
These factors include, among others: 
● MD32260 $MA_RATED_VELO 
● MD32250 $MA_RATED_OUTVAL 
● Automatic interface alignment (SINAMICS parameter "Reference speed" p2000) 
For drive optimization see Further optimization options (Page 222)  
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NOTICE  
Machine axes that interpolate one with another must have the same dynamic response at 
the same velocities. 
This can be achieved by setting the same KV factor or dynamic response adaptation in the 
following machine data: 
• MD32900 $MA_DYN_MATCH_ENABLE 
• MD32910 $MA_DYN_MATCH_TIME 
The real KV factor can be checked with the following error in the service display. 
• e.g., HMI Advanced: Operating area "Diagnosis" > "Service displays" > "Service axis" 

 

Checking the loop gain 
If a KV factor is already known for a machine type in question, this can be set and checked. 
To ensure that the drive does not reach its current limit during acceleration and deceleration, 
the acceleration is reduced for checking via the following machine data:   
● MD32300 $MA_MAX_AX_ACCEL (axis acceleration) 
The KV factor must also be checked for high speeds of the rotary axis and spindle (e.g., for 
spindle positioning, tapping). 
The approach behavior at various speeds can be checked by means of the HMI Advanced 
servo trace software. The speed setpoint is recorded for this purpose. 

 
Figure 10-13 Speed setpoint characteristic 

No overshoots may occur while the drive is approaching the static states; this applies to all 
speed ranges. 
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Overshoot in the position control loop 
The reasons for an overshoot in the control loop can be:   
● Acceleration too high (current limit is reached) 
● Rise time too long (re-optimization necessary) 
● Mechanical backlash 
● Mechanical components canted 
For safety reasons, set the KV factor for each axis to a little less than the maximum possible 
value. 
● MD32900 $MA_DYN_MATCH_ENABLE[n] 
● MD32910 $MA_DYN_MATCH_TIME[n] 
For axes interpolating with each other, the same KV-factor should be set. Normally it is the 
KV-factor of the weakest interpolating axis.  
Contour monitoring must be set subsequently (MD36400 $MA_CONTROL_TOL). 

Acceleration 
In the following machine data machine axes are accelerated and decelerated with the values 
entered.   
● MD32300 $MA_MAX_AX_ACCEL (axis acceleration) 
This value should allow the axes to be accelerated and positioned fast and accurately, while 
ensuring that the machine is not loaded unduly.  

Checking the acceleration 
The sign of a properly adjusted acceleration of a machine axis is acceleration and 
positioning free from overshoot at rapid traverse rate and maximum load (max. external 
moment of inertia).   
After the acceleration has been entered, the axis is traversed rapidly and the actual current 
values and current setpoint are recorded. 
This recording shows whether the drive reaches the current limit. Here, the current limit can 
be reached for a short time. 
The current must be well below the current limit, however, before the rapid traverse velocity 
or the final position is reached. 
Load changes during the machining should not result in the current limit being reached, as 
they may result in contour errors. For this reason, the acceleration value should be a little bit 
less than the maximum acceleration value. 
Machine axes can have different acceleration values, even if they interpolate with each 
other. 
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Jerk 
For jerk, the following should be noted: 
● For indexing program instructions (SOFT), the maximum jerk must be set in the following 

machine data: 
– MD32431 $MA_MAX_AX_JERK (maximum jerk) 

● For JOG and positioning axes the following machine data should be supplemented: 
– MD32420 $MA_JOG_AND_POS_JERK_ENABLE 
– MD32430 $MA_JOG_AND_POS_MAX_JERK 

Machine data 

Table 10- 20 Position control: Machine data 

Number Identifier Name/remarks Reference
axis spec. ($MA_ ... ) 
32100 AX_MOTION_DIR[n] Traversing direction  
32110 ENC_FEEDBACK_POL[n] Actual value sign  
32200 POSCTRL_GAIN [n] KV factor  
32300 MAX_AX_ACCEL[n] Axis acceleration  
32420 JOG_AND_POS_JERK_ENABLE Enabling jerk limitation  
32430 JOG_AND_POS_MAX_JERK Axial jerk  
32431 MAX_AX_JERK Maximum axial jerk when traversing along the path  
32900 DYN_MATCH_ENABLE[n] Dynamic response adaptation  
32910 DYN_MATCH_TIME [n] Time constant for dynamic matching  
36400 CONTROL_TOL Contour monitoring  

Literature 
Function Manual; speed, setpoint/actual-value systems, control: Closed-loop control 
Function Manual Extended Functions; Compensation, Section "Dynamic feedforward control 
(following error compensation)" 
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10.5.8 Speed setpoint matching 
In the case of speed setpoint comparison, the NC is informed, which speed setpoint 
corresponds to which motor speed in the drive, for parameterizing the axial control and 
monitoring. Speed setpoint matching can be performed automatically or manually.   

Automatic adjustment 
It is possible to perform automatic speed setpoint adjustment if the drive supports acyclic 
services on the PROFIBUS-DP (standard for SINAMICS). 
Acyclic services on the PROFIBUS-DP are supported  
if in the following machine data the value "0" is entered: 
● MD32250 $MA_RATED_OUTVAL (rated output voltage) [%] 
During start-up of the NCK, speed setpoint matching between the NCK and the drive is then 
performed automatically. 

 

WARNING  
The SINAMICS parameter "Reference speed" p2000 may not be changed during operation 
of the control with the drive. 

 

 Note 
If automatic speed setpoint matching fails for one axis, the following message is output on a 
traverse request for this axis: 
• Message: "Wait, axis enable missing" 
This axis and any axes that interpolate with it are not traversed. 

 

Manual comparison 
The speed setpoint alignment (interface normalization) is specified in the following machine 
data: 
● MD32250 $MA_RATED_OUTVAL (rated output voltage) [%] 
● MD32260 $MA_RATED_VELO (rated motor speed) 
If a non-zero value is entered into the following machine data, the NCK assumes that speed 
setpoint matching will be performed manually. 
● MD32250 $MA_RATED_OUTVAL (rated output voltage) [%] 

 

 
 

Note 
The maximum upper limit for the speed setpoint is set in machine data 
• MD36210 $MA_CTRLOUT_LIMIT (maximum speed setpoint) [%] 
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Calculation of the motor speed 
If the motor speed required for speed setpoint matching is not known directly, it can be 
calculated as follows with reference to the required axis velocity (linear axis) or load speed 
(rotary axis/spindle): 

 
 

 
● vAxis [mm/min] 
● MD31060 $MA_DRIVE_RATIO_NUMERA (load gearbox numerator) 
● MD31050 $MA_DRIVE_RATIO_DENOM (load gearbox denominator) 
● MD31030 $MA_LEADSCREW_PITCH (leadscrew pitch) [mm/rev] 
● nMotor [rpm] 
● nLoad [rpm] 

Checking the trim 
Incorrect speed setpoint matching has a negative impact on the real loop gain of the axis. 
To check speed setpoint matching it is necessary for a defined traverse velocity to compare 
the actual following error with the desired following error that should be set if speed setpoint 
matching is correct. 

 
● Desired following error [ mm ] 
● Traversing velocity [ m/min ] 
● MD32200 $MA_POSCTRL_GAIN (servo gain  factor) [(m/min)/mm] 
The actual following error is shown in the axis-specific service data: 
HMI: 
Operating area "Diagnostics" > "Service displays" > "Service axis/spindle" 
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Machine data 

Table 10- 21 Speed setpoint matching: Machine data 

Number Identifier Name/remarks Reference
Axis-spec. ($MA_ ... ) 
32250 RATED_OUTVAL  Rated output voltage [%] G2 
32260 RATED_VELO Rated motor speed G2 

Literature 
Function Manual Basic Functions; 
Speeds, setpoint/actual value systems, control, Chapter "Speeds, traversing ranges, 
accuracy" 

10.5.9 Drift compensation 

Digital drives 
Digital drives are not subject to drift or compensate for it automatically.  

Machine data 

Table 10- 22 Drift compensation: Machine data 

Number Identifier Name/remarks Reference
axis spec. ($MA_ ... ) 
36720 DRIFT_VALUE Basic drift value, always = 0 

Note: 
0 recommended for digital drive. 

G2 



 NCK start-up 
 10.5 Parameterize axis data 

IBN CNC: NCK, PLC, drive 
Commissioning Manual, 03/2009, 6FC5397-2AP10-5BA0 155 

10.5.10 Velocity matching (axis) 

Max. axis velocity 
The value entered in the following machine data is the limit velocity up to which a machine 
axis can accelerate (rapid traverse limiting). It depends on the machine and drive dynamics 
and the limit frequency of actual-value acquisition.    
● MD32000 $MA_MAX_AX_VELO[n] (max. axis velocity) 
The max. axis velocity is used for traversing in the parts program when rapid traverse (G00) 
is programmed. 
The maximum linear or rotary axis velocity should be entered in the machine data in 
accordance with MD30300 $MA_IS_ROT_AX[n]. 

Rapid traverse in JOG mode 
The value entered in the following machine data is the velocity at which the machine axis 
traverses in JOG mode with the rapid traverse override key actuated and with an axial 
feedrate override of 100%.   
● MD32010 $MA_JOG_VELO_RAPID[n] (rapid traverse in JOG mode) or 
● MD32040 $MA_JOG_REV_VELO_RAPID[n] (revolutional feedrate in JOG mode with 

rapid traverse override) 
The entered value may not exceed the max. permissible axis velocity. 
This machine data will not be used for the programmed rapid traverse G00. 

JOG axis velocity 
The value entered in this machine data is the velocity at which the machine axis traverses in 
JOG mode with an axial feedrate override of 100%:   
● MD32020 $MA_JOG_VELO[n] (axis velocity in JOG mode) or 
● MD32050 $MA_JOG_REV_VELO[n] (revolutional feedrate in JOG mode) 
The velocity from MD32020 JOG_VELO[n] or MD32050 JOG_REV_VELO[n] is used only if  
● for linear axes: SD41110 $SN_JOG_SET_VELO = 0 
● for rotary axes: SD41130 $SN_JOG_ROT_AX_SET_VELO = 0 
or 
● for reverse feed: SD41120 $SN_JOG_REV_SET_VELO = 0 
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If the above mentioned setting data are unequal to 0, the JOG velocity results as follows: 
1. SD41100 $SN_JOG_REV_IS_ACTIVE (revolutional feedrate in JOG mode) = 0 

=> Linear feedrate (G94) 
– Linear axes: 
JOG velocity = SD41110 $SN_JOG_SET_VELO (JOG velocity for G94) 
– Rotary axes: 
JOG velocity = SD41130 $SN_JOG_ROT_AX_SET_VELO (JOG velocity for rotary axes) 

2. SD41100 $SN_JOG_REV_IS_ACTIVE (revolutional feedrate in JOG mode) = 1 
– JOG velocity = SD41120 $SN_JOG_REV_SET_VELO (JOG velocity for G95) 

The entered value may not exceed the max. permissible axis velocity. 
 

NOTICE  
Depending on MD30300 $MA_IS_ROT_AX[n], the velocities have to be entered in mm/min, 
inch/min, or rpm. 
If the velocities are changed, MD36200 $MA_AX_VELO_LIMIT[n] (threshold value for 
velocity monitoring) must be adapted accordingly. 

 

Machine data 

Table 10- 23 Velocities: Machine data 

Number Identifier Name / remarks Reference
axis-spec. ($MA_ ... ) 
30300 IS_ROT_AX[n] Rotary axis  
32000 MAX_AX_VELO[n] Maximum axis velocity G2 
32010 JOG_VELO_RAPID[n] Rapid traverse in JOG mode  
32020 JOG_VELO[n] JOG axis velocity  
32040 JOG_REV_VELO_RAPID[n] Revolutions feedrate in JOG mode with rapid 

traverse override 
 

32050 JOG_REV_VELO[n] Revolutional feedrate in JOG mode  
32060 POS_AX_VELO[n] Initial setting for positioning axis velocity P2 
32250 RATED_OUTVAL  Rated output voltage  
32260 RATED_VELO[n] Rated motor speed  
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Setting data 

Table 10- 24 Velocities: Setting data 

Number Identifier Name / remarks Reference
General ($SN_ ...) 
41100 JOG_REV_IS_ACTIVE Revolutional feedrate in JOG mode active  
41110 JOG_SET_VELO JOG velocity for linear axes (for G94)  
41120 JOG_REV_SET_VELO JOG velocity (for G95)  
41130 JOG_ROT_AX_SET_VELO JOG speed for rotary axes  
41200 JOG_SPIND_SET_VELO JOG velocity for the spindle  

Literature 
Function Manual Basic Functions; 
Speeds, setpoint/actual value systems, control, Chapter "Speeds, traversing ranges, 
accuracy" 
Function Manual, Expanded Functions; Manual and Hand Wheel Travel 
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10.5.11 Axis monitoring 

Static monitoring functions 
The static monitoring functions with reference to a machine axis are:    

Exact stop coarse 
Window around the setpoint position within which exact stop coarse is detected.   
● MD36000 $MA_STOP_LIMIT_COARSE (exact stop coarse) 
● IS: DB31,... DBX60.6 (position reached with exact stop coarse) 

Exact stop fine 
Window around the setpoint position within which exact stop fine is detected.   
● MD36010 $MA_STOP_LIMIT_FINE (exact stop fine) 
● IS: DB31,... DBX60.7 (position reached with exact stop coarse) 

Delay time exact stop fine 
Delay time after which the actual value must have reached the tolerance window "Exact stop 
fine" when the setpoint position is reached. 
● MD36020 $MA_POSITIONING_TIME (delay time exact stop fine) 
● Alarm: "25080 Positioning monitoring" and follow-up mode. 

Zero speed tolerance 
Position tolerance which a standing machine axis may not leave.   
● MD36030 $MA_STANDSTILL_POS_TOL (standstill tolerance) 
● Alarm: "25040 Zero speed control" and follow-up mode. 

Delay time zero speed monitoring 
Delay time after which the actual value must have reached the tolerance window "Zero 
speed tolerance" when the setpoint position is reached. 
● MD36040 $MA_STANDSTILL_DELAY_TIME (Zero-speed monitoring delay time) 
● Alarm: "25040 Zero speed control" and follow-up mode. 
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Clamping tolerance 
Tolerance window for a standing machine axis while the signal "Clamping active" is present 
at the PLC interface.   
● MD36050 $MA_CLAMP_POS_TOL (clamping tolerance) 
● IS: DB31,... DBX2.3 (clamping active) 
● Alarm: "26000 Clamping monitoring" 

 
Figure 10-14 Static monitoring functions 

Working area limitation 
The permissible working area of the machine axes can be adapted to the particular 
machining situation using the "dynamic" working area limitation.   
● SD43400 $SA_WORKAREA_PLUS_ENABLE (Working area limitation active in the 

positive direction) 
● SD43410 $SA_WORKAREA_MINUS_ENABLE (Working area limitation active in the 

negative direction) 
● SD43420 $SA_WORKAREA_LIMIT_PLUS (Working area limitation plus) 
● SD43430 $SA_WORKAREA_LIMIT_MINUS (Working area limitation minus) 
● Alarm: "10630 Axis reaching operating range limit +/-" 
● Alarm: "10631 Axis is at operating range limit +/- (JOG)" 
● Alarm: "10730 Progr. end point is behind working area limitation +/-" 
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Software limit switches 
Two software limit switch pairs are provided per machine axis. The active software limit 
switch pair is selected in the PLC.   
● MD36100 $MA_POS_LIMIT_MINUS (1st software limit switch minus) 
● MD36110 $MA_POS_LIMIT_PLUS (1st software limit switch plus) 
● MD36120 $MA_POS_LIMIT_MINUS2 (2nd software limit switch minus) 
● MD36130 $MA_POS_LIMIT_PLUS2 (2nd software limit switch plus) 
● IS: DB31,... DBX12.2 (2nd software limit switch minus) 
● IS: DB31,... DBX12.3 (2nd software limit switch plus) 
● Alarm: "10620 Axis reaching software limit switch +/-" 
● Alarm: "10621 Axis is at software limit switch +/- (JOG)" 
● Alarm: "10720 Progr. end point is behind software limit switch +/-" 

 

NOTICE  
 

All position monitoring functions are only active with valid reference point of the 
corresponding reference point of the machine axis. 

 

Hardware limit switches 
If the PLC signals that a hardware limit switch has been reached, the machine axis is 
stopped with the parameterized brake response.   
● IS: DB31, ... DBX12.1 (hardware limit switch plus) 
● IS: DB31, ... DBX12.0 (hardware limit switch minus) 
● MD36600 $MA_BRAKE_MODE_CHOICE (braking behavior on hardware limit switch) 

0 = Brake characteristic is complied with 
1 = Rapid deceleration with setpoint "0" 

● Alarm: "21614 Hardware limit switch [+/-]" 

 
Figure 10-15 Overview of end limitations 
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Dynamic monitoring functions 
The dynamic monitoring functions with reference to a machine axis are:    

Speed setpoint monitoring 
The speed setpoint monitoring prevents that the max. admissible motor speed is exceeded. 
It must be set such that the max. velocity (rapid traverse) can be reached and, in addition, a 
certain control margin remains. 
● MD36210 $MA_CTRLOUT_LIMIT[n] (maximum speed setpoint as %) 

 
Figure 10-16 Speed setpoint limitation 

The following machine data is used to define how long the speed setpoint may remain within 
the limits before the speed setpoint monitoring responds. 
● MD36220 $MA_CTRLOUT_LIMIT_TIME[n] (delay time for speed setpoint monitoring) 
 
Error response 
● Alarm: "25060 Speed setpoint limiting" 
and stopping the machine axis using a speed setpoint ramp whose characteristic is set in 
● MD36610 $MA_AX_EMERGENCY_STOP_TIME (braking ramp time when errors occur) 
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Cause of errors/error handling 
● A measuring circuit error or drive error is present. 
● Setpoints are too high (accelerations, velocities, reducing factors). 
● Obstacle in the machining space (e.g. tool hits working table) => remove obstacle. 
The speed setpoint consists of the speed setpoint of the position controller and the 
feedforward control parameter (if feedforward control is active). 

 
Figure 10-17 Speed setpoint calculation 

 

NOTICE  
The limitation of the speed setpoint will turn the control loop into a nonlinear control loop. 
Generally, this will result in deviations from the contour and longer dwelling of the machine 
axis within the speed setpoint limitation. 

 

Actual velocity monitoring 
Monitoring due to the actual velocity of the machine axis determined based on the encoder 
values   
● MD36020 $MA_AX_VELO_LIMIT (velocity-monitoring threshold) 
Error response 
● Alarm: "25030 Alarm limit of actual velocity" 
and stopping the machine axis using a speed setpoint ramp whose characteristic is set in 
● MD36610 $MA_AX_EMERGENCY_STOP_TIME (braking ramp time when errors occur) 
  
Remedy 
● Check actual values 
● Check position control direction (control sense) 
● Threshold value for velocity monitoring is possibly too low. 
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Contour monitoring 
Monitoring of the difference between the following error measured and the following error 
calculated from the position setpoint.   
● MD36400 CONTOUR_TOL (contour monitoring tolerance range) 
Error response 
● Alarm: "25050 Contour monitoring" 
and stopping the machine axis using a speed setpoint ramp whose characteristic is set in 
● MD36610 $MA_AX_EMERGENCY_STOP_TIME (braking ramp time when errors occur) 
  
Remedy 
Contour errors are caused by signal distortions in the position control loop.  
Remedy: 
● Increase the tolerance band 
● Checking the KV factor: 

The real KV factor must correspond to the desired KV factor, set via 
MD32200 $MA_POSCTRL_GAIN[n] (KV factor). 
HMI-Advanced 
Operating area "DIAGNOSTICS" > "Service displays" > "Service axis" 

● Check optimization of the speed controller 
● Check smooth running of the axes 
● Check machine data for traversing motions 

(Feedrate override, acceleration, max. velocities, ... ) 
● For operation with feedforward control: 

MD32810 $MA_EQUIV_SPEEDCTRL_TIME (equivalent time constant of speed control 
loop for feedforward control) or if the machine data is imprecisely set, the MD36400 
$MA_CONTOUR_TOL must be enlarged. 
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Encoder limit frequency monitoring 
Monitoring of the limit frequency of the encoder of a machine axis.   
● MD36300 $MA_ENC_FREQ_LIMIT (encoder limit frequency) 
Error response 
● Alarm: "21610 Encoder frequency exceeded" 
● IS: DB31, ... DBX60.2 "Encoder limit frequency exceeded 1" 
● IS: DB31, ... DBX60.3 "Encoder limit frequency exceeded 2" 
and stopping the machine axis using a speed setpoint ramp whose characteristic is set in 
● MD36610 $MA_AX_EMERGENCY_STOP_TIME (braking ramp time when errors occur) 
  
Remedy 
After the axes have come to a stop, the position control is resumed after the alarm (RESET 
at the machine control panel) is acknowledged. 

 

NOTICE  
The axis affected must be re-referenced. 

 

Encoder zero mark monitoring 
The zero mark monitoring of the encoder of a machine axis checks whether pulses were lost 
between two zero mark passes.   
● MD36310 $MA_ENC_ZERO_MONITORING (zero-mark monitoring) 
is used to enter the number of detected zero mark errors at which the monitoring is to 
respond. 
Special situation: 
A value of 100 will additionally disable hardware monitoring of the encoder. 
Error response 
● Alarm: "25020 Zero mark monitoring" 
and stopping the machine axes using a speed setpoint ramp whose characteristic is set in 
● MD36610 $MA_AX_EMERGENCY_STOP_TIME (braking ramp time when errors occur) 
  
Error causes 
● MD36300 $MA_ENC_FREQ_LIMIT [n] (encoder limit frequency) set too high. 
● Encoder cable damaged. 
● Encoder or encoder electronics defective. 
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Position tolerance when switching over the encoder 
It is possible to switch between the two encoders or position measuring systems of a 
machine axis at any time. The permissible position difference between the two position 
measuring systems when switching over is monitored.   
● MD36500 $MA_ENC_CHANGE_TOL (max. tolerance on position actual value 

switchover) 
Error response 
● Alarm: "25100 Measuring system cannot be switched over" 
The requested switchover to another encoder is not carried out. 
Error causes 
● The specified permissible tolerance is too small. 
● The position measuring system to which you want to switch over to is not referenced. 

Transmission Monitoring the encoder position tolerance 
The position difference between the two encoders or position measuring systems of a 
machine axis is monitored with  
● MD36510 $MA_ENC_DIFF_TOL (measuring system synchronism tolerance) 
Error response 
● Alarm: "25105 Measuring systems are not synchronous" 
and stopping the machine axes using a speed setpoint ramp whose characteristic is set in 
the following machine data: 
● MD36610 $MA_AX_EMERGENCY_STOP_TIME (braking ramp time when errors occur) 

 
Figure 10-18 Monitoring for SINUMERIK 840D sl 
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NOTICE  
 

MD36620 $MA_SERVO_DISABLE_DELAY_TIME (switchoff delay servo enable) 
must always be selected greater than 
MD36610 $MA_AX_EMERGENCY_STOP_TIME (braking ramp time when errors occur) 
If this is not the case, the braking ramp cannot be kept. 

 

Literature 
Function Manual Basic Functions; Axis monitoring: Protection zones 

10.5.12 Axis homing 

referencing 
When referencing a machine axis, the actual position value system of the machine axis is 
synchronized with the machine geometry. Depending on the encoder type used, the machine 
axis is referenced with or without traversing movements.  

Reference point approach 
For all machine axes which are not equipped with an encoder providing an absolute actual 
position value, referencing is carried out by traversing the machine axis to a reference point; 
this is called the reference point approach. 
The reference point approach can be carried out either manually in JOG mode, submode 
REF, or using a parts program.  
With the operating mode JOG and submode REF, reference point approach is started using 
traverse direction keys PLUS or MINUS (depending on the parameterized reference point 
approach direction). 
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10.5.12.1 Incremental measuring system 

Incremental measuring systems 
With incremental measuring systems, referencing is carried out using a reference point 
approach divided into three phases: 
1. Traversing to the reference cam 
2. Synchronizing to the encoder zero marker 
3. Approach reference point 

t

 
Figure 10-19 Signal chart: Referencing with an incremental measuring system (principle) 

Phase-independent data 
The following machine data and interface signals are relevant in each of the individual 
phases of the reference point approach: 
● MD11300 $MN_JOG_INC_MODE_LEVELTRIGGRD (INC/REF in jog mode) 
● MD34000 $MA_REFP_CAM_IS_ACTIVE (axis with reference cam) 
● MD34110 $MA_REFP_CYCLE_NR (axis sequence for channel-specific reference point 

approach) 
● MD30240 $MA_ENC_TYPE (encoder type) 
● MD34200 $MA_ENC_REFP_MODE (referencing mode) 
● IS: DB21, ... DBX1.0 ("Activate referencing") 
● IS: DB21, ... DBX33.0 ("Referencing active") 



NCK start-up  
10.5 Parameterize axis data 

 IBN CNC: NCK, PLC, drive 
168 Commissioning Manual, 03/2009, 6FC5397-2AP10-5BA0 

Phase 1: Traversing to the reference cam 
The following machine data and interface signals are relevant: 
● MD34010 $MA_REFP_CAM_DIR_IS_MINUS (approach reference cam in minus 

direction) 
● MD34020 $MA_REFP_VELO_SEARCH_CAM (reference cam approach velocity) 
● MD34030 $MA_REFP_MAX_CAM_DIST (maximum distance to the reference cam) 
● MD34092 $MA_REFP_CAM_SHIFT (electr. cam offset, incremental measuring systems 

with equidistant zero markers) 
● IS: DB21, ... DBX36.2 ("All axes with obligatory reference point are referenced") 
● IS: DB31, ... DBX4.7/DBX4.6 ("Traversing keys plus/minus") 
● IS: DB31, ... DBX12.7 ("Reference point approach delay") 
● IS: DB31, ... DBX60.4, DBX60.5 ("Referenced/synchronized 1, 2") 
Properties of phase 1: 
● The feedrate override (feedrate switch) is active. 
● The feed stop (channelspecific and axisspecific) is active. 
● The machine axis can be stopped and restarted with NC-stop/NC-start. 
● The machine axis traverses a distance specified in the following machine data from the 

starting position in the direction of the reference cam, without reaching the reference 
cam. 
– MD34030 $MA_REFP_MAX_CAM_DIST (max. distance to reference cam) 

● The following interface signal is set to "0". The axis stops, and alarm 20000 "Reference 
cam not reached" is output. 
– IS: DB31, ... DBX12.7 ("Reference point approach delay") = 0 

 

WARNING  
 

If the reference cam is not calibrated exactly, it is possible that a wrong zero mark is 
evaluated after the reference cam has been left. As a result, the control system will 
take a wrong machine zero. 
Software limit switches, protection areas and work area limits will thus also be active 
for the wrong positions. The difference is equivalent to one encoder revolution in 
each case. 
Danger for man and machine exists. 

 

Phase 2: Synchronizing to the encoder zero mark 
The following machine data and interface signals are relevant: 
● MD34040 $MA_REFP_VELO_SEARCH_MARKER (creep velocity) 
● MD34050 $MA_REFP_SEARCH_MARKER_REVERSE (direction reversal on reference 

cam) 
● MD34060 $MA_REFP_MAX_MARKER_DIST (maximum distance from cam to reference 

mark) 
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Properties of phase 2: 
● Feed override (the feed override switch) is not active. 

If a feed override of 0% is selected via the feed override switch, the traverse movement is 
stopped. 

● Feed stop (channel-specific and axis-specific) is active. 
On a feed stop, the traverse movement is stopped and the alarm displayed: 

● Alarm 20005 "Reference point approach canceled" 
● NC-Stop/NC-Start is inactive. 
● With IS: DB31, ... DBX12.7 ("Reference point approach delay") = 0, the machine axis 

traverses a distance parameterized in the following machine data after leaving the 
reference cam. 
– MD34060 $MA_REFP_MAX_MARKER_DIST (max. distance to the reference mark) 

Without the zero mark being detected, the machine axis stops and the following alarm 
is displayed: 
Alarm 20002 "Zero mark missing" 

Phase 3: Approach reference point 
The following machine data and interface signals are relevant: 
● MD34070 $MA_REFP_VELO_POS (reference point positioning velocity) 
● MD34080 $MA_REFP_MOVE_DIST (reference point distance to zero mark) 
● MD34090 $MA_REFP_MOVE_DIST_CORR (reference point offset, additive) 
● MD34100 $MA_REFP_SET_POS (reference point value) 
● IS: DB31, ... DBX2.4, 2.5, 2.6, 2.7 ("Reference point value 1...4") 
● IS: DB31, ... DBX60.4, DBX60.5 ("Referenced/synchronized 1, 2") 
Properties of phase 3: 
● Feed override (the feed override switch) is active. 
● Feed stop (channel-specific and axis-specific) is active. 
● NC-Stop/NC-Start is active. 

Literature 
Function Manual Basic Functions; Reference point approach: Referencing with incremental 
measurement systems 
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10.5.12.2 Distancecoded reference marks 

Distancecoded reference marks 
When clearance-coded reference marks are used, referencing is divided into 2 phases:   
1. Synchronize by overriding 2 reference marks 
2. Traverse to target point 

 
Figure 10-20 Signal chart: Distance-coded reference marks (principle) 

Phase-independent data 
The following machine data and interface signals are independent with respect to the 
individual phases of reference point approach: 
● MD11300 $MN_JOG_INC_MODE_LEVELTRIGGRD (INC/REF in jog mode) 
● MD34000 $MA_REFP_CAM_IS_ACTIVE (axis with reference cam) 
● MD34110 $MA REFP_CYCLE_NR (axis sequence for channel-specific reference point 

approach) 
● MD30240 $MA ENC_TYPE (encoder type) 
● MD34200 $MA ENC_REFP_MODE (referencing mode) 
● MD34310 $MA ENC_MARKER_INC (interval between two reference marks) 
● MD34320 $MA ENC_INVERS (inverse measuring system) 
● IS: DB21, ... DBX1.0 ("Activate referencing") 
● IS: DB21, ... DBX33.0 ("Referencing active") 
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Phase 1: Synchronize by overriding 2 reference marks 
The following machine data and interface signals are relevant: 
● MD34010 $MA REFP_CAM_DIR_IS_MINUS (approach reference cam in negative 

direction) 
● MD34040 $MA REFP_VELO_SEARCH_MARKER (referencing velocity) 
● MD34060 $MA REFP_MAX_MARKER_DIST (maximum distance between 2 reference 

marks) 
● MD34300 $MA ENC_REFP_MARKER_DIST (reference mark distance) 
● IS: DB21 .. 30, DBX36.2 ("All axes to be referenced are referenced") 
● IS: DB31, ... DBX4.7/DBX4.6 ("Traversing keys plus/minus") 
● IS: DB31, ... DBX12.7 ("Reference point approach delay") 
● IS: DB31, ... DBX60.4, DBX60.5 ("Referenced/synchronized 1, 2") 
Properties of phase 1: 
● If the machine axis travels from the initial position a distance defined in 

MD34300 $MA REFP_MARKER_DIST (max. distance to the reference mark) without two 
reference marks being overridden, then the machine axis stops and 
the system issues alarm 20004 "Reference mark missing". 

Phase 2: Traversing to the target point 
The following machine data and interface signals are relevant: 
● MD34070 $MA REFP_VELO_POS (target point positioning velocity) 
● MD34090 $MA REFP_MOVE_DIST_CORR (absolute offset) 
● MD34100 $MA REFP_SET_POS (target point) 
● MD34330 $MA REFP_STOP_AT_ABS_MARKER (with/without target point) 
● IS: DB31, ... DBX60.4, DBX60.5 ("Referenced/synchronized 1, 2") 
Properties of phase 2: 
● The feed rate override (feed rate switch) is active. 
● The feed stop (channelspecific and axisspecific) is active. 
● The machine axis can be stopped and restarted with NC stop/NC start. 
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Determining the absolute offset 
To determine the absolute offset between the measuring system zero point and the machine 
zero, the following procedure is recommended: 
1. Determining the actual position of the measuring system 

After two reference marks following one after the other (synchronized) have been 
overtraveled, the actual position of the length measuring system can be read on the user 
interface at "Actual position".  
The absolute offset must be zero at this time: 

● MD34090 $MA REFP_MOVE_DIST_CORR = 0 
1. Determine the absolute machine actual position 

Determining the absolute machine actual position, e.g., can be performed by traversing 
the machine axis to a known position (fixed stop). Alternatively, it can be measured at any 
position (laser interferometer). 

2. Calculating the absolute offset 
Linear measurement system non-inverse to machine system: 
Absolute offset = machine actual position + actual position of the measuring system 
Linear measuring system inverse to machine system: 
Absolute offset = machine actual position - actual position of the measuring system 

● MD34090 $MA REFP_MOVE_DIST_CORR (reference point/absolute offset) 
 

WARNING  
 

After you have determined the absolute offset and made an entry in 
• MD34090 $MA REFP_MOVE_DIST_CORR (absolute offset) 
the position measuring system must be re-referenced. 

 

Literature 
Function Manual Basic Functions; Reference point approach: Referencing with length 
measuring systems with distancecoded reference marks 



 NCK start-up 
 10.5 Parameterize axis data 

IBN CNC: NCK, PLC, drive 
Commissioning Manual, 03/2009, 6FC5397-2AP10-5BA0 173 

10.5.12.3 Absolute encoders 

Absolute encoder 
Initial referencing of the measuring system of a machine axis with absolute encoder is 
performed by calibrating the encoder.   

Follow-up referencing 
Follow-up referencing of a machine axis is performed automatically while the NC starts up 
without axis movement. The following conditions must be fulfilled: 
● The measuring system of the machine axis active after the booting of the NC works with 

the absolute encoder 
● The absolute encoder is calibrated: 

MD34210 $MA_ENC_REFP_STATE[n] = 2 (absolute value encoder is calibrated) 

Calibration 
To calibrate the absolute encoder, the actual value of the encoder is matched with the 
machine zero once and then enabled. 
The SINUMERIK 840D sl supports the following types of calibration: 
● Operator-assisted calibration 
● Automatic calibration using probe 
● Calibration using BERO 
The calibration using the probe and BERO is described in: 

Literature 
Function Manual Basic Functions; Reference point approach: Automatic adjustment with 
measuring probe, adjustment with BERO 
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Operator-assisted calibration 
During operator-assisted calibration, the machine axis of the absolute encoder is moved to 
the known machine position (reference position). The position value of the reference position 
is taken over by the NC as the reference point value.   
Recommended procedure 
1. Parameterization of referencing mode 

– MD34200 $MA_ENC_REFP_MODE[n] = 0 
2. Approaching referencing position 

Traversing the machine axis to the referencing position in JOG mode. Approach direction 
according to machine data: 
– MD34010 $MA_REFP_CAM_DIR_IS_MINUS (reference point approach in minus 

direction) (0 = positive, 1 = negative approach direction) 
 

NOTICE  
 

To avoid the actual position of the machine axis being falsified by backlash in the 
drive train, reference point approach must be performed at low velocity and always 
from the same direction. 

 

3. Assumption of the reference position in the NC 
The reference position is entered in the machine data: 
– MD34100 $MA_REFP_SET_POS[n] (reference point value) 

4. Enabling encoder calibration 
Encoder calibration is performed in the machine data: 
– MD34210 $MA_ENC_REFP_STATE[n] = 1 

5. Activate changed machine data by NCK reset. 
6. Completing encoder calibration 

When the NC has started up, encoder calibration is completed in mode: JOG > REF for 
the machine axis by once more pressing the direction key as described in point 2: 
– Select JOG > REF mode 
– Select machine axis 
– Press traverse direction key 

 

 
 

Note 
Pressing the traverse direction key does not move the machine axis! 

 

The NC then calculates the reference point offset and enters it in the machine data: 
● MD34090 $MA_REFP_MOVE_DIST_CORR[n] (reference point offset) 

To indicate that calibration has been completed, the value in the machine data changes 
from 1 = enable encoder calibration to 2 = encoder calibrated: 
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● MD34210 $MA_ENC_REFP_STATE[n] = 2 
The value from the machine data is shown as the actual position of the machine axis for 
the current machine position on the user interface: 

● MD34100 $MA_REFP_SET_POS[n] (reference point value) 

Calibrating several absolute encoders 
For time-optimized calibration of the absolute encoders of several machine axes, the 
following procedure is recommended:   
1. Depending on the machine design, move all or several machine axes to their reference 

position. See above: Points 1 to 4. 
2. Perform an NCK reset. See above: Point 5. 
3. Complete encoder calibration for all machine axes. See above: Point 6. 

Recalibration 
Recalibration of the absolute encoder is required after:   
● Gear change between load and absolute encoder 
● Removal/installation of the absolute encoder (encoder replacement) 
● Removal/installation of the motor with the absolute encoder (motor replacement) 
● SRAM data loss of the NC, battery power failure. In this case, it is necessary to load a 

series startup file. 
● PRESET 

 

NOTICE  
 

The status of the absolute encoder is only automatically reset to 1 = "encoder not 
calibrated" by the NCK on gear change: 
• MD34210 $MA_ENC_REFP_STATE[n] = 1 
In all other cases, it is the sole responsibility of the NCK user to indicate the uncalibrated 
state of the absolute encoder by manually resetting the status to "encoder not 
calibrated" and to perform calibration again. 

 

A recalibration of the absolute encoder is also required when machine data MD34210 
$MA_ENC_REFP_STATE[n] is set to zero under the following conditions:  
● Alarm 25020 "Zero mark monitoring of the active encoder" has been issued. 
● The control has been switched off during the consistency check. 
● The encoder number has changed. 

Literature 
Function Manual Basic Functions; Reference point approach: Referencing with absolute 
encoders 
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10.5.12.4 Interface signals and machine data 

Interface signals 

Table 10- 25 Referencing: Interface signals 

DB number Bit, byte Name Reference
Mode-groupspecific Signals from PLC to mode group 
11, ... 0.7 Mode group reset K1 
11, ... 1.2 Machine function REF K1 
Mode-groupspecific Signals from mode group to PLC 
11, ... 5.2 Active machine function REF K1 
Channel-specific Signals from PLC to channel 
21, ... 1.0 Activate referencing  
Channel-specific Signals from channel to PLC 
21, ... 28.7 (MMC -> PLC) REF K1 
21, ... 33.0 Referencing active  
21, ... 35.7 Reset K1 
21, ... 36.2 All axes that must have a reference point are referenced  
Axis-specific Signals from PLC to axis/spindle  
31, ... 1.5/1.6 Position measuring system 1/position measuring system 2 A2 
31, ... 2.4-2.7 Reference point value 1 to 4  
31, ... 4.6/4.7 Traversing keys minus/plus H1 
31, ... 12.7 Reference point approach delay  
Axis-specific Signals from axis/spindle to PLC 
31, ... 60.4/60.5 Referenced, synchronized 1/Referenced, synchronized 2  
31, ... 64.6/64.7 Traverse command minus/plus H1 

Machine data 

Table 10- 26 Referencing: Machine data 

Number Name of Identifier Name Reference
General ($MN_ ... ) 
11300 JOG_INC_MODE_LEVELTRIGGRD INC/REF in jog/continuous mode H1 
Channelspecific ($MC_ ... ) 
20700 REFP_NC_START_LOCK NC start disable without reference point  
axisspecific ($MA_ ... ) 
30200 NUM_ENCS Number of encoders G2 
30240 ENC_TYP Actual value encoder type  
30242 ENC_IS_INDEPENDENT Encoder is independent G2 
31122 BERO_DELAY_TIME_PLUS BERO delay time in plus direction S1 
31123 BERO_DELAY_TIME_MINUS BERO delay time in minus direction S1 
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Number Name of Identifier Name Reference
34000 REFP_CAM_IS_ACTIVE Axis with reference cam  
34010 REFP_CAM_DIR_IS_MINUS Reference point approach in minus direction  
34020 REFP_VELO_SEARCH_CAM Reference point approach velocity  
34030 REFP_MAX_CAM_DIST Maximum distance to reference cam  
34040 REFP_VELO_SEARCH_MARKER[n] Reference point creep speed [encoder number]  
34050 REFP_SEARCH_MARKER_REVERSE[n] Change of direction on reference cam [encoder 

number] 
 

34060 REFP_MAX_MARKER_DIST[n] Maximum distance to reference mark; Maximum 
distance to 2 reference marks with distance-
coded scales [encoder number] 

 

34070 REFP_VELO_POS Reference point positioning velocity  
34080 REFP_MOVE_DIST[n] Reference point distance/target point with 

distance-coded system [encoder number] 
 

34090 REFP_MOVE_DIST_CORR[n] Reference point/absolute offset, distancecoded 
[encoder number] 

 

34092 REFP_CAM_SHIFT Electronic reference cam shift for incremental 
measurement systems with equidistant zero 
marks. 

 

34100 REFP_SET_POS[n] Reference point value [reference point number]  
34102 REFP_SYNC_ENCS Actual value adjustment to the referencing 

measurement system 
 

34110 REFP_CYCLE_NR Axis sequence for channel-specific referencing  
34120 REFP_BERO_LOW_ACTIVE Polarity change of BERO  
34200 ENC_REFP_MODE[n] Referencing mode [encoder number]  
34210 ENC_REFP_STATE[n] Status of absolute value encoder [encoder 

number] 
 

34220 ENC_ABS_TURNS_MODULO Absolute value encoder range for rotary 
encoders 

R2 

34300 ENC_REFP_MARKER_DIST[n] Reference marker distance with distancecoded 
scales [encoder number] 

 

34310 ENC_MARKER_INC[n] Interval between two reference marks with 
distance-coded scales [encoder no.]  

 

34320 ENC_INVERS[encoder] Linear measuring system inverse to machine 
system [encoder number]  

 

34330 REFP_STOP_AT_ABS_MARKER[n] Distancecoded linear measurement system 
without destination point [encoder number] 

 

35150 SPIND_DES_VELO_TOL Spindle speed tolerance S1 
36302 ENC_FREQ_LIMIT_LOW Encoder limit frequency resynchronization  
36310 ENC_ZERO_MONITORING Zero mark monitoring  
30250 ACT_POS_ABS Absolute encoder position at time of deactivation.  

Literature 
Function Manual Basic Functions; Reference point approach: 
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10.6 Parameterization of spindle data 

Reference 

See also 
Spindle data (Page 378) 
Spindle modes (Page 379) 
Initial spindle state (Page 380) 
General functionality (Page 381) 
General functionality (Page 381) 

10.6.1 Setpoint/actual value channels of spindle 
Parameterization of the setpoint/actual value channels of a spindle is identical to 
parameterization of the setpoint and actual value channels of an axis. For this, see Section 
"Setpoint / actual value channels" (Page 375).   
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10.6.2 Gear stages 

Enabling of 
The gear stage change is generally carried out in the following machine data:  
● MD35010 $MA_GEAR_STEP_CHANGE_ENABLE (gear stage change possible, spindle 

has several gear stages) 
If this machine data is not set, the system assumes that the spindle has no gear stages. 

Multiple gearbox steps 
If more than one gearbox step exists, the number of gearbox steps is entered into 
MD35090 $MA_NUM_GEAR_STEPS. 

Parameter sets 
In spindle mode of a spindle, the NC will select the parameter set that suits the current gear 
stage best.   
Gear stage x => parameter set (x+1) => index [x] 
In axis mode of a spindle, the NC always selects the 1st parameter set (index [0], 
independent of the current gear stage. 
The machine data listed in the following are gear stage-dependent machine data of a 
spindle: 
● MD35110 $MA_GEAR_STEP_MAX_VELO[n] (nmax for gear stage change) 
● MD35120 $MA_GEAR_STEP_MIN_VELO[n] (nmin for gear stage change) 
● MD35130 $MA_GEAR_STEP_MAX_VELO_LIMIT[n] (nmax for gear stage) 
● MD35135 $MA_GEAR_STEP_PC_MAX_VELO_LIMIT (nmax for gearbox step with position 

control)  
● MD35140 $MA_GEAR_STEP_MIN_VELO_LIMIT[n] (nmin for gear stage) 
● MD35200 $MA_GEAR_STEP_SPEEDCTRL_ACCEL[n] (acceleration in speed-control 

mode) 
● MD35210 $MA_GEAR_STEP_POSCTRL_ACCEL[n] (acceleration in position control 

mode) 
For further information on parameter sets, see Section "Axis/spindle parameter sets" 
(Page 132). 

Literature 
Function Manual Basic Functions; Spindles: Gear stage change 
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10.6.3 Spindle measuring systems 

Encoder matching 
When parameterizing the measuring systems of spindles, the same conditions apply as for 
parameterization of the measuring systems of rotary axes. This multiple is 2048.    
For incremental measuring systems see Section "Parameterization of incremental measuring 
systems" (Page 134). 
For absolute measuring systems see Section "Parameterization of absolute measuring 
systems" (Page 138). 

 

NOTICE  
If the motor encoder is used for actual-value sensing, the encoder matching data must be 
entered in the machine data for each individual gear stage if several gear stages are 
present. 

 

Pulse multiplication factor 
The maximum multiplication of the appropriate drive is always used as the multiplication of 
the increments.   
Examples of encoder adaptation 

Example A: encoder on the spindle 
Suppose the following conditions are provided: 
● The incremental encoder is mounted on the spindle. 
● Encoder pulses = 500 [pulses/rev.] 
● Pulse multiplication = 128 
● Internal precision = 1000 [increment/degree] 
● Sensor ratio = 1:1 
● Load ratio = 1:1 
The machine data are set acc. to the values above: 
● MD10210  $MN_INT_INC_PER_DEG (computational resolution) = 1,000 [incr./degree] 
● MD31020 $MA_ENC_RESOL (encoder resolution) = 500 [pulses/revolution] 
● MD31050 $MA_DRIVE_AX_RATION_DENOM (load rev. denominator) = 1 
● MD31060 $MA_DRIVE_AX_RATION_NUMERA (load rev. numerator) = 1 
● MD31070 $MA_DRIVE_ENC_RATION_DENOM (sensor speed denominator) = 1 
● MD31080 $MA_DRIVE_ENC_RATION_NUMERA (sensor speed numerator) = 1 
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One encoder increment corresponds to 5.625 internal increments. 
One encoder increment corresponds to 0.005625 degrees (highest possible positioning 
resolution). 

Example B: encoder at motor 
Suppose the following conditions are provided: 
● The incremental encoder is mounted on the motor. 
● Encoder pulses = 2048 [pulses/rev.] 
● Pulse multiplication = 128 
● Internal precision = 1000 [increment/degree] 
● Sensor ratio = 1:1 
● Load ratio 1= 2.5:1 [motor speed/spindle speed] 
● Load ratio 2= 1:1 [motor speed/spindle speed] 
Gear stage 1 

 
 

 
One encoder increment corresponds to 0.54932 internal increments. 
One encoder increment corresponds to 0.00054932 degrees (highest possible positioning 
resolution). 
Gear stage 2 

 
One encoder increment corresponds to 1.3733 internal increments. 
One encoder increment corresponds to 0.0013733 degrees (highest possible positioning 
resolution). 
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10.6.4 Speeds and setpoint adjustment for spindle 

Speeds, gear stages 
In SINUMERIK solution line, data for five gear stages are implemented. These stages are 
defined by a minimum and maximum speed for the stage itself and by a minimum and 
maximum speed for the automatic gear stage changeover.    
A new set gear stage is output only if the new programmed speed cannot be traversed in the 
current gear stage. For the sake of simplification, the oscillation times for gear stage 
changeovers can be specified directly in the NC; the oscillation function must otherwise be 
implemented in the PLC. The oscillation function is initiated via the PLC. 

 
Figure 10-21 Example for speed ranges for automatic gear stage selection (M40) 

Speeds for conventional operation 
The speeds of the spindle in conventional mode are entered in the machine data: 
● MD32010 $MA_JOG_VELO_RAPID (rapid traverse in jog mode) 
● MD32020 $MA_JOG_VELO (axis velocity in JOG mode) 
  
The direction of rotation is specified via the appropriate directional keys for the spindle on the 
MCP. 
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Direction of rotation 
The direction of rotation of a spindle corresponds to the traversing direction of an axis. 

Setpoint matching 
The speeds must be transferred with standardized values for the drive controller. The values 
are scaled in the NC using the selected load gear and the appropriate drive parameter.   

Machine data 

Table 10- 27 Speeds and setpoint adjustment for spindle: Machine data 

Axisspecific ($MA_ ... ) 
31050 DRIVE_AX_RATIO_DENOM Denominator load gearbox  
31060 DRIVE_AX_RATIO_NUMERA Numerator load gearbox  
32010 JOG_VELO_RAPID Rapid traverse in the JOG mode  
32020 JOG_VELO JOG axis velocity  
35010 GEAR_STEP_CHANGE_ENABLE Gear stage change possible  
35020 SPIND_DEFAULT_MODE Basic spindle setting  
35030 SPIND_DEFAULT_ACT_MASK Activate initial spindle setting  
35040 SPIND_ACTIVE_AFTER_RESET Spindle active after reset  
35200 GEAR_STEP_SPEEDCTRL_ACCEL[n] Acceleration in speed control mode  
35220 ACCEL_REDUCTION_SPEED_POINT Speed limit for reduced acceleration  
35230 ACCEL_REDUCTION_FACTOR Reduced acceleration  
35400 SPIND_OSCILL_DES_VELO Oscillation speed  
35410 SPIND_OSCILL_ACCEL Oscillation acceleration  
35430 SPIND_OSCILL_START_DIR Oscillation start direction  
35440 SPIND_OSCILL_TIME_CW Oscillation time for M3 direction  
35450 SPIND_OSCILL_TIME_CCW Oscillation time for M4 direction  
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Interface signals 

Table 10- 28 Speeds and setpoint adjustment for spindle: Interface signals 

DB number Bit, byte Name Reference
Axis-specific Signals from PLC to axis/spindle 
31, ... 4.6 Traversing keys minus  
31, ... 4.7 Traversing keys plus  
31, ... 16.2-16.0 Actual gear stage  
31, ... 16.3 Gear changed  
31, ... 16.6 No speed monitoring when changing the gear  
31, ... 18.4 Oscillation via PLC  
31, ... 18.5 Oscillation speed  
Axis-specific Signals from axis/spindle to PLC 
31, ... 82.2-82.0 Set gear stage  
31, ... 82.3 Change gear  
31, ... 84.7 Active spindle control mode  
31, ... 84.6 Active spindle mode oscillation mode  
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10.6.5 Position spindle 
The NC provides an oriented spindle stop function with which the spindle can be moved into 
a certain position and held there (e.g. for tool changing purposes). Several programming 
commands are available for this function which define the approach and program 
processing.   

Literature 
Function Manual Basic Functions; Spindles 

Functionality 
● To absolute position (0-360 degrees) 
● Incremental position (+/- 999999.99 degrees) 
● Positioning without influence of block change (SPOSA) 
● Block change when block end position is reached (calculated by interpolation) 
The control brakes the spindle down to position control speed at the acceleration rate for 
speed operation.  
If position control speed has been reached, the control branches into position control mode 
and the acceleration rate for position control mode and the KV factor become active. 
The interface signal "Exact stop fine" is output to indicate that the programmed position has 
been reached (block change when position reached). 
Acceleration rate for position control mode must be set such that the current limit is not 
reached. Acceleration rate must be entered separately for each gear step. 
If the spindle is positioned from zero speed, it is accelerated up to a maximum speed 
corresponding to position control speed; the direction is defined via machine data. If there is 
no reference, the direction of actuation is as in MD35350 SPIND_POSITIONING_DIR. When 
position control mode is switched on, contour monitoring is also activated. 
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Machine data 

Table 10- 29 Spindle positioning: Machine data 

axisspecific ($MA_ ... ) 
35300 SPIND_POSCTRL_VELO position control activation speed  
35350 SPIND_POSITIONING_DIR Direction of rotation when positioning from the 

standstill 
 

35210 GEAR_STEP_POSCTRL_ACCEL  Acceleration in position control mode  
36000 STOP_LIMIT_COARSE Exact stop coarse  
36010 STOP_LIMIT_FINE Exact stop fine  
32200 POSCTRL_GAIN KV factor  
36400 CONTOUR_TOL Contour monitoring  

Interface signals 

Table 10- 30 Spindle positioning: Interface signals 

DB number Bit, byte Name Reference
Axis-specific Signals from axis/spindle to PLC 
31, ... 60.6 Position reached with exact stop "fine"  
31, ... 60.7 Position reached with exact stop "coarse"  
31, ... 84.5 Positioning mode  
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10.6.6 Synchronizing spindle 
To allow the spindle to be positioned from the NCK, its position has to be adjusted using the 
measuring system. This operation is called "synchronization".   
As a rule, synchronizing is done to the zero mark of the connected encoder or to a reference 
cam as zero mark substitute. 
The following machine data defines the actual position of the spindle at the zero mark 
position: 
● MD34100 $MA_REFP_SET_POS (reference point value) 
The zero mark offset is entered in the following machine data: 
● MD34090 $MA_REFP_MOVE_DIST_CORR (reference point offset) 
The following machine data specifies which signal is used for synchronization: 
● MD34200 $MA_ENC_REFP_MODE (homing mode) 

1 = Encoder zero mark 
2 = Bero 

When is synchronization necessary? 
The spindle will be synchronized: 
● after the NC has powered up when the spindle is moved using a programming command 
● after a request for resynchronization by the PLC 

NST DB31,... DBX16.4 (resynchronize spindle 1) 
NST DB31,... DBX16.5 (resynchronize spindle 2) 

● after each gear stage change for an indirect measuring system 
MD31040 $MA_ENC_IS_DIRECT (direct measuring system) = 0 

● when the encoder limit frequency falls below the programmed value after a speed has 
been programmed which is above the encoder limit frequency. 

 

NOTICE  
 

If the spindle encoder is not mounted directly on the spindle and there are gear ratios 
between the encoder and spindle (e.g. encoder mounted on motor), then a BERO signal 
connected to the drive (SERVO) must be used for synchronization. The control system 
then automatically resynchronizes the spindle after each gear stage change. The user 
does not have to contribute anything here. 
In general, backlash, gearbox elasticity and reference cam hysteresis reduce the 
accuracy achievable during synchronization. 
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Machine data 

Table 10- 31 Synchronizing spindle: Machine data 

Axisspecific ($MA_ ... ) 
34100 REFP_SET_POS Reference point value  
34090 REFP_MOVE_DIST_CORR Reference point offset  
34200 REFP_MODE Referencing mode  

Interface signals 

Table 10- 32 Synchronizing spindle: Interface signals 

DB number Bit, byte Name Reference
Axis-specific Signals from PLC to axis/spindle  
31, ... 16.4 Synchronize spindle 1  
31, ... 16.5 Synchronize spindle 2  
Axis-specific Signals from axis/spindle to PLC 
31, ... 60.4 Referenced/synchronized 1  
31, ... 60.5 Referenced/synchronized 2  
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10.6.7 Spindle monitoring 

Axis/spindle stops 
If the velocity falls below the one specified in the following machine data, then the interface 
signal IS DB31,... DBX61.4 (axis/spindle stops) is set:  
● MD36060 $MA_STANDSTILL_VELO_TOL (maximum velocity/speed for "Axis/Spindle 

stopped") 
The path feedrate is then released in the following set machine data: 
● MD35510 $MA_SPIND_STOPPED_AT_IPO_START (feed enable for "Spindle stopped") 

Spindle in setpoint range 
If the spindle reaches the tolerance range specified in the following machine data, then the 
interface signal IS DB31,... DBX83.5 (spindle in setpoint range) is set: 
● MD35150 $MA_SPIND_DES_VELO_TOL (spindle speed tolerance) 
The path feedrate is then released in the following set machine data: 
● MD35510 $MA_SPIND_STOPPED_AT_IPO_START (feed enable for "Spindle stopped") 

Maximum spindle speed 
The maximum spindle speed is entered in the following machine data: 
● MD35100 $MA_SPIND_VELO_LIMIT (max. spindle speed) 
The NC limits the spindle speed to this value. 
Error reaction: 
If the speed is nevertheless exceeded by the speed tolerance (drive error), the following 
signal is output: 
● IS DB31,... DBX83.0 (speed limit exceeded) = 1 
● Alarm "22150 Maximum number of chucks exceeded" 
The following machine data also limits the speed of the spindle: 
● MD36200 $MA_AX_VELO_LIMIT (velocity-monitoring threshold) 
When the speed is exceeded, an alarm is generated. 
In position-controlled mode (e.g. SPCON), the NC limits the specified maximum speed 
specified in machine or setting data to 90% of the maximum value (control reserve). 
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Gear stage speed min./max. 
The default of a max./min. gear stage speed is entered in the following machine data: 
● MD35130 $MA_GEAR_STEP_MAX_VELO_LIMIT (maximum speed for gear stage) 
● MD35140 $MA_GEAR_STEP_MIN_VELO_LIMIT (minimum speed for gear stage) 
The speed cannot leave this range when the appropriate gear stage is engaged. 

Programmed Spindle speed limitations 
The following functions can be used to specify a spindle speed limitation in an indexing 
program: 
● G25 S... (min. spindle speed) 
● G26 S... (max. spindle speed) 
The limitation is active in all operating modes. 
The function LIMS=... can be used to specify a spindle speed limit for G96 (constant cutting 
rate): 
● LIMS=... (speed limitation (G96)) 
This limitation is only effective when G96 is active. 

Encoder frequency limit 
If the sensor limit frequency in the following machine data is exceeded, synchronization of 
the spindle is lost and spindle functionality is reduced (thread, G95, G96): 
● MD36300 $MA_ENC_FREQ_LIMIT (encoder limit frequency) 
The spindle will be re-synchronized automatically once the sensor frequency falls below the 
value defined in the following machine data: 
● MD36302 $MA_ENC_FREQ_LIMIT_LOW (encoder limit frequency at which the encoder 

is turned on again) 
The encoder limit frequency value must be such that the mechanical encoder speed limit is 
not exceeded or else the synchronization from high speeds will be incorrect. 
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Figure 10-22 Ranges of spindle monitoring functions/speeds 

Literature 
Function Manual Basic Functions; Spindles: Spindle monitoring 
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10.6.8 Spindle data 

Machine data  

Table 10- 33 Spindle: Machine data 

Number Name of identifier Name 
General ($MN_ ... ) 
12060 OVR_SPIND_IS_GRAY_CODE Spindle override with Gray coding 
12070 OVR_FACTOR_SPIND_SPEED Evaluation of spindle speed override switch 
12080 OVR_REFERENCE_IS_PROG_FEED Override reference velocity 
Channelspecific ($MC_ ... ) 
20090 SPIND_DEF_MASTER_SPIND Initial setting for master spindle on channel 
20092 SPIND_ASSIGN_TAB_ENABLE Enabling/disabling of spindle converter 
20118 GEOAX_CHANGE_RESET Allow automatic geometry axis change 
22400 S_VALUES_ACTIVE_AFTER_RESET S function active after RESET 
Axisspecific ($MA_ ... ) 
30300 IS_ROT_AX Rotary axis 
30310 ROT_IS_MODULO Modulo conversion  
30320 DISPLAY_IS_MODULO Position display 
31050 DRIVE_AX_RATIO_DENOM Denominator load gearbox 
31060 DRIVE_AX_RATIO_NUMERA Numerator load gearbox 
31122 BERO_DELAY_TIME_PLUS BERO delay time in plus direction 
31123 BERO_DELAY_TIME_MINUS BERO delay time in minus direction 
32200 POSCTRL_GAIN KV factor 
32810 EQUIV_SPEEDCTRL_TIME Equivalent time constant speed control loop for 

feedforward control 
32910 DYN_MATCH_TIME Time constant for dynamic matching 
34040 REFP_VELO_SEARCH_MARKER Reference point creep speed 
34060 REFP_MAX_MARKER_DIST Monitoring of zero mark distance  
34080 REFP_MOVE_DIST Reference point distance/destination point for distance-

coded system 
34090 REFP_MOVE_DIST_CORR Reference point offset/absolute offset, distancecoded 
34100 REFP_SET_POS Reference point value 
34200 ENC_REFP_MODE Homing mode 
35000 SPIND_ASSIGN_TO_MACHAX Assignment of spindle to machine axis 
35010 GEAR_STEP_CHANGE_ENABLE Gear stage change possible 
35012 GEAR_STEP_CHANGE_POSITION Gear stage change position 
35020 SPIND_DEFAULT_MODE Basic spindle setting 
35030 SPIND_DEFAULT_ACT_MASK Activate initial spindle setting 
35040 SPIND_ACTIVE_AFTER_RESET Spindle active after reset 
35100 SPIND_VELO_LIMIT Maximum spindle speed 
35110 GEAR_STEP_MAX_VELO[n] Maximum speed for gear change 
35120 GEAR_STEP_MIN_VELO[n] Minimum speed for gear change 
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Number Name of identifier Name 
35130 GEAR_STEP_MAX_VELO_LIMIT[n] Maximum speed of gear stage 
35140 GEAR_STEP_MIN_VELO_LIMIT[n] Minimum speed of gear stage 
35150 SPIND_DES_VELO_TOL Spindle speed tolerance 
35160 SPIND_EXTERN_VELO_LIMIT Spindle speed limitation via PLC 
35200 GEAR_STEP_SPEEDCTRL_ACCEL[n] Acceleration in speed control mode 
35210 GEAR_STEP_POSCTRL_ACCEL[n] Acceleration in position control mode 
35220 ACCEL_REDUCTION_SPEED_POINT Speed limit for reduced acceleration 
35230 ACCEL_REDUCTION_FACTOR Reduced acceleration 
35300 SPIND_POSCTRL_VELO position control activation speed 
35350 SPIND_POSITIONING_DIR Positioning direction of rotation for a nonsynchronized 

spindle 
35400 SPIND_OSCILL_DES_VELO Oscillation speed 
35410 SPIND_OSCILL_ACCEL Oscillation acceleration 
35430 SPIND_OSCILL_START_DIR Oscillation start direction 
35440 SPIND_OSCILL_TIME_CW Oscillation time for M3 direction 
35450 SPIND_OSCILL_TIME_CCW Oscillation time for M4 direction 
35500 SPIND_ON_SPEED_AT_IPO_START Feed enable with spindle in setpoint range 
35510 SPIND_STOPPED_AT_IPO_START Feed enable with stationary spindle 
35590 PARAMSET_CHANGE_ENABLE Parameter set definition possible from PLC 
36060 STANDSTILL_VELO_TOL Threshold velocity "Axis/spindle stationary" 
36200 AX_VELO_LIMIT Threshold value for velocity monitoring 

Setting data 

Table 10- 34 Spindle: Setting data 

Number Identifier Name 
Spindlespecific ($SA_ ... ) 
42600 JOG_FEED_PER_REF_SOURCE Revolutional feedrate control in JOG mode 
42800 SPIND_ASSIGN_TAB Spindle number converter 
42900 MIRROR_TOOL_LENGTH Mirror tool length offset 
42910 MIRROR_TOOL_WEAR Mirror wear values of tool length compensation 
42920 WEAR_SIGN_CUTPOS Mirror wear values of machining plane 
42930 WEAR_SIGN Invert sign of all wear values 
42940 TOOL_LENGTH_CONST Retain the assignment of tool length components when 

changing the machining plane (G17 to G19) 
43210 SPIND_MIN_VELO_G25 Progr. Spindle speed limiting G25 
43220 SPIND_MAX_VELO_G26 Progr. Spindle speed limiting G26 
43230 SPIND_MAX_VELO_LIMS Progr. spindle speed limitation with G96 
43300 ASSIGN_FEED_PER_REF_SOURCE Rotational feedrate for positioning axes/spindles 



NCK start-up  
10.6 Parameterization of spindle data 

 IBN CNC: NCK, PLC, drive 
194 Commissioning Manual, 03/2009, 6FC5397-2AP10-5BA0 

Interface signals 

Table 10- 35 Spindle: Interface signals 

DB number Bit, byte Name 
Axis-specific Signals from PLC to axis/spindle 
31, ... 0 Feed override 
31, ... 1.7 Override active 
31, ... 1.6 Position measuring system 2 
31, ... 1.5 Position measuring system 1 
31, ... 1.4 Followup mode 
31, ... 1.3 Axis/spindle disable 
31, ... 2.2 Spindle reset/delete distancetogo 
31, ... 2.1 Servo enable  
31, ... 3.6 Velocity/spindle speed limitation 
31, ... 16.7 Delete S value 
31, ... 16.5 Resynchronize spindle 2 
31, ... 16.4 Resynchronize spindle 1 
31, ... 16.3 Gear changed 
31, ... 16.2-16.0 Actual gear stage A to C 
31, ... 17.6 Invert M3/M4 
31, ... 17.5 Resynchronize spindle during positioning 2 
31, ... 17.4 Resynchronize spindle during positioning 1 
31, ... 18.7 Direction of rotation setpoint left 
31, ... 18.6 Direction of rotation setpoint right 
31, ... 18.5 Oscillation speed 
31, ... 18.4 Oscillation via PLC 
31, ... 19.7 - 19.0 Spindle offset H - A 
Axis-specific Signals from axis/spindle to PLC 
31, ... 60.7 Position reached with exact stop fine  
31, ... 60.6 Position reached with exact stop coarse 
31, ... 60.5 Referenced/synchronized 2 
31, ... 60.4 Referenced/synchronized 1 
31, ... 60.3 Encoder limit frequency exceeded 2 
31, ... 60.2 Encoder limit frequency exceeded 1 
31, ... 60.0 Axis/no spindle 
31, ... 61.7 Current controller active 
31, ... 61.6 Speed control loop active 
31, ... 61.5 Position controller active 
31, ... 61.4 Axis/spindle stationary (n < nmin) 
31, ... 82.3 Change gear 
31, ... 82.2-82.0 Set gear stage AC 
31, ... 83.7 Actual direction of rotation clockwise 
31, ... 83.5 Spindle in setpoint range 
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DB number Bit, byte Name 
31, ... 83.2 Setpoint speed increased 
31, ... 83.1 Setpoint speed limited 
31, ... 83.0 Speed limit exceeded 
31, ... 84.7 Active spindle control mode 
31, ... 84.6 Active spindle mode oscillation mode 
31, ... 84.5 Active spindle positioning mode 
31, ... 84.3 Rigid tapping active 
31, ... 86 and 87 M function for spindle 
31, ... 88-91 S function for spindle 
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Optimize the drive. 11
 

You can optimize the drives in the "Commissioning" > "Optimization/Test" operating area.  

 
Figure 11-1 Optimization/test 

The following functions are available: 
● Frequency response measurements for the following control loops: 

– Current controller 
– Speed controller 
– Position controller 

● Automatic controller setting 
● Function generator 
● Circularity test 
● Trace 

– Servo trace 
– Drive trace 
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Measuring functions 
The measuring functions make it possible to assess the automatic controller action of the 
respective control loop (frequency response) by the integrated FFT analysis (Fast Fourier 
Transformation) without external measuring equipment.   
The measurement results are represented graphically as a Bode diagram. HMI file functions 
can be used to archive the diagrams for documentation purposes and to simplify remote 
diagnostics. 

Circularity test 
The circularity test serves to set and assess the dynamic response for interpolating axes or 
to analyze the contour accuracy on the quadrant transitions (circular contours) achieved by 
means of friction compensation (conventional or neural quadrant error compensation).   

Reference 
Function Manual Extended Functions, K3 Compensation, Section "Circularity test" 

Servo trace 
Servo trace provides a graphically assisted analysis of the time response of position 
controller and drive data. 

Drive trace 
Drive trace provides a graphically assisted analysis of the time response of drive signals. 
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11.1 Measuring functions 

Explanation 
A range of measuring functions allows the time and/or frequency response of drives and 
closed-loop controls to be displayed in graphic form on the screen. For this purpose, test 
signals with an adjustable interval are connected to the drives. 

Measurement/signal parameters 
The test setpoints are adapted to the application in question by means of measurement or 
signal parameters, the units of which are determined by the relevant measuring function or 
operating mode. The measurement or signal parameter units are subject to the following 
conditions: 

Table 11- 1 Quantity and units for measurement or signal parameters 

Size Unit 
Velocity Metric system: 

Specification in mm/min or rev/min for translatory or rotary 
movements 
Inch system: 
Specification in inch/min or rev/min for translatory or rotary 
movements 

Distance Metric system: 
Specification in mm or degrees for translatory or rotary 
movements 
Inch system: 
Specification in inch or degrees for translatory or rotary 
movements 

Time Specified in ms 
Frequency Specified in Hz 

 
 

 Note 
The default setting for all parameters is 0. 
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Preconditions for starting measuring functions 
To ensure that no erroneous traversing movements due to part programs can be carried out, 
the measuring functions have to be started in <JOG> mode. 

 

CAUTION  
When traversing movements are carried out within the framework of measuring functions, 
no software limit switches and working area limitations are monitored, since these are 
carried out in follow-up mode. 
Prior to starting traversing movements, the user must therefore ensure that the axes are 
positioned such that the traversing limits specified within the framework of the measuring 
functions are sufficient to prevent collision with the machine. 

 

Starting measuring functions 
Measuring functions initiating a traversing movement are only selected using the specific 
softkey. The actual start of the measuring function and thus of the traversing movement is 
always carried out with <NC-START> on the machine control panel. 
If the main screen of the measuring function is quitted without the traversing movement 
being initiated, the selection of the traversing function is canceled. 
Once the traversing function has been started, the main screen can be exited without any 
affect on the traversing movement. 

 

 Note 
<JOG> mode must be selected when measuring functions are started. 

 

Further safety notices 
The user must ensure that when the measuring functions are used: 
● The <EMERGENCY STOP> button is always within reach. 
● No obstacles are in the traversing range. 
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Canceling measuring functions 
The following events will cancel active measuring functions: 
● Hardware limit switch reached 
● Traversing range limits exceeded 
● Emergency stop 
● Reset (mode group, channel) 
● NC STOP 
● No controller enabling command 
● Canceling drive enable 
● Canceling traversing enable 
● Selection of parking (in position-controlled operation). 
● Feed override = 0% 
● Spindle override = 50% 
● Change in operating mode (JOG) or operating mode JOG not selected 
● Actuation of traversing keys 
● Actuation of handwheel 
● Alarms leading to axis shutdown 
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11.2 Frequency response measurements 

11.2.1 Current control loop measurement 

Functionality 
The current control loop only needs to be measured for diagnostic purposes if there is a fault 
or if there is no standard data for the motor / power unit combination (third-party motor). 

 

CAUTION  
The user must take special safety measures when measuring the current control loop (e.g. 
secure drive clamping) for hanging axes without external counterweight. 

 

Operating path 
Operating path for measuring the current control loop: Operating area switchover > 
"Commissioning" > "Optimization/Test" > "Current control loop" 

Measuring functions 
The following measuring functions are available for measuring the current control loop: 
 
Measuring type Measured variable 
Reference frequency response 
(downstream of the current setpoint filter) 

Torque-generating actual current value / 
torque-generating current setpoint 

Setpoint step change (downstream of the 
current setpoint filter) 

Measured variable 1: Torque-generating current setpoint
Measured variable 2: Torque-generating actual current 
value 
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Measurement 
The measurement sequence is divided into the following steps: 
1. Setting the traverse range monitoring and the enable logic. 
2. Selecting the measurement type 
3. Setting the parameters, softkey "Measuring parameters" 
4. Displaying the measurement results, softkey "Display" 

 
Figure 11-2 Current controller 

Measuring parameters 
● Amplitude 

Magnitude of the test signal amplitude. Given in percent of the peak torque. Values from 
1% to 5% are suitable. 

● Bandwidth 
The frequency range analyzed with the measurement.  
The bandwidth depends on the current controller sampling time.  
Example: 
125 μs current controller sampling time, set bandwidth 4000 Hz 
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11.2.2 Speed control loop measurement 

Functionality 
The response characteristics for the motor measuring system are analyzed when measuring 
the speed control loop. Various measurement parameter lists are available depending on the 
basic measurement setting which has been selected. 

Operating path 
Operating path for measuring the speed control loop: Operating area switchover > 
"Commissioning" > "Optimization/Test" > "Speed control loop" 

Measuring functions 
The following measurement functions are available for measuring the speed control loop: 
 
Measuring type Measured variable 
Reference frequency response (downstream of 
the speed setpoint filter) 

Actual speed value motor encoder/speed setpoint 
after filter 

Reference frequency response (upstream of 
the speed setpoint filter) 

Actual speed value motor encoder/speed setpoint 
after filter 

Setpoint step change (downstream of the 
speed setpoint filter) 

Measured variable 1: 
• Speed setpoint downstream of the filter 
• Actual torque value 
Measured variable 2: Actual speed value motor 
encoder 

Interference frequency response (fault 
downstream of the current setpoint filter) 

Actual speed value motor encoder / torque setpoint 
fct. generator 

Disturbance variable step change (fault 
downstream of the current setpoint filter) 

Measured variable 1: 
• Torque setpoint fct. generator 
• Actual torque value 
Measured variable 2: Actual speed value motor 
encoder 

Speed-controlled system (excitation 
downstream of the current setpoint filter) 

Actual speed value motor encoder/actual torque 
value 

Frequency response of the mechanical parts 1) Actual speed value measuring system 1/actual 
speed value measuring system 2 

1) The machine axis in question must have both a direct and an indirect measuring system to 
determine the frequency response of the mechanical parts. 
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Measurement 
The measurement sequence is divided into the following steps: 
1. Setting the traverse range monitoring and the enable logic 
2. Selecting the measuring type and measured variable 
3. Setting the parameters, softkey "Measuring parameters" 
4. Displaying the measurement results, softkey "Display" 

 
Figure 11-3 Speed controller 

In the example shown, the speed control loop has not yet been optimized. 
A suitable filter parameterization is used to optimize the dynamic response. This can be 
called with the "Filter" softkey. 
The following figure shows the standard settings for a low-pass filter at 1999 Hz (encoder 
mounting frequency).  

 
Figure 11-4 Standard settings of the speed control loop filter 
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Figure 11-5 Speed control loop filter with rejection band 1190 Hz 

The use of a rejection band at 1190 Hz and adaptation of the proportional gain results in the 
following optimized setting for the speed control loop. 

 
Figure 11-6 Optimized speed control loop 
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11.2.3 Position control loop measurement 

Functionality 
This measuring function basically analyzes the response to the active position measuring 
system. If the function is activated for a spindle without a position measuring system, an 
alarm is displayed. Depending on the measured variable selected, various measurement 
parameter lists are displayed.   

Operating path 
Operating path for measuring the speed control loop: Operating area switchover > 
"Commissioning" > "Optimization/Test" > "Position control loop" 

Measuring functions 
The following measuring functions are available for measuring the position control loop: 
 
Measuring type Measured variable 
Reference frequency response Actual position/position setpoint 
Setpoint step change Measured variable 1: Position setpoint 

Measured variable 2: 
• Actual position value 
• System deviation 
• Following error 
• Actual speed value 

Setpoint ramp Measured variable 1: Position setpoint 
Measured variable 2: 
• Actual position value 
• System deviation 
• Following error 
• Actual speed value 
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Measurement 
The measurement sequence is divided into the following steps: 
1. Setting the traverse range monitoring and the enable logic 
2. Selecting the measuring type and measured variable 
3. Setting the parameters, softkey: "Measuring parameters" 
4. Displaying the measurement results, softkey: "Display" 
The following figure shows an optimized position control loop in which the Kv factor has been 
adapted via the machine data MD32200 $MA_POSCTRL_GAIN. 

 
Figure 11-7 Optimized position control loop 
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Reference frequency response measurement 
The reference frequency response measurement determines the transmission ratio of the 
position controller in the frequency range (active position measuring system).   
The setpoint filters, control loop gain (Kv factor) and feedforward control must be 
parameterized such that resonance is avoided wherever possible over the entire frequency 
range.  
Measuring parameters 
● Amplitude 

This parameter determines the magnitude of the test signal amplitude. It should be set to 
the smallest possible value (e.g. 0.01 mm). 

● Bandwidth 
The bandwidth parameter is used to set the analyzed frequency range. The larger this 
value, the finer the frequency resolution and the longer the measurement time. The 
maximum value is specified by the position controller cycle (Tposition controller):  
Bandwidthmax [Hz] = 1 / (2 * Tposition controller [sec]) 
 
Example: 
Position controller cycle: 2 ms 
Bandwidthmax = 1 / (2 * 2*10-3) = 250 Hz 

● Averaging 
The accuracy of the measurement and measurement duration increase with this value. A 
value of 20 is normally suitable. 

● Settling time 
This value represents the delay between recording of the measured data and injection of 
the test setpoint and offset. A value of between 0.2 and 1 s is recommended. Do not set 
too low a value for the settling times or the frequency response and phase diagrams will 
be distorted. 

● Offset 
The measurement requires a slight speed offset of a few motor revolutions per minute. 
The offset must be set such that no speed zero crossings occur at the set amplitude. 
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Measurement: Setpoint step change and setpoint ramp 
The transient or positioning response of the position control in the time range, and in 
particular the effect of setpoint filters, can be assessed with the step and ramp stimulation 
functions.   
Possible measured variables: 
● Actual position value (active position measuring system) 
● Control deviation (following error) 
Measuring parameters 
● Amplitude 

Determines the magnitude of the specified setpoint step change or ramp. 
● Measurement time 

This parameter determines the period of time to be recorded (maximum: 2048 position 
controller cycles). 

● Settling time 
This value represents the delay between measured data recording / test setpoint output 
and the injection of the offset. 

● Ramp time 
With default setting: The position reference value is specified with the "Setpoint ramp" 
according to the set ramp time. In this case, the acceleration limits which currently apply 
to the axis or spindle are effective. 

● Offset 
The step is stimulated from standstill or starting from the constant traverse speed set in 
this parameter. 
If an offset value other than zero is input, the step change is stimulated during traversal. 
For the sake of clarity, the displayed actual position value does not include this speed 
offset. 
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Figure 11-8 Signal chart for position setpoint/ramp measuring function  

At maximum axis velocity, there is a (virtual) step change in the velocity (continuous line). 
The curves represented by the dashed line correspond to a realistic, finite value. The offset 
component is excluded from the display graphic in order to emphasize the transient 
processes. 

Measurement: Setpoint step change 
To avoid overloading the mechanical system of the machine, the step height is limited to the 
value specified in the machine data during the "Setpoint step change" measurement:   
● MD32000 $MA_MAX_AX_VELO (maximum axis velocity) 
This may result in failure to achieve the desired step height. 
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Measurement: Setpoint ramp 
With measurement "Setpoint ramp", the following machine data influence the measurement 
result:   
● MD32000 $MA_MAX_AX_VELO (maximum axis velocity) 

The maximum axis velocity limits the ramp gradient (velocity limitation). The drive does 
not reach the programmed end position (amplitude). 

● MD32300 $MA_MAX_AX_ACCEL (maximum axis acceleration) 
The maximum axis acceleration limits the velocity change (acceleration limitation). This 
leads to "rounding" on the transitions at the beginning and end of the ramp. 

 

CAUTION  
 

In normal cases the machine data corresponds exactly with the load capacity of the 
machine kinematics and should not be changed (increased) as part of the 
measurements: 
• MD32000 $MA_MAX_AX_VELO (maximum axis velocity) 
• MD32300 $MA_MAX_AX_ACCEL (maximum axis acceleration) 
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11.3 Circularity test measurement 

Functionality 
The circularity test serves to set and assess the dynamic response for interpolating axes or 
to analyze the contour accuracy on the quadrant transitions (circular contours) achieved by 
means of friction compensation (conventional or neural quadrant error compensation). 

Operating path 
Operating path to circularity test: Operating area switchover > "Commissioning" > 
"Optimization/Test" > "Circularity test" 

Measuring parameters 
The parameters are entered in the "Measurement" menu. 
● Axis names and axis numbers 
● Circle that is to be traversed and the actual position values recorded 

The parameter settings in the input fields "Radius" and "Feed" must correspond to the 
values from the part program that controls the circular motion of the axes, taking account 
of the feed override switch setting.  

● The "Measuring time" display field shows the measuring time calculated from the 
"Radius" and "Feed" values for recording the actual position values during the circular 
movement. 
If only parts of the circle can be represented (i.e. measuring time too short) the measuring 
time can be increased in the menu by reducing the feed value. This also applies if the 
circularity test is started from the stationary condition. 
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Display mode 
The following parameter assignments for programming the mode of representation of 
measurement results can also be made: 
● Display based on mean radius 
● Display based on programmed radius 
● Scaling of the diagram axes 
If the measuring time calculated exceeds the time range that can be displayed from the trace 
buffers (maximum measuring time = position controller cycle frequency * 2048), a coarser 
sampling rate is used for recording (n * position controller cycle frequency), so that a 
complete circle can be displayed. 

 
Figure 11-9 Circularity test measurement parameters 

The two drives selected for measurement must describe a circular interpolation (G2/G3) with 
the parameters shown in the example via a part program: 
Radius=100 mm, F=10000 mm/min 
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Measurement 
The measurement sequence is divided into the following steps: 
1. Setting the parameters, softkey "Measurement" (see above figure). 
2. Start measurement with "Start" softkey. 

The selected axes run in the part program. 
3. Displaying the measurement results, softkey "Display". 

A switchover is made to the graphic illustration of the recorded circular diagram (see 
following figure). 

 

 
 

Note 
If required, a QEC / backlash compensation can be performed via MD32200 
$MA POSCTRL_GAIN for the KV factor optimization. 

 

 
Figure 11-10 Circularity test measurement 
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11.4 Trace 

11.4.1 Trace overview 

Introduction 
A trace shows signals over a time interval (signal charts) 
The following functions are available: 
● Servo trace 

Servo trace offers functions for recording and graphically illustrating the temporal 
characteristics of values for servo signals, e.g. actual position value, following error etc. 

● Drive trace 
Drive trace offers functions for recording and graphically illustrating the temporal 
characteristics of values for signals from the drive system, e.g. actual speed value, actual 
current value etc.  
It must be possible for the signals to be recorded to be interconnected via a BICO source. 

 

11.4.2 Servo trace 

Basic servo trace display 
The basic display of the servo trace function is reached via the operating area 
"Commissioning" > "Optimization/Test" > "Trace" > "Servo trace". 

 
Figure 11-11 "Servo trace measurement" basic display 
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Parameterization in the basic display 
The following selection is made in the basic display for the servo trace measurement: 
● Axis/spindle selection 
● Measuring signal 
● Measurement time 
● Trigger time 
● Trigger type 
● Trigger threshold 

Signal selection 

"Axis/spindle name" input field 
The cursor must be positioned on the "Axis/spindle name" list box of the trace concerned. 
You can select it with the softkeys "Axis+" and "Axis-" or by accepting a value from the drop-
down list box. 

"Signal selection" input field 
The cursor must be positioned on the "Signal selection" list box of the trace concerned. The 
selection is made through acceptance from the drop-down list box. 
The available selection options depend on the existing configuration and activated functions. 

Measuring parameters 

"Measuring duration" input field 
The measuring time is written directly into the "Measuring duration" input field. 

"Trigger time" input field 
Direct entry of pre-triggering or post-triggering. With negative input values (leading sign 
minus -) recording begins at the set time before the trigger event. 
With positive input values (without sign) recording starts the time set after the triggering 
event. 
Condition: Trigger time + measuring duration ≥ 0. 
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"Trigger" input field 
The trigger type is displayed in the "Trigger" drop-down list box. The trigger always refers to 
Trace 1. When the trigger condition is satisfied, Traces 2 to 4 are started simultaneously. 
Settable trigger conditions: 
● "No trigger", i.e. measurement starts by pressing softkey "Start" (all traces are started 

time-synchronized) 
● "Positive edge" 
● "Negative edge" 
● "Trigger event from the part program" 

The trace can be started via an NC part program in conjunction with the system variable 
$AA_SCTRACE [axis identifier]. 

Reference 
SINUMERIK 840D sl / 840Di sl System Variable Manual 

"Threshold" input field 
Direct input of the trigger threshold. 
The threshold is only effective with trigger types "Positive edge" and "Negative edge". 
The unit refers to the selected signal. 

Softkeys "Axis+" and "Axis-" 
Selection of the axis/spindle when the cursor is positioned on the appropriate "Axis/spindle 
name" list field. 
You can also select the axis/spindle directly in the list box from the drop-down list using the 
cursor. 

Softkeys "Start" and "Stop" 
Trace function recording is started with the softkey "Start". 
With the "Stop" softkey or RESET, you can cancel a running measurement. 



 Optimize the drive. 
 11.4 Trace 

IBN CNC: NCK, PLC, drive 
Commissioning Manual, 03/2009, 6FC5397-2AP10-5BA0 219 

11.4.3 Drive trace 

Basic drive trace display 
The basic display of the drive trace function is reached via the operating area 
"Commissioning" > "Optimization/Test" > "Trace" > "Drive trace". 

 
Figure 11-12 Basic "drive trace" display 

When you are in the field for signal selection for a signal, you can press the <SELECT> 
button to move to a window in which you can determine the signal for interconnecting. 

 
Figure 11-13 Drive trace interconnections 



Optimize the drive.  
11.4 Trace 

 IBN CNC: NCK, PLC, drive 
220 Commissioning Manual, 03/2009, 6FC5397-2AP10-5BA0 

If you scroll through the basic display, the following parameters are displayed: 

 
Figure 11-14 Basic drive trace display, "Trigger" parameter 

Parameterization in the basic display 
The following selection is made in the basic display for the drive trace measurement: 
● Drive unit selection 
● Signal selection 
● Record 
● Trigger 

Reference 
SINAMICS S120 List Manual 

Signal selection 
Signals to be recorded, e.g. actual speed value, actual current value etc.  
It must be possible for the signals to be recorded to be interconnected, i.e. a BICO source. 

Trigger signal 
The trigger (signal) can be used to specify the event with which the recording of values is to 
start, e.g. the actual speed value is not to be recorded straightaway when the drive trace 
starts but only when the actual current value is > 10 A (here the actual current value trigger 
is > 10 A). 
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"Drive unit+" and "Drive unit-" softkeys 
Selection of drive unit in which recording is to take place. 

Softkeys "Start" and "Stop"  
Trace function recording is started with the softkey "Start".  

 
Figure 11-15 Drive trace recording 

You can cancel an active recording with the "Stop" softkey or RESET. 
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11.5 Further optimization options 

Introduction 
You can adapt the following parameters in the operating area "Commissioning" > "Machine 
data" > "Drive MD" for the drive optimization.  

Speed adjustment 
● Spindle drive: 

p500 = 102, speed setpoint in p322 corresponds to setpoint 4000 0000hex 
● Feed drive: 

p500 = 101, speed setpoint in p311 corresponds to setpoint 4000 0000hex 
The speed setpoint can be diagnosed in the corresponding drive in r2050[1+2] or r2060[1]. 

Brake behavior OFF3 
Depending on the requirements, the brake behavior for each drive can be adjusted to the 
signal 2.OFF3. Default setting: p1135 = 0, brake with maximum current.  
Parameters p1135, p1136, p1137 can be used to set a flatter braking ramp for drive-specific 
parameterization.  
Maximum braking ramp setting: 600 secs 
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Drive optimization with HMI sl 12
12.1 Automatic servo optimization 

Introduction 
With the HMI sl user interface under the "Commissioning" > "Automat. Servo Opt." menu, 
you have the following options for automatic axis optimization: 
● Selection of individual axis for optimization 
● Selection of one strategy from many options 
● Reconfiguration of measurement conditions 
● Chart display and activities protocol for optimization process 
● Display of current measurement and at the same time the average of previous 

measurements 
● Checking and processing of optimization results for speed and position controller 
● Accept or reject results 

 
Figure 12-1 Basic display for automatic optimization of SERVO axes 

The "Optimization" function can be used for all individual axes (SERVO and direct drives). 
 

 Note 
The following axes are not supported during automatic optimization with HMI sl version 2.6: 
• Gantry 
• Master slave 
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12.2 Overview of navigation 

Overview 
When optimizing an axis, you navigate via various dialog screens.                       
The following figure shows the navigation options for optimizing an axis: 

1 2 3

6

7 8 9

54

 
Figure 12-2 Navigation for automatic optimization of an individual axis 

 

 Note 
The following section "General operating sequences for automatic servo optimization" uses 
the numbers shown in the above diagram (e.g. dialog screen "Strategy selection" ②). 
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12.3 General operating sequences for automatic servo optimization 

General operating sequences 
1. In the "Commissioning" operating area, press the "Automat. servo opt." softkey. 

"Axis selection" dialog screen appears ①. 

 
Figure 12-3 Axis selection 

2. Use the cursor keys to select an axis for optimization. 
 

 
 

Note 
You can use the "Options" softkey to select special functions for the optimization ④. 

 

 
Figure 12-4 Options 

3. Choose the options for optimization. 
4. Press "OK". 
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5. In the "Axis selection" dialog screen ①, press the "Optimize" softkey. 
6. In the "Strategy selection" dialog screen ②, select the strategy for optimization. 

 
Figure 12-5 Strategy selection 

7. Press "OK". 
8. In the "Axis park position" dialog screen ③, move the axes on the machine into a safe 

position for optimization. 

 
Figure 12-6 Axis park position 

 

DANGER  
 

Automatic servo optimization based on analysis of measurements. The measurements 
require the axis to move. Ensure that all axes are in a safe position. 

 

9. Press "OK". 
Optimization is started ⑤.  
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Figure 12-7 Optimization in progress 

You will occasionally be asked to enter details so that the process can continue.  
This is required because you need to initiate certain machine processes (e.g. 
measurements which require an <NC START>).  
You can abort the coordination process at any stage of automatic servo optimization.  
Once optimization has been aborted, all original machine data, which was present in the 
control and in the drives before optimization was started, is restored.  
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10. If the optimization process has completed some optimizations for a control loop, a 
"Controller data overview" dialog screen ⑦ appears. 

 
Figure 12-8 Controller data overview 

You can modify and check the results and either accept or reject the proposed control 
parameters. 

 

 
 

Note 
Alternatively the optimized values can also be displayed graphically as a Bode diagram 
using the "Bode diagram" softkey function. 

 

11. Select "Transfer" to transfer the values calculated. 
You can undertake further optimizations. 
For example in a typical strategy, the mechanical stretch of closed-loop speed control is 
measured and gains and filters defined for optimized dynamics behavior ⑧.  

 
Figure 12-9 Measurement configuration 
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12. If you accept the settings for closed-loop speed control by pressing "Transfer", the drive 
data is updated, and the strategy then runs the measurements for closed loop position 
control, "Measurement is running" dialog screen ⑥. 

 
Figure 12-10 Measurement is running 

13. Once the optimum values for closed loop position control have been selected, the data is 
transferred to the CNC and drives, and the strategy runs the next stage which may be 
e.g. to measure for verification. 



Drive optimization with HMI sl  
12.4 Additional optimization stages - commissioning interpolation axes 

 IBN CNC: NCK, PLC, drive 
230 Commissioning Manual, 03/2009, 6FC5397-2AP10-5BA0 

12.4 Additional optimization stages - commissioning interpolation axes 

Additional optimization stages 
Additional optimization stages should be undertaken for axes which make up a collection of 
interpolations. These optimization stages should be undertaken manually by the 
commissioning staff using the options provided in the HMI Advanced or start-up tool: 
e.g.: 
● Circularity test measurement (Page 213) 
● Adaptation of servo gains (e.g. smallest servo gain in all interpolating axes without DSC 

see Position control loop measurement (Page 207)) 
● When using speed feed forward control, transfer equivalent time constants of the slowest 

axis (highest value) into all interpolating axes (see Speed control loop measurement 
(Page 204)). 
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Data backup and standard commissioning 13
 

Introduction 
Once commissioning of the NCK, PLC and drive has been completed, you can manage the 
modified data using the functions below: 
● Save/Archive user data 
● Series commissioning 
● Upgrading, as series commissioning 

User data 
The following user data can be managed: 

Table 13- 1 User data 

NCK/HMI PLC 
Machine data OB (organization blocks) 
Setting data FB (function blocks) 
Option data SFB (system function blocks) 
Global (GUD) and local (LUD) user data FC (functions) 
Tool and magazine data SFC (system functions) 
Protection zone data DB (data blocks) 
R parameters SDB (system data blocks). 
Work offsets  
Compensation data  
Display machine data  
Workpieces, global part programs and 
subroutines 

 

Standard and user cycles  
Definitions and macros  
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13.1 Data backup 

Introduction 
Data is backed up by means of the HMI. SINUMERIK solution line components can either be 
backed up individually or jointly. You can select from:   
● NCK (NC) 
● PLC 
● HMI 
● Drives 

Operating sequence 
1. Selection of Data backup menu 

Operating range "Services > ETC key ">" > "Standard commissioning". 
2. You can choose which data you want to back up: 

– HMI 
– NC with compensation data 
– PLC 
– PROFIBUS drives 

3. Archive name: The suggested archive name depends on the selected area and can be 
changed if necessary. 

4. Create the data backup file by selecting the component to which you wish the file to be 
output: 
– NC card (CompactFlash card) 
– Archive 

Data backup DRIVE-CLiQ motors  
 

 Note 
We would recommend backing up the DRIVE-CLiQ motor data onto a CompactFlash card 
(NC card).  
The p4692 parameter must be set to "1" in the "Commissioning" > "Machine data" > "Control 
unit MD" operating range. 
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13.2 User data backup/Series commissioning 

Introduction 
Data can be saved and archived in the following ways: 
● Reading out the data completely: Series commissioning 
● Files are exported/imported area by area. 

The following user data can be selected as individual files: 
– Machine data 
– Setting data 
– Tool data 
– R parameters 
– Zero point offset 
– Compensation data (LEC) 
– Part programs 
– Standard cycles 
– User cycles 
– PLC programs (binary file) 

In the case of a data backup, e.g., following commissioning of the control system, the user 
data selected via the user interface are written to what is known as a series-commissioning 
file. Once a series-commissioning file has been imported, the control system returns to its 
original state, as it was at the time of the data backup. 

Time of data backup 
Experience has shown that the following times can be recommended for carrying out data 
backups: 
● Following commissioning 
● After changing machine-specific settings 
● After service, e.g., after replacement of a hardware component, software upgrade, etc. 
● Before activation of memory-configuring machine data. A warning prompting you to back 

up is displayed automatically. 
 

 
 

Note 
References: Operator's Guides for:  
• HMI Advanced 
• HMI-Embedded 
• ShopMill/ShopTurn 
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13.3 Preassignments when saving PLC data 

Introduction 
When creating a series-commissioning file that contains PLC data, the PLC image that is 
saved during this process is dependent on the status of the PLC at the time of creation.  
Depending on the status of the PLC, the following PLC images result: 
● Original image 
● Instantaneous image 
● Inconsistent image 

Operating sequence for original image 
The original image of the PLC is represented by the PLC-data state immediately after 
loading the S7 project into the PLC. 
1. Set the PLC to the operating status STOP. 
2. Load the appropriate S7 project into the PLC using SIMATIC Manager STEP 7. 
3. Create a series-commissioning file with PLC data. 
4. Set the PLC to the RUN operating status. 

Operating sequence for instantaneous image 
If you cannot create an original image, you can save an instantaneous image as an 
alternative. 
1. Set the PLC to the operating status STOP. 
2. Archive PLC data. 
3. Set the PLC to the RUN operating status. 

Operating sequence for inconsistent image 
An inconsistent image results if a series-commissioning file with PLC data is created and the 
PLC is in the RUN state (cyclic operation). The data blocks of the PLC are saved at different 
times with contents that under certain circumstances may meanwhile have changed. This 
may result in a data inconsistency that, once the data backup has been copied back to the 
PLC, may under certain circumstances result in a PLC stop in the user program. 

 

NOTICE  
The creation of a series-commissioning file with PLC data while the PLC is in RUN status 
(cyclic operation) may result in an inconsistent PLC image in the series commissioning 
archive. After this series-commissioning file has been copied back, this data inconsistency 
in the PLC user program may under certain circumstances result in a PLC stop. 

 



 Data backup and standard commissioning 
 13.4 Series commissioning 

IBN CNC: NCK, PLC, drive 
Commissioning Manual, 03/2009, 6FC5397-2AP10-5BA0 235 

Changing the PLC operating status 
The PLC operating status can be changed using: 
● SIMATIC STEP7 Manager 
● PLC mode selector on the NCU (position "2" -> STOP, position "0" -> RUN) 

13.4 Series commissioning 

Introduction 
Series commissioning means bringing a series of control systems to the same initial state as 
regards their data.  
You can archive/read in your choice of PLC, NC and HMI data for series commissioning. 
Compensation data can be saved at the same time if necessary. The drive data are saved 
as binary data which cannot be modified. 

Requirement 
The password, e.g., with access level 3 (user) is set. 

 

 Note 
In order to prevent a topology error, Control Unit parameter p9906 (topology comparison 
stage of all components) should be set to "Medium" to load Control Unit series 
commissioning.  
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Operating sequence 
1. Open the menu to create a series-commissioning file: 

Operating range "Services" > <ETC> key > > "Series IBN". 

 
Figure 13-1 Series commissioning 

2. Create an archive for the series-commissioning file: You can select which data you wish 
to save as the archive contents: 
– HMI 
– NC with compensation data 
– PLC 
– PROFIBUS drives 

3. Archive name: The suggested archive name depends on the selected area and can be 
changed if necessary. 

4. Create the series-commissioning file by selecting the component to which you wish the 
file to be output: 
– NC-Card 
– Archive 
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File functions for SINAMICS parameters 14
14.1 Overview of file functions 

Functionality 
The "File functions" function gives you the following options for SINAMICS parameters of 
drive objects: 
● Backing up on the HMI 
● Loading to the drive unit 
● Editing on the HMI 
The functions are available under "Commissioning" > "Machine data" > <ETC> key > "File 
functions". 
Depending on the machine data area from which the file functions were selected, the 
corresponding entry is selected from the selection box for selecting data.  
The data and parameters available on the control appear in this selection box. 
The first three vertical softkeys for "+/-" and "Direct selection" are adapted accordingly and 
are only visible where there is more than one component.  

 
Figure 14-1 Selecting "SINAMICS drive parameters" file functions 
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SINAMICS parameters 
You can use a drop down list box in the "Data" window to back up/load the following 
SINAMICS parameters from the individual drive objects: 
● SINAMICS control unit parameters 
● SINAMICS infeed parameters 
● SINAMICS drive parameters 
● SINAMICS communications parameters 

Drive objects 
Select the respective drive objects using the vertical softkeys.  
For example the "Drive +"/"Drive -" vertical softkeys for "SINAMICS drive parameters". 

14.2 Data backup of SINAMICS parameters 

Introduction 
Select the "File functions" dialog under "Commissioning" > "Machine data" > <ETC> key. 

Operating sequence 
Proceed as follows to back up the drive object parameters: 
1. In the "Data" window, select the data type you require. 
2. Use the "+/-" or "Direct selection" vertical softkeys to select the component if there is 

more than one component. 
3. In the "File" window enter a name or select an existing name from the selection box. 
4. In the "Directory" window, select the directory under which you want to save the 

parameters. 
5. Press "Save". 
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The following screen shots show examples of "SINAMICS drive parameters" and 
"SINAMICS control unit parameters".  

 
Figure 14-2 Select "File functions" >"SINAMICS drive parameters"  

 
Figure 14-3 Select "File functions" > "SINAMICS control unit parameters"  
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14.3 Loading the SINAMICS parameter file 

Introduction 
Select the "File functions" dialog under "Commissioning" > "Machine data" > <ETC> key. 

Operating sequence 
Proceed as follows to load parameters to the individual drive objects: 
1. In the "Data" window, select the data type you require. 
2. Use the "+/-" or "Direct selection" vertical softkeys to select the component if there is 

more than one component. 
3. Select an existing name from the selection box. 

 
Figure 14-4 Loading/copying SINAMICS drive parameter file functions 

4. Press "Load". 
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The following message will appear if the source and target numbers don't match: 

 
Figure 14-5 Loading/copying SINAMICS drive parameter file functions, "Adapt" query 

5. Select "Adapt". 
You can now adapt the "Actual values" for the "File" using the "Setpoints". 

 
Figure 14-6 Loading/copying SINAMICS drive parameter file functions, "Adapt"  

6. Press "OK". 
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14.4 Editing the SINAMICS parameter file 

Introduction 
Select the "File functions" dialog under "Commissioning" > "Machine data" > <ETC> key. 

Operating sequence 
Proceed as follows to display the contents of a file: 
1. In the "Data" window, select the data type you require. 
2. Use the "+/-" or "Direct selection" vertical softkeys to select the component if there is 

more than one component. 
3. Select an existing name from the selection box. 

 
Figure 14-7 Select "File functions" > "File"  

4. Press "Edit..." 

 
Figure 14-8 Editing SINAMICS drive parameter file functions 

5. The content of the file is displayed and can be viewed.
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Tips for commissioning SINAMICS drives 15
 

Introduction 
This chapter describes instructions and tips on: 
● Changing topology (modular machine)  
● Drive states 
● Diagnostics for pending alarms 
● Drive (SERVO) parameter RESET, individual 
● Version display of the drives (SERVOs) 
● Checking/setting power supply data settings 
● Identification/Optimization "ALM > Infeed/Configuration" 
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15.1 Changing topology (modular machine) 

Introduction 
The topology is changed using the following menus: 
● "Commissioning" > "Drive system" > "Drive units" > "Topology". 

 
Figure 15-1 "Drive units" > "Topology" menu 

● "Commissioning" > "Drive system" > "Drive units" > "Configuration". 

 
Figure 15-2 "Drive units" > "Configuration" menu 



 Tips for commissioning SINAMICS drives 
 15.1 Changing topology (modular machine) 

IBN CNC: NCK, PLC, drive 
Commissioning Manual, 03/2009, 6FC5397-2AP10-5BA0 245 

Functions for changing topology 
The following functions are provided for changing the topology: 
● "Topology" > "Add component..." 
● "Topology" > "Change..." 

– Delete drive objects/components 
– Enable/disable drive objects 
– Change drive object name/number 
– Change component name/number 

● "Configuration" > "Sort..." 
● "Configuration" > "Change..." 

– Change drive object name 
– Change component name 
– Change comparison level 

 

 
 

Note 
First commissioning is not necessary after changes to the topology. 

 

15.1.1 Adding components 

Introduction 
If you connect a component (e.g. SMC20) via DRIVE-CLiQ to the drive system for the NCU, 
SINAMICS detects the change in the actual topology and sends the actual/reference 
topology difference to the HMI. 
The new component must be configured on the HMI and assigned to a drive object 
(SERVO-DO/Motor Module) via the drive wizard. 

 

 Note 
Up to version 2.5 
A new motor with DRIVE-CLiQ can only be assigned to an existing drive object (SERVO-
DO) (see following operating sequence, including "Add component") that has never 
previously been assigned an encoder interface or another motor with DRIVE-CLiQ and that 
has not yet ever been commissioned. 
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Operating sequence 
1. Select the "Commissioning" > "Drive system" > "Drive units" menu. 

 
Figure 15-3 "Drive system" > "Configuration" menu 

2. Press "Topology". 

 
Figure 15-4 Topology without new component 

in the "Topology" menu, you start with the actual status (here an example). 
The component has not been connected yet. 

3. Connect a new DRIVE-CLiQ component (e.g. SMC20) to a Motor Module. 
 

 
 

Note 
Only plug in (connect) components when the drive unit is switched off. 
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Figure 15-5 Desired state 

 
Figure 15-6 Actual state 
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Figure 15-7 Component not commissioned yet (201) 

SINAMICS detects the change in the actual topology and sends the actual/reference 
topology difference to the HMI. 
– GRAYED OUT -> Desired state, drive object/component not plugged in and/or 

deactivated in drive system 
Use the cursor keys to select the required line. The state is indicated in the bottom 
part of the window. 

– RED -> actual state - present in the actual topology 
New components which haven't yet been commissioned have a component number 
> "200", in this example, the number is "201". 
The new component must now be configured in the drive system via the vertical softkey 
"Add component...". 

4. Press "Add component...". 
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Figure 15-8 Menu "Add component" 

A new component has been found. 
5. Press "OK" to configure and accept this component. 

 
Figure 15-9 Configuration begins 

During the unit configuration there are a succession of messages containing information 
on the configuration.  
Determining the device configuration may take several minutes. 
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Before the configuration is completed, the HMI displays the following query: 

 
Figure 15-10 Power on reset (warm restart) 

6. Press "OK" to perform an NCK power on restart (warm restart). 

 
Figure 15-11 Component accepted 

The unit configuration is finished. The component has been accepted. 
You have the following options to assign this component (e.g. SMC20 with new encoder) 
to a drive: 
– Press "Drives" to open the drive wizard. Select the drive and run through the drive 

wizard to the encoder configuration (Page 85). 
– Press "OK" and assign this component later to a drive. 
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Figure 15-12 "Topology" menu after "OK" 

The actual state is displayed in the topology.  
If you select the component with the cursor keys, the HMI informs you in the bottom 
area of the topology table, which components have been connected to this component 
via DRIVE-CLiQ.  

 

 
 

Note 
A non-assigned component must be commissioned with the drive wizard. 
You can start the drive wizard via the "Topology" menu with the following operating 
sequence: 
1. Press the <RECALL> key. 
2. Press "Drives". 

 

See also 
Drive diagnostics (Page 268) 
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15.1.2 "Topology" > "Change..." menu 

15.1.2.1 Changing entry into topology 

Introduction 
You have the following options in the "Topology" > "Change..." dialog: 
● Delete drive objects/components 
● Enable/disable drive objects 
● Change drive object name/number 
● Change component name/number 

Operating sequence for "Topology" > "Change" dialog 
You have saved the drive data (see "Data backup of SINAMICS parameters" (Page 238)) 
You are in the "Commissioning" > "Drive system" > "Drive units" > "Topology" menu. 

 
Figure 15-13 Changing topology (modular machine) SK "Change" 

1. Press "Change...". 
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Figure 15-14 Changing topology (modular machine) > query 

2. Read the query through carefully. 
You have saved the data.  
Press "OK". 

 
Figure 15-15 Basic display for "Change topology (modular machine)" 

3. You are in the basic display for changing the topology (modular machine). 
Activate the following functions from this basic display: 
– Delete drive objects/components 
– Enable/disable drive objects 
– Change drive object name/number 
– Change component name/number 

The sections below describe the operating sequences for these functions. 
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15.1.2.2 Deleting drive objects 

Operating sequence 
1. Use the cursor keys to select a drive object. 

Once you have selected a drive object, the vertical "Delete drive object" softkey function 
is displayed. 

 
Figure 15-16 Menu "Topology" > "Change..." > "SERVO_3_3:2 selected" drive object 

2. Press "Delete drive object". 

 
Figure 15-17 Menu "Topology" > ""Change..." > "Delete drive object" Note for double motor module 

A note regarding the drive object appears and you are again asked whether the drive 
object is to really be deleted. 

3. Press "OK". 
The drive object is deleted from the reference topology.  
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15.1.2.3 Deleting components 

Operating sequence 
1. Use the cursor keys to select a component. 

Once you have selected a component, the vertical "Delete component" softkey function is 
displayed. 

 
Figure 15-18 Menu "Topology" > "Change" > Component SM_2" selected 

2. Press "Delete component". 

 
Figure 15-19 Menu "Topology" > "Change" > "Delete component" > Note relating to component 

3. A note regarding the component appears and you are again asked whether the 
component is to really be deleted. 

4. Press "OK". 
The component is deleted from the reference topology.  
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Figure 15-20 Menu "Topology" > "Change" > "Component deleted" > Warning relating to 

component 

5. A warning appears above the topology window if the component is still present in the 
actual topology. 

6. Press "OK". 

 
Figure 15-21 Menu " Topology" > "Topology comparison" view 

7. You can see in the window with the "Topology comparison" view that the "SMx module" 
component in the actual topology is still wired (highlighted in red). 

8. Remove the module. 
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15.1.2.4 Enabling/disabling drive object 

Introduction 
In the "Topology" > "Change..." menu you can disable/enable drive objects directly in the 
drive system. 

Operating sequence 
1. Use the cursor keys to select a drive object. 

Once you have selected a drive object, the vertical "Enable/disable dr. obj." softkey 
function is displayed. 

 
Figure 15-22 "Topology" > "Change" menu 

2. Press "Enable/disable dr. obj.". 
Follow the instructions given by the messages. 
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Figure 15-23 Menu "Topology" > "Change" > SERVO_3_3:2 disabled drive object 

3. Once successfully disabled, the drive object and the associated components are grayed 
out. 

4. If you want to reactivate this drive object, press "Enable/disable dr. obj.". 
Follow the instructions given by the messages. 
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15.1.2.5 Changing drive object/component names/numbers 

Introduction 
You have the following options under the menu: 
● "Topology" > "Change..." 

– Change drive object name/number 
– Change component name/number 

 
Figure 15-24 Menu "Topology" > "Change..." > "Drive object no. 2" set to 20 

● "Configuration" > "Change..." 
– Change drive object name 
– Change component name 
– Change comparison level 

 
Figure 15-25 Menu "Configuration" > "Change..." > Name/comparison level 



Tips for commissioning SINAMICS drives  
15.1 Changing topology (modular machine) 

 IBN CNC: NCK, PLC, drive 
260 Commissioning Manual, 03/2009, 6FC5397-2AP10-5BA0 

 

 
 Note 

Changing the names and numbers affects data in the reference and actual topology 
for the drive software. 
Changing the comparison level affects the topology comparison in the drive software. 

 

Operating sequence 
1. Position the cursor in the "Change..." menu on the corresponding field. Specify a new 

"Name/number/comparison level". 
2. Press <Input>. 

15.1.3 Replacing SINAMICS S120 components 

Introduction 
The operating sequences describe two procedures for replacing a component: 
● Replacing a motor module with a more powerful one. 
● Replacing SMI/SMx motor component. 
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Operating sequence for replacing a motor module with a more powerful one. 
The following prerequisites are satisfied: 
● The motor modules are of the same type. 
● The serial number is different. 
● MLFB number differs e.g. instead of 5 A -> 9 A. 

 

 
 

Note 
DRIVE-CLiQ components simply have different serial numbers 
In this case no further configuration is needed. 

 

 
 

Note 
A permanent change in the drive system should not be undertaken 
Before you replace the DRIVE-CLiQ component, change the comparison level. 
1. Select the "Commissioning" > "Machine data" > "Control unit MD" dialog. 
2. Change parameters p9907 (component number) and p9908 (comparison level of a 

component). 
3. Save (Page 238) the changed drive data before shutting off (power OFF). 
4. Switch the drive system off (power OFF). 
5. Replace the component. 
6. Switch the drive system on (power ON). 
7. No further configuration is required. 

 

You have replaced the motor module with the drive system switched off. 
The motor module should be permanently replaced. 
1. Select the "Commissioning" > "Machine data" > "Control unit MD" dialog. 
2. Set the "Device configuration" parameter to control unit: p0009 = 1 
3. Transfer the new component: Control Unit: p9905 = 2 
4. Wait until p9905 = 0 is automatically set. 
5. Set the "Device configuration" parameter to control unit: p0009 = 0 
6. Save "All": set p977 = 1. 
7. It is imperative you wait until p977 is automatically written back to "0" this takes about 40 

seconds. 
The replacement of a single SINAMICS component is automatically acknowledged by the 
system. 
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Operating sequence for replacing SMI/SMx motor component 
1. You have removed the previous SMI or SMx motor component. 

This motor component is missing from the actual topology.  
SINAMICS indicates this in the form of a topology error alarm.  
The "Commissioning" > "Drive system" > "Drive units" > "Topology" dialog shows the 
previous motor component awaiting replacement GRAYED OUT (present in reference 
topology only). 

 

 
 

Note 
The new SMI/SMx motor component must not yet be inserted! 

 

2. In the "Commissioning" > "Drive system" > "Drive units" > "Topology" > "Change..." 
dialog, remove the SMI/SMx motor component awaiting replacement from the reference 
topology using the "Delete component" dialog (Page 255). 

 

 
 

Note 
Save (Page 238) the changed drive data before switching off (power OFF). 

 

3. Switch the drive system off and on (power OFF/ON). 
4. In the "Commissioning" > "Drive system" > "Drive units" > "Topology" dialog, check 

whether the SMI/SMx motor component has been removed from the reference topology 
as follows: 
– Topology error alarm no longer active. 
– "Commissioning" > "Drive system" > "Drive units" > "Topology" dialog no longer shows 

any differences. 
5. Switch off the drive system. 
6. Plug in the new SMI/SMx motor component. 
7. Switch on the drive system. 
8. Add the new SMI/SMx motor component using the "Commissioning" > "Drive system" > 

"Drive units" > "Topology" > "Add component" (Page 245) dialog for the reference 
topology. 

9. Assign the added SMI/SMx motor component via the "Commissioning" > "Drive system" > 
"Drives" (Page 85) drive wizard. 
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15.1.4 Display options 

Introduction 
The "Display options" function allows you to do things like set which drive object and 
component properties are to be displayed in the "Configuration" and "Topology" windows.  

Operating sequences for "Configuration" window 
You are in the "Commissioning" > "Drive system" > "Drive units" menu. 
1. Select "Configuration" > "Display options". 

 
Figure 15-26 "Configuration" > "Display options" menu. 

Define the following properties for the "Configuration" window: 
– Topology display 
– Columns to be displayed 
– Filter for drive objects and components to be displayed 
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Operating sequences for "Topology" window 
You are in the "Commissioning" > "Drive system" > "Drive units" menu. 
1. Select "Topology" > "Display options". 

 
Figure 15-27 "Topology" > "Display options" menu. 

Define the following properties for the "Topology" window: 
– Topology display 
– Filter for drive objects and components to be displayed 

When you click on filter "off", even components which are not in the DRIVE CLiQ are 
displayed. 

 
Figure 15-28 "Topology" menu - Filter "off" has been selected for the "Display options". 
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The colors used in the topology window have the following meanings for the drive objects 
and components: 
● GRAYED OUT -> Desired state, drive object/component not plugged in and/or 

deactivated in drive system 
Use the cursor keys to select the required line. The state is indicated in the bottom part of 
the window. 

● RED -> actual state - present in the actual topology 
 

15.1.5 Sorting the topology display 

Operating sequence 
In the "Drive system" > "Drive units" > "Configuration" menu you can call up a sorting 
function for the topology display. 

 
Figure 15-29 "Drive system" > "Drive units" > "Configuration" menu 

1. Press "Sort...". 
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Figure 15-30 "Configuration" > "Sort..." menu 

2. In the "Sort" dialog select from the following sorting options for displays in the topology 
window: 
– Drive object 

The display is sorted by drive object number. 
– Wiring 

The display is sorted by the wiring of the drive components in the drive system. 
– Component number 

The display is sorted by component number. 
– Axis 

The display is sorted by axis number.  
3. Press "OK". 
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15.1.6 Check topology 

Introduction 
After you have parameterized the drive components, you can view the topology on the HMI. 

Topology of individual drive components  
1. Under "Commissioning", press the "Drive system" > "Drive units" > "Topology" softkeys 

one after the other. 
2. On the HMI, the topology of individual drive components is displayed, including the 

component number (see figure below). 
You can now check whether the topology displayed conforms with the topology of your 
system. 

 
Figure 15-31 Topology 

You will need the component numbers in order to configure direct measuring systems 
manually. 

See also 
Drive diagnostics (Page 268) 
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15.2 Drive diagnostics 

Introduction 
You can view the alarms and faults of the drive in the "Diagnostics" > "Drive system" 
operating area on the HMI.   

 
Figure 15-32 Overview of drive states, "Diagnostics" > "Drive system" menu 

Operating sequence 
1. Select the relevant drive component with the cursor in the overview of the drive states. 
2. Press "Details". 

 
Figure 15-33 "Diagnostics" > "Drive system" > "Details" menu 
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3. Press "Alarms". 

 
Figure 15-34 "Diagnostics" > "Drive system" > "Details" > "Alarms" menu 

4. Press "Faults". 

 
Figure 15-35 "Diagnostics" > "Drive system" > "Details" > "Faults" menu 

See also 
Adding components (Page 245) 
Check topology (Page 267) 
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15.3 Diagnostics for pending alarms 

Introduction 
Alarms - these are warnings and faults - can be viewed in SINAMICS S120 via parameters. 

Warnings 
Pending warnings are indicated by parameter r2122 of the relevant drive components in 
question.  
Deleting the warning buffer may be carried out manually: 
● Write r2111 of the drive component with "0". 

This results in the deletion of all existing warnings of this component and updates the 
current warnings still pending. 

Faults 
Fault messages are indicated by parameter r945. 

Display on HMI 
If you set the MD13150 $MN_SINAMICS_ALARM_MASK to the hexadecimal value "D0D" on 
the HMI, then the HMI automatically displays the pending warnings/faults from SINAMICS 
S120. 
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15.4 Drive (SERVO) parameter RESET, individual 

Introduction 
The factory setting (parameter RESET) may be set for each drive (SERVO) individually. 

 

 Note 
Not just the motor and encoder data are reset. All the configured Binector-Connector logic 
operations (releases, probe signals) and message frame type are also deleted. 

 

Operating sequence 
1. Set the factory settings on the selected drive: p0010 = 30 
2. Activate the factory settings on this drive: p0970 = 1 
3. Device automatically carries out RESET of all parameters on this drive. 
4. Save drive-specific: set p971 = 1 

or 
save "All": set p977 = 1 

5. It is imperative you wait until p977/p971 is automatically written back to "0"; this takes 
about 40 seconds. 
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15.5 Firmware version display of drive components 

Introduction 
The firmware version of the drive components can be viewed under "Commissioning" > 
"Drive system" > "Drive units" > Configuration" in the "FW comp" column. 
Example: 2603000, -> Firmware version is 02.60.30.00 

 
Figure 15-36 Menu "Drive system > Configuration" 

Using certain parameters from individual drive components, it is also possible to view the 
relevant firmware version for: 
● System software SINAMICS S120 
● Firmware from: 

– Drive components 
– SMC or SMI modules 

System software SINAMICS S120   
The version of the SINAMICS S120-SW available in the system is readable in parameter r18 
on the TCU/PCU. 
Example:  
r18 = 2300700, -> firmware version is 02.30.07.00 
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Firmware version drive components   
The firmware version of all individual components is read out individually in parameters 
r975[2] and r975[10] for each drive component (NCU, ALM, power unit). 
Example: 
r975[2] = 230, r975[10] = 700 -> "230" & "700" -> firmware version is 02.30.07.00 

Firmware version of all SMC or SMI modules 
The firmware version of all SMC or SMI modules is read out in parameter r148[0…2] on the 
relevant motor module.   
Example: 
r148[0] = 2300700, -> firmware version of the connected encoder module 1 is 02.30.07.00 
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15.6 Checking/setting power supply data settings 

Introduction 
The power supply data settings must be checked/set in the SINAMICS during 
commissioning. 

Checking/setting network data when commissioning the infeed 
You can use the "Commissioning" > "Drive units" > "Infeed" > "Configuration" > "Network 
data" menu to view and modify the network data. 

 
Figure 15-37 Network data  

See also 
Identification/Optimization "ALM > Infeed/Configuration" (Page 275) 
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15.7 Identification/Optimization "ALM > Infeed/Configuration" 

Introduction 
On identification of the ALM, control optimization in the ALM is also carried out. Here, the 
inductance and capacity of the DC link are determined and the optimum control data 
determined for the set-up converter. 
Identification can only be performed after the controller and the drive have been put into 
operation. 

Procedure for automatic identification of the ALM  
Identification of the ALM is performed automatically by the system in the current SINAMICS 
versions as soon as the first drive has been commissioned and enable terminal X122.1 
activated. An internal optimization sequence is started automatically; it takes appox. 20 
seconds to complete.  
During this optimization sequence, enable terminal X122.1 should not be deactivated; 
otherwise the optimization would be aborted. If optimization is aborted, identification may be 
carried out manually at a later stage by the user. 

Procedure for manual identification of the ALM 
Identification of the ALM is carried out as follows: 
1. Disconnect release (AUS1) ALM (X122.1) by commissioner. 
2. Select machine data for the infeed (ALM) in the "Commissioning" > "Machine data" > 

"Infeed MD" menu. 
3. Initiate identification on the ALM: p3410 = 5. 
4. Connect release ALM (release has to remain pending during the execution of the first 

step of the identification). 
5. ALM controller data are reset automatically and power supply identification starts. 
6. After identification has occurred, p3410 is automatically written to 0 and the values are 

saved automatically for the controller data of the ALM. Check: p3402 = 9 (release has to 
remain during the execution of this step of the identification!). 

7. Disconnect release ALM (X122.1) by commissioner. 
8. The optimized ALM data are saved automatically. The data does not need to be saved 

manually (p977 = 1). 
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General tips 16
16.1 Configuration of the properties of the network interface for PROFIBUS 

Introduction 
In the STEP7 project, you configure the network interfaces PROFIBUS DP, via which you 
want to reach the machine control panel: 

PROFIBUS DP operating sequence 
1. You used the left mouse button to select NCU 720.1 and while holding down the mouse 

button you dragged it to the "Station design" station window. 
2. After you release the mouse button, configure the properties of PROFIBUS DP interface 

for socket X126 (machine control panel) in the dialog box (see figure below). 

 
Figure 16-1 Properties of PROFIBUS DP 

3. Click the following menu items one after the other: 
– the "New..." button, 
– the "Network settings" tab in the "Properties new subnet PROFIBUS Subnet" dialog 

box. 
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4. Select the transmission rate "12 Mbps" for the "DP" profile (see figure below). 

 
Figure 16-2 Properties of the PROFIBUS interface 

5. Click on "Options" and then on the "Equidistance" tab (see figure below). 

 
Figure 16-3 Equidistance 
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6. To enable reproducible access to peripherals (for hand wheel mode), the PROFIBUS DP 
must have constant bus cycle time. The following entries are necessary under 
Equidistance: 
– Click on the "Activate equidistance bus cycle" field 
– Enter the cycle, e.g., "2 ms" for the "Equidistance DP cycle" (for integrated 

PROFIBUS) (see MD10050 $MN_SYSOCK_CYCLE_TIME). 
– Click on the "Times Ti and To equal for all slaves" field 
– The fields "Time Ti" and "Time To" must contain a value "< 2ms". 

7. Click on "OK" three times. 
8. Module NCU 720.1 with SINAMICS S120 is inserted into the HW config (see figure 

below). 
 

 
 

Note 
With the <F4> key and confirmation of the question regarding "Reorganize", you can 
reorganize the display in the station window. 

 

 
Figure 16-4 HW config with NCU 7x0 

As the next step configure a machine control panel with hand wheel. 
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16.2 Separate NCK and PLC general reset 

Introduction 
If necessary, you can execute NCK or PLC general reset separately. To do so, proceed as 
follows: 

Operating sequence for NCK general reset 
1. Turn the NCK commissioning switch (SIM/NCK label) on the NCU to position "1". 
2. Execute POWER ON or Hardware RESET. 
3. NCK general reset is requested. 

– The control system boots up, 
– The SRAM is deleted and 
– the machine data is preassigned with standard values. 

4. After an error-free boot, the system generates the number "6" and a flashing point on the 
status display of the NCU. 
– The LED RUN illuminates GREEN continuously. 
– The NCK is in cyclic transmission. 

5. Turn the NCK commissioning switch back to the "0" position. 
 

 
 

Note 
It is also possible to trigger an NCK boot (corresponds to position "0" on the NCK 
commissioning switch) via the NCK RESET softkey under Commissioning on the HMI. In 
the status bar, the system displays the message "Commissioning successful". 
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Operating sequence for PLC general reset with hardware RESET or POWER ON 
1. Turn the PLC mode selector to position "3". 
2. Carry out POWER ON or Hardware RESET. 
3. PLC general reset is requested. 

– LED STOP flashes 
– LED SF illuminates 

4. Turn the PLC-mode selector in succession to the following switch positions: 
– Briefly to "2" 
– Back to "3" 

LED STOP first flashes with about 2Hz and then illuminates. 
5. After LED STOP lights up, place the PLC mode selector at position "0". 

– LED STOP goes out and LED RUN (GREEN) lights up. 
– PLC has had a general reset and is in cyclic transmission. 

Operating sequence for PLC general reset without hardware RESET or POWER ON 
1. Turn the PLC mode selector to position "2" (STOP operating state). 

– LED STOP illuminates 
2. Turn to position "3" (operating state MRES, request general reset) and hold in this 

position (about 3 seconds) until STOP-LED PS lights up again. 
– LED STOP goes off then comes back on 

3. Within 3 seconds, turn to the positions  
STOP-MRES-STOP ("2"-"3"-"2"). 
– LED STOP first flashes with about 2Hz and then illuminates again. 

4. After LED STOP lights up, place the PLC mode selector at position "0". 
– LED STOP goes out and LED PR (GREEN) lights up. 
– PLC has had a general reset and is in cyclic transmission. 

5. After LED RUN (green) is illuminated, place the PLC mode selector in position "0". 
⇒ PLC has had a general reset and is now in cyclic mode. 
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16.3 Configuring the communication between the PLC and the drive 

Telegram lengths and I/O addresses 
 

 Note 
In the HW Config, a telegram length and the associated I/O addresses is preassigned per 
default. 
The pre-assignment for SINAMICS Integrated corresponds to telegram 116 for the axes and 
391 for the NCU and 370 for the ALM with the max. possible telegram length.  
This default can be used to supply all known telegrams; no modification is necessary. 

 

Operating sequence 
1. To view this configuration, click in the HW Config on the module "SINAMICS Integrated" 

and select "Object properties", using the <right mouse button>. 
2. Select the "Configuration" tab and the select the "Overview" tab. 

As shown in the figure below, you can view the lengths of the preassigned telegrams. 
The figure shows user-defined telegrams for 6 axes. 

 
Figure 16-5 Message length 

3. Click "OK" to close the dialog. 
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4. You can view the address areas in the station window in the detail view by clicking on 
"SINAMICS Integrated". Here, for example, address 4100 corresponds to the address 
entered in MD13050 $MN_DRIVE-LOGIC_ADRESS[0]. The addresses have a gap of 40 
bytes. The following figure shows how the default values MD13050 $MN_DRIVE-
LOGIC_ADRESS[0…5] correspond to the input/output addresses for standard 
configuration of the PLC. 

 
Figure 16-6 SINAMICS Integrated addresses 
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16.4 Integrating PG/PC into the network (NetPro) 

Introduction 
To carry out routing functions, it is necessary to integrate a PG/PC in the SIMATIC Manager 
under NetPro and to configure the interfaces. 

Requirements 
The following preconditions for integrating a PG/PC in the hardware configuration network 
must be satisfied: 
● inserted NCU 720.1 into the HW config, 
● configured the properties of the network interfaces, 
● configured the PLC to drive communication, 
● inserted the machine control panel (MCP), 
● saved and compiled the configuration, 
● created a PLC program. 

See also 
Insert NCU 7x0 in HW config  (Page 45) 
Configuring the properties of the network interfaces (Page 46) 
Adding a machine control panel and handwheel in HW Config (Page 307) 
End hardware configuration and load to the PLC (Page 54) 
Creating a PLC program (Page 55) 
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16.4.1 Integrating PG/PC into NetPro 

Introduction 
To enable the communication between PG/PC <-> HMI via Ethernet, the PG/PC should be 
included in the network configuration of the system.  
To integrate the PG/PC, proceed from the following starting situation in the 
SIMATIC Manager. 
You are in the HW config in the created project "PLC-Erst-IBN 840D sl" (see figure below). 

 
Figure 16-7 HW config project "PLC-Erst-IBN 840D sl"  
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Operating sequence for integrating PG/PC into NetPro 
1. Click on the "NetPro" button (see previous figure). 
2. From the catalog under "Stations", insert the PG/PC via Drag&Drop into the network 

configuration (see figure below). 

 
Figure 16-8 Insert PG/PC 

The newly inserted symbol PG/PC does not yet contain any interfaces. Next, configure the 
interfaces. 
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16.4.2 PG/PC interface configuration 

Introduction 
Under NetPro, configure the interfaces required for commissioning at the PG/PC. These may 
include the following interfaces: 
● Ethernet for the communication for NCU socket X127 
● PROFIBUS 

Operating sequence for configuring interfaces 
1. Highlight the symbol "PG/PC" under NetPro. 
2. Select "Object properties" <right mouse button >. 
3. In the "Properties - PG/PC" dialog box displayed, select the "Interfaces" tab in the dialog 

(see figure below). 
Under this tab, define/configure all the required interfaces. 

 
Figure 16-9 Properties - PG/PC 
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Operating sequence for configuring interfaces at PG/PC 
1. Click on "New…" to configure the Ethernet interface first. 
2. In the type selection field, select "Industrial Ethernet" (see figure below). 

 
Figure 16-10 Type Industrial Ethernet 

3. Click "OK". 
4. In the subsequent dialog box, select the subnet "Ethernet(1)" and enter the IP address 

and the subnet screen mask of your PG/PC (see figure below). E.g.: 
– IP address, such as, 192.168.0.3 
– Subnet screen form = 255.255.255.0 

 
Figure 16-11 Properties of the Ethernet Interface 

5. Click "OK". 
6. You can configure additional interfaces via "New". 
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7. When you have configured the interfaces, all the configured interfaces are visible under 
the "Interface" tab (see figure below). 

 
Figure 16-12 Configured interfaces 

The configured interfaces must be assigned in a device-specific manner to the available 
hardware interfaces on the PG/PC. 
The sequence steps are laid out in the following section. 
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16.4.3 Assigning interfaces 

Introduction 
The interfaces configured in the previous chapter must now be assigned in a device-specific 
manner to the available hardware interfaces on the PG/PC. 

Operating sequence for assigning an Ethernet interface 
1. Select the "Assign" tab. 
2. Select "Ethernet interface(1)" in the selection field "Configured interfaces". 
3. Select the installed network card "TCP/IP -> Realtek RTL8139/810xF…" in the selection 

field "Interface parameterizations in PG/PC" (see figure below). 

 
Figure 16-13 Selecting 

4. Click on "Assign" and confirm the subsequent message on processing object properties 
with "OK". 
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The assigned interfaces are deleted from the field "Configured interfaces" and these 
assigned interfaces are displayed in the field "Assigned" (see figure below). 

 
Figure 16-14 Assigning Ethernet interface 

5. Now assign the remaining configured interfaces (PROFIBUS). 
From those interfaces assigned, one must be marked as "active". 

6. Select "Ethernet interface" in the field "Assigned" and mark the field next to it as "active". 
7. Click on "OK" to end the dialog "Properties - PG/PC". 
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In NetPro, the PG/PC interface declared as "active" is highlighted in YELLOW (see figure 
below). 

 
Figure 16-15 Configured PG/PC in the network configuration 

8. Select "Save and compile > Save and check all" and confirm the process with "OK". 
The next operating sequence described explains how to load this hardware configuration 
to the NCU. 
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16.4.4 Loading the HW config to NCU 

Introduction 
The newly created network configuration PG/PC must be introduced to NCU. 
You have established a connection to the Ethernet interface (X120 or X127) and you load 
this configuration from the PG/PC to the NCU. 

Operating sequence for loading HW config to NCU 
1. Change from "NetPRO" to "HW Config". 
2. Press the "Download to module" button. 

The target module interactive screenform automatically displays both configured 
communication peers.  

3. Confirm the load into the module with "OK". 
4. Confirm the dialog boxes displayed subsequently with "OK" or "No" for the query 

"…Should the module be started now (restart)?". 
 

 
 

Note 
Loading the HW config to NCU is only possible via Ethernet interface. 
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16.5 NCU 7x0 and NX1x Terminal Assignment 

Introduction 
The following terminals are pre-assigned with the unit configuration: 
● NCU 7x0 

– X122 
– X132 

● NX1x 
– X122 

Terminal assignment X122 (NCU 7x0)   
 
Pin 
no. 

Function Assignment recommendation BICO source/sink Macro number 

ON/OFF 1 Infeed Line Module with 
DRIVE-CLiQ Connection 

CU: r0722.0 Infeed p840 1 1 Input1) 

"Infeed Ready Signal" of Line Module 
without DRIVE-CLiQ connection 

SLM X21.1 Drive p864 5 

2 Input "OFF3 – rapid stop" 
Function:  
Braking with a configurable OFF3 ramp 
(p1135,1136,1137); thereafter, pulse 
suppression and starting lockout. The 
drive stops controlled. The braking 
response can be set separately for each 
servo. 

CU: r0722.1 Each drive 
2. OFF3, p849 

1 
5 

3 Input SH/SBC - Group 1 SINAMICS Safety 
Integrated (SH = p9601 release) 

CU: r0722.2 p9620 (all drives 
in the group) 

4 Input SH/SBC - Group 2 SINAMICS Safety 
Integrated (SH = p9601 release) 

CU: r0722.3 p9620 (all drives 
in the group) 

The macro does 
not perform any 
BICO 
interconnection; 
the use of the 
function requires 
parameterization 
by the user. 

5 Ground for pins 1 ... 4 
6 Ground for pins 7, 8, 10, 11 
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Pin 
no. 

Function Assignment recommendation BICO source/sink Macro number 

7 Output SH/SBC - Group 1 
SINAMICS Safety Integrated 

CU: p0738 r9774 Bit 1 
BICO from CU 
after the  
first drive in the 
group 

8 Output SH/SBC - Group 2 SINAMICS Safety 
Integrated 

CU: p0739 p9774 bit 1 
BICO from CU 
after the first drive 
in the group  

The macro does 
not perform any 
BICO 
interconnection; 
the use of the 
function requires 
parameterization 
by the user. 
The pin will be 
parameterized as 
output by the 
macro 1/5. 

9 Ground for pins 7, 8, 10, 11 
10 Input Bero 1 – equivalent zero mark"  CU: r 0722.10 p495 = 2  The macro does 

not perform any 
BICO 
interconnection; 
the use of the 
function requires 
parameterization 
by the user. 

Probe 1 Central Measuring (check that 
MD13210 = 0!) 

CU: p0680[0] = 3 Each drive  
p488 [1,2,3]=0 

1/5 11 Input 

Probe 1 - distributed measurement 
(control MD13210 = 1)  

CU: p0680[0] = 0 Each drive  
p488 [1,2,3]=3 

The macro does 
not perform any 
BICO 
interconnection; 
the use of the 
function requires 
parameterization 
by the user. 

12 Ground for pins 7, 8, 10, 11 
1) Low – high edge required! 
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Terminal assigment X132 (NCU 7x0)   
 
Pin 
no. 

Function Assignment recommendation BICO source/sink Macro number 

1 Input Digital input $A_IN[1] CU: r0722.4 CU: p2082[0] 
2 Input Digital input $A_IN[2] CU: r0722.5 CU: p2082[1] 
3 Input Digital input $A_IN[3] CU: r0722.6 CU: p2082[2] 

Digital input $A_IN[4] CU: p2082[3] 

1 
5 

4 Input 
Line contactor, feedback signal 

CU: r0722.7 
LM : p0860 The macro does not 

perform any BICO 
interconnection; the 
use of the function 
requires 
parameterization by 
the user. 

5 Ground for pins 1 ... 4 
6 Ground for pins 7, 8, 10, 11 

Infeed Operation (Line Module with 
DRIVE-CLiQ Connection) 

LM :r0863.0 1 7 Output 

Digital output $A_OUT[4] CU: p2091.3 

CU: p0742 

5 
Infeed Operational (if Line Module with 
DRIVE-CLiQ Connection) 

LM : r0899.0 1 8 Output 

Digital output $A_OUT[3] CU: p2091.2 

CU: p0743 

5 
9 Ground for pins 7, 8, 10, 11 

Digital output $A_OUT[2] CU: p2091.1 1/5 Output 
Line contactor control LM : r0863.1 

CU: p0744 
The macro does not 
perform any BICO 
interconnection; the 
use of the function 
requires 
parameterization by 
the user. 

Bero 2 – equivalent zero mark CU: r 0722.14  Drive:  
p0495 = 5 

10 

Input 

2. OFF 2  Drive: p0845 

The macro does not 
perform any BICO 
interconnection; the 
use of the function 
requires 
parameterization by 
the user. 

Output Digital output $A_OUT[4] CU: p2091.0 CU: p0745 1/5 
Probe 2 Central Measuring (check that 
MD13210 = 0!) 

CU: p0680[1] = 6 Each drive  
p489 [1,2,3]=0 

11 
Input 

Probe 2 - distributed measurement 
(control MD13210 = 1) 

CU: p0680[1] = 0 Each drive  
p489 [1,2,3]=6 

The macro does not 
perform any BICO 
interconnection; the 
use of the function 
requires 
parameterization by 
the user. 

12 Ground for pins 7, 8, 10, 11 
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Terminal assignment X122 (NX 10/15)   
 
Pin 
no. 

Function Assignment recommendation BICO source/sink Macro number 

ON/OFF 1 Infeed Line Module with 
DRIVE-CLiQ Connection 

NX: r0722.0 Infeed p840 1 Input1) 

"Infeed Ready Signal" of Line Module 
without DRIVE-CLiQ connection 

SLM X21.1 Drive p864 

2 Input "OFF3 – rapid stop" 
Function:  
Braking with a configurable OFF3 ramp 
(p1135,1136,1137); thereafter, pulse 
suppression and starting lockout. The 
drive stops controlled. The braking 
response can be set separately for 
each servo. 

NX: r0722.1 Each drive 
2. OFF3, p849 

3 Input SH/SBC 1 - Group 2 SINAMICS Safety 
Integrated (SH enable = p9601) 

NX: r0722.2 p9620 (all drives 
in the group) 

4 Input SH/SBC 1 - Group 1 SINAMICS Safety 
Integrated (SH enable = p9601) 

NX: r0722.3 p9620 (all drives 
in the group) 

The macro does not 
perform any BICO 
interconnection; the 
use of the function 
requires 
parameterization by 
the user. 

5 Ground for pins 1 ... 4 
6 Ground for pins 7, 8, 10, 11 
7 Output SH/SBC - Group 1 

SINAMICS Safety Integrated 
NX: p0738 r9774 bit 1 

BICO from CU 
after the  
first drive in the 
group 

8 Output SH/SBC - Group 2 SINAMICS Safety 
Integrated 

NX: p0739 p9774 bit 1 
BICO from CU 
after the first drive 
in the group  

The macro does not 
perform any BICO 
interconnection; the 
use of the function 
requires 
parameterization by 
the user. 

9 Ground for pins 7, 8, 10, 11 
10 Input Bero 1 – equivalent zero mark"  NX: r0722.10 Drive: p495 = 2  

Bero 2 – equivalent zero mark  NX: r0722.11 Drive: p495 = 3 11 Input 
2. OFF 2  NX: r0722.11 Drive: p0845 

The macro does not 
perform any BICO 
interconnection; the 
use of the function 
requires 
parameterization by 
the user. 

12 Ground for pins 7, 8, 10, 11 
1) Low – high edge required! 
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Support for terminal assignment at the HMI   
In the following menu you can perform terminal assignment for the drive units (NCU, NX) of 
the associated SINAMICS drive group. 
● "Commissioning" > "Drive system" > "Drive units" > "Inputs/outputs" menu   

 
Figure 16-16 "Inputs/outputs" menu for terminal assignment 
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16.6 Overview - Assignment of SINAMICS and NCK machine data for 
communication via PROFIBUS 

Assignment of SINAMICS and NCK machine data for communication 
The table below uses a sample to SINAMICS S120 component configuration to illustrate the 
assignment of the communication parameters. The SINAMICS S120 drive group comprises 
the following: 
● an NCU (CU), 
● an ALM, 
● Three Motor Modules (MM) 

 

 
 

Note 
In the Control Unit Parameter 978, deactivate the process data exchange with the value 
"0". Cyclic and acyclic data are separated. Components that do not communicate on 
PROFIBUS are to be preassigned "255". 
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Figure 16-17 Assignment 
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16.7 Drive-object assignment for PROFIBUS connection 

Introduction 
PROFIBUS message frames (internal PROFIBUS, HW Config) are used to specify the 
process data to be exchanged between the NCK and the drives. The sequence of the drive 
objects (configurable/configured using HW Config) involved in PROFIBUS process-data 
exchange is defined via a drive-object list.  

List of drive objects 
You usually configure eight drive objects (DOs). The drive objects have drive-object (DO) 
numbers and are input in p978[0…9] as a list of drive objects. 
You configure the following from parameter p978 in the index:  
● 0…5 -> Motor Module (e.g., DO no. 3…8) 
● 6 -> Control Unit (e.g., DO no. 1) 
● 7 -> Active Line Module (e.g., DO no. 2), 

PROFIBUS message frame 370 is not currently available for the Active Line Module 
(infeed). However, according to the SINAMICS rule, all DOs from parameter p0101 have 
to be assigned in parameter p0978. The resulting infeed DO number then has to be 
entered in index 9 (see table below). 

 

 
 

Note 
The list of DOs involved in process-data exchange is completed by entering a value of 
"0". Components that are available, but do not communicate on PROFIBUS, must be 
preset to "255". 

 

The list of drive objects is already pre-assigned in the following order by the system upon 
initializing the drive (acceptance of topology):  
● ALM, first Motor Module …n., CU; e.g., 2-3-4-5-1. 
● The assignment allocated by the drive when the DRIVE-CLiQ topology is accepted must 

be reviewed and adapted. 

Drive-object numbers 
The drive-object numbers (DO numbers) can be viewed under "Commissioning > Machine 
data > Control Unit MD/Infeed MD/Drive MD" in the component name line. For example, the 
name for a Control Unit could be: "DP3.Slave3:CU_003 (1)". The DO number appears inside 
the brackets "(…)". 
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Drive-object assignment  
The table below uses the example of a SINAMICS S120 component configuration to 
illustrate the drive-object assignment to be made for the drive parameters. 
For example, the drive group could be configured as follows: 
● One Control Unit (CU) 
● One Active Line Module (ALM) 
● Three Motor Modules 

Table 16- 1 Assignment of p978[0…9] for infeed with DRIVE-CLiQ connection 

Component Index p978  List of drive objects  
1. Motor module 0 3 
2. Motor module 1 4 
3. Motor module 2 5 

not found 3 2551) 
not found 4 2551) 
not found 5 2551) 

CU 6 1 
ALM, only if protocol 370 is 

available 
7 2551) 

not found 8 02) 
ALM (Standard for SINUMERIK) 9 2 

1) Not active 
2) End of exchange of PZD 

 

 Note 
The following table describes the assignment of the drive objects in the p978[0…9] for an 
infeed without DRIVE-CLiQ connection. This assignment is also done for a drive group with 
NX module.  
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Table 16- 2 Assignment p978[0…9] for infeed without DRIVE-CLiQ connection 

Component Index p978  List of drive objects  
1. Motor module 0 2 
2. Motor module 1 3 
3. Motor module 2 4 

not found 3 2551) 
not found 4 2551) 
not found 5 2551) 

CU 6 1 
ALM, only if protocol 370 is 

available 
7 2551) 

not found 8 02) 
not found 9 0 

1) Not active 
2) End of exchange of PZD 

Procedure for assigning the drive objects in parameter p978 
You are now in the "Commissioning > Machine data > Control Unit MD" menu. 
p978 can be written using the following sequence: 
1. Set p9 = 1 
2. Set p978 [0...9] to the values outlined in the table below (column …List of drive 

objects…), e.g., 3-4-5-255-255-255-1-255-0-2. 
– Motor Module drive objects, ascending order (connected as per DRIVE-CLiQ) 
– Control unit 
– ALM 

3. Set p9 = 0 
4. Save "All": set p977 = 1 

It is imperative you wait until p977 is automatically written back to "0". 

See also 
Overview - Assignment of SINAMICS and NCK machine data for communication via 
PROFIBUS (Page 299) 
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16.8 PROFIBUS machine control panel on the HMI 

Configuration of the PROFIBUS machine control panel 
The following is essential for a PROFIBUS machine control panel on the HMI: 
● Configuration of the properties of the network interface for PROFIBUS 
● Supplementation of the machine control panel and hand wheel in HW Config 
● Modification of the machine control panel in OP100 

16.8.1 Configuration of the properties of the network interface for PROFIBUS 

Introduction 
In the STEP7 project, you configure the network interfaces PROFIBUS DP, via which you 
want to reach the machine control panel: 

PROFIBUS DP operating sequence 
1. You used the left mouse button to select NCU 720.1 and while holding down the mouse 

button you dragged it to the "Station design" station window. 
2. After you release the mouse button, configure the properties of PROFIBUS DP interface 

for socket X126 (machine control panel) in the dialog box (see figure below). 

 
Figure 16-18 Properties of PROFIBUS DP 

3. Click the following menu items one after the other: 
– the "New..." button, 
– the "Network settings" tab in the "Properties new subnet PROFIBUS Subnet" dialog 

box. 
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4. Select the transmission rate "12 Mbps" for the "DP" profile (see figure below). 

 
Figure 16-19 Properties of the PROFIBUS interface 

5. Click on "Options" and then on the "Equidistance" tab (see figure below). 

 
Figure 16-20 Equidistance 
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6. To enable reproducible access to peripherals (for hand wheel mode), the PROFIBUS DP 
must have constant bus cycle time. The following entries are necessary under 
Equidistance: 
– Click on the "Activate equidistance bus cycle" field 
– Enter the cycle, e.g., "2 ms" for the "Equidistance DP cycle" (for integrated 

PROFIBUS) (see MD10050 $MN_SYSOCK_CYCLE_TIME). 
– Click on the "Times Ti and To equal for all slaves" field 
– The fields "Time Ti" and "Time To" must contain a value "< 2ms". 

7. Click on "OK" three times. 
8. Module NCU 720.1 with SINAMICS S120 is inserted into the HW config (see figure 

below). 
 

 
 

Note 
With the <F4> key and confirmation of the question regarding "Reorganize", you can 
reorganize the display in the station window. 

 

 
Figure 16-21 HW config with NCU 7x0 

As the next step configure a machine control panel with hand wheel. 
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16.8.2 Load GSD file (contains machine control panel) 

Introduction 
To expand the machine control panel, you need the device data (GSD file) with the 
SINUMERIK MCP. This file contains information that a DP master system requires to link the 
MCP as DP slave in its PROFIBUS configuration. 
This file is a component of the STEP7 package for NCU7x0 (tool box). 

Operating sequences 
1. Search in the HW config under "Extras" > "Install GSD file…" in the installation directory 

of the tool box under, for example: C:\temp\tb_sl_1.1.0.0\8x0d\GSD\MCP_310_483 to find 
the corresponding GSD directory. 

2. Choose the corresponding language you want to install. 
3. Click "Install". 
4. Click "Close". 

16.8.3 Adding a machine control panel and handwheel in HW Config 

Introduction 
The machine control panel (MCP) can be connected via PROFIBUS to the PLC. In later 
configurations, this will also be possible over the network. 

Operating sequence for adding an MCP in HW Config 
You have created a NCU and a NX in the HW Config and installed the GSD file for the MCP. 
1. Search under "PROFIBUS DP" > "Further field devices" > "NC/RC" > "MOTION 

CONTROL" for the "SINUMERIK MCP" module. 
2. Click with the left mouse button to select the "SINUMERIK MCP" module and drag it to 

the chain for the "PROFIBUS DP master system" in the "Station design" station window. 
3. After releasing the mouse button, the machine control panel is added (see figure below). 
4. Select "MCP" and enter the PROFIBUS address 6 under "Object properties" > button 

"PROFIBUS..." > tab "Parameter" > input field "Address". 
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5. Click on "OK" twice. 
Now you can assign the slots of the machine control panel, e.g., "Standard + Hand 
wheel". 

 
Figure 16-22 Machine control panel in HW Config 
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6. In the hardware catalog under "SINUMERIK MCP" click with the left mouse button to 
select the "Standard+Hand wheel" option and drag it to Slot 1 (see figure below). 

 
Figure 16-23 Standard+Handwheel for slot 

You have configured a machine control panel with handwheel in HW Config. 
 

 Note 
If a handwheel has been configured, equidistance is required. You set this when you 
configured the PROFIBUS DP. PROFIBUS address for the machine control panel is "6". 

 

Save, compile and load the configuration to the PLC as the next operating sequence.  
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16.8.4 Modifying PROFIBUS machine control panel in OB100 

Introduction 
The PLC basic program automatically transfers the machine control panel signals (MCP 
signals) and the addresses of the MCP in the HW config if the configuration is set up as laid 
out below. 

Operating sequence 
● Under "Blocks", double-click on "OB100" to open it. 

In OB100, the parameters below have to be preset: 
 MCPNum :=1 
 MCP1IN := P#E 0.0 
 MCP1OUT := P#E 0.0 
 MCP1StatSend := P#E 8.0 
 MCP1StatREc := P#E 12.0 
 MCPBusAdresse := 6 
 MCPBusType = B#16#33 
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Licensing 17
17.1 Import licensing terms 

The terms below are important for understanding the license management of SINUMERIK 
software products. 

 
Term Description 
Software product "Software product" is generally used to describe a product that is installed on a piece of 

hardware to process data. Within the license management of SINUMERIK software products, 
a corresponding license is required to use each software product. 

Hardware In the context of license management of SINUMERIK software products, "hardware" refers to 
the component of a SINUMERIK control system to which licenses are assigned on the basis 
of its unique identifier. License information is also saved to remanent memory on this 
component. 
Example: 
• SINUMERIK 840D sl: CF card 
• SINUMERIK 840Di sl: MCI board 

License A license gives the user a legal right to use the software product. Evidence of this right is 
provided by the following: 
• CoL (Certificate of License) 
• License key 

CoL 
(Certificate of License)  

The CoL is the proof of the license. The product may only be used by the holder of the 
license or authorized persons. The CoL includes the following data relevant for the license 
management: 
• Product name 
• License number 
• Delivery note number 
• Hardware serial number 
Note 
The hardware serial number is located only on a CoL of the system software or if the license 
was ordered bundled, in other words the system software came together with options. 

License number The license number is the feature of a license that is used for its unique identification. 
CF Card 
(Compact Flash Card)  

The CF Card represents, as the carrier of all the remanent data of a SINUMERIK solution line 
control system, the identity of this control system. The CF Card includes the following data 
relevant for the license management: 
• Hardware serial number 
• License information including the License Key 

Hardware serial number The hardware serial number is a permanent part of the CF Card. It is used to identify a 
control system uniquely. The hardware serial number can be determined by: 
• CoL (see: Certificate of License > "Note") 
• HMI user interface 
• Printing on the CF Card 



Licensing  
17.2 Overview 

 IBN CNC: NCK, PLC, drive 
312 Commissioning Manual, 03/2009, 6FC5397-2AP10-5BA0 

Term Description 
License key The License Key is the "technical representative" of the sum of all the licenses that are 

assigned to one particular piece of hardware, which is uniquely marked by its hardware serial 
number. 

Option One option is a SINUMERIK software product that is not contained in the basic version and 
which requires the purchase of a license for its use. 

Product A product is marked by the data below within the license management of SINUMERIK 
software products: 
• Product designation 
• Order number: 
• License number 

17.2 Overview 
The use of the installed system software and the options activated on a SINUMERIK control 
system require that the licenses purchased for this purpose are assigned to the hardware. In 
the course of this assignment, a License Key is generated from the license numbers of the 
system software, the options, as well as the hardware serial number. Here, access occurs to 
a license database administered by Siemens A&D via the Internet. Finally, the license 
information including the License Key is transferred to the hardware. 
There are two ways to access the license database: 
● Web License Manager 
● Automation License Manager 

 

 
 

Note 
Using SINUMERIK software products for testing purposes 
SINUMERIK software products may be temporarily activated and used for testing 
purposes on a SINUMERIK control system, even without the corresponding License Key. 
The license-information "Overview" dialog box on the SINUMERIK user interface, e.g., 
HMI Advanced, indicates that the License Key is "Insufficient". Also the control system 
will repeatedly display a corresponding message. 
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17.3 Web License Manager 
By using the Web License Manager, you can assign licenses to hardware in a standard Web 
browser. To conclude the assignment, the License Key must be entered manually at the 
control system via the HMI user interface. 

Internet address 
The Internet address of the Web License Managers is:  
http://www.siemens.com/automation/license 

17.4 Automation License Manager 
The Automation License Manager can be used to assign all the licenses required for a piece 
of hardware (license-requirement comparison). The license information, including the 
License Key, is transferred electronically via an Ethernet link (TCP/IP).  
Preconditions: 
● The Automation License Manager must be installed on the computer (PC/PG) that is 

used to assign the licenses to the hardware. 
● The computer (PC/PG) must be able to connect to the license database and the 

SINUMERIK control system via Ethernet link (TCP/IP):  
– License database: Internet connection 
– SINUMERIK control system: Intranet or PTP connection (Ethernet, Peer-To-Peer)  
The individual steps for assigning licenses to hardware (license database) and the 
transfer of license information from/to the SINUMERIK control system can be performed 
such that only one connection must be available at any one time. 

http://www.siemens.com/automation/license
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17.5 License database 
The license database contains all the customer-specific license information relevant for the 
license management of SINUMERIK software products. The central management of the 
license information in the license database ensures that the existing license information 
regarding a piece of hardware is always up to date.  

License database access 
License database access occurs via: 
● Direct access 

The direct access occurs with: 
– Delivery note number 
– License number 
The direct access enables the direct assignment of licenses for which the license 
numbers are available, e.g., in the form of a CoL. 

● Customer login 
The customer login occurs with: 
– User name 
– Password 
The customer login enables the assignment of all the licenses available to the user that 
are delivered at the time of the login and have not yet been assigned to any hardware. 
Here, the license numbers of licenses that can still be assigned need not be directly at 
hand, instead these are displayed from within the license database. 

 

 
 

Note 
Customer login 
You can obtain a customer login from Siemens A&D Mall under menu item: 
"Registration". The Internet address is: http://mall.automation.siemens.com/  
Currently, access is not yet possible for all countries. 

 

Various license information 
As indicated above, only the license information in the license database represents the 
current status regarding a piece of hardware. Differences may arise between the license 
information available for a piece of hardware and that of the license database due to: 
● loading older archive data into the NCK (data restoration from a series-commissioning file 

after a service job) 
● assigning licenses to hardware without transferring the modified license information for 

the hardware control system (online) 
As a result, a more limited license requirement (possibly no license requirement) may be 
displayed than indicated on the HMI user interface of the control system for a license 
requirement alignment by Automation License Manager. 
To align the license information, a transfer should be carried out for the current license 
information of the license database for the hardware control system (online). 

http://mall.automation.siemens.com
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17.6 CF Card and hardware serial numbers 
The CF card (Compact Flash card) contains, in addition to the system and user software and 
the retentive system and user data, that data relevant for the license management of 
SINUMERIK software products of a control system:  
● Hardware serial number 
● License information including the License Key 
The CF card thus represents the identity of a SINUMERIK control system. For this reason, 
assigning licenses to a control system always occurs using the hardware serial number. 
This has the advantage that the CF card can be slotted into a replacement NCU in the event 
of failure and all data is retained. 

Automation License Manager 
Thus, the hardware serial number is always decisive during the transfer of license 
information to a control system in Automation License Manager and not the set IP address of 
the control system with which Automation License Manager is currently communicating. 

Determining the hardware serial number  
The hardware serial number is a permanent part of the CF card. It is used to identify a 
control system uniquely. The hardware serial number can be determined by:  
● CoL (Certificate of License) (see note)  
● SINUMERIK user interface, e.g. HMI Advanced 
● Printing on the CF card 
● Display in the Automation License Manager as supplementary information for the 

elements below: 
– Control system file 
– Control system (online) 
– Control image (offline)  

 

 
 

Note 
Hardware serial number and CoL 
The hardware serial number is located only on a CoL of the system software or if the 
license was ordered bundled, in other words the system software came together with 
options. 
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17.7 SINUMERIK License Key 

Basic information on License Keys 
If a license is required for a product, then with the purchase of the license the purchaser 
receives a CoL as proof for the rights to use this product and a corresponding License Key 
as to the "technical representative" of this license. In conjunction with software products, the 
License Key usually must be available on the hardware on which the software product 
executed. 

SINUMERIK License Keys 
Depending on the software product, there are License Keys with different technical 
properties. The essential properties of a SINUMERIK License Key are: 
● Hardware reference 

The hardware serial number included in the SINUMERIK License Key provides a direct 
link between the License Key and the hardware on which it can be used. In other words, 
a License Key created for the hardware serial number of a specific CF card is only valid 
for this CF card and will be rejected on other CF cards as invalid.  

● Total number of assigned licenses 
A SINUMERIK License Key not only refers to one single license, instead it is the 
"technical representative" of all licenses that are assigned to the hardware at the time of 
its generation.  

Copying SINUMERIK License Keys 
By the fixed reference to certain hardware, a SINUMERIK License Key may, for example, be 
copied to various computers (PC/PG) and/or memory media for security or archiving 
purposes. 
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17.8 Assigning via Web License Manager 

17.8.1 You can execute an assignment via direct access as follows 

Background 
For the direct access, log on to a computer connected to the Internet (PC/PG) with the 
delivery note and license number in the Web License Manager. All licenses of the delivery 
note numbers entered at the login may then be assigned to a piece of hardware. After 
completing the assignment process, the new License Key is displayed. This must then be 
entered in the licensing dialog of the HMI components used. 

Requirements 
The following prerequisites must be met in order to assign a license to a piece of hardware 
via direct access and HMI user interface: 
● The HMI component is connected with the control system (NCU) on which the license 

should be assigned. Both components have been booted. 
● A computer (PC/PG) with Internet connection and browser is available. 
● The login data for the direct access (e.g., per CoL) are available: 

– License number 
– Delivery note number 
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Assigning a license to a piece of hardware 
1. Determine the hardware serial number and the product name (HMI Advanced/HMI 

Embedded: "Hardware type") via the HMI licensing dialog box. 
HMI Advanced/HMI Embedded: 
Operating-area switchover: Commissioning > Key: etc. (">") > Licenses > Overview 

 

 
 

Note 
Ensure that the hardware serial number displayed is also really the one you want to make 
the assignment for. The assignment of a license to a piece of hardware cannot be 
reversed via the Web License Manager. 

 

2. Go to the Internet page of the Web License Manager: 
http://www.siemens.com/automation/license 

3. Login via "Direct access": 
– License number 
– Delivery note number 

4. Follow the additional instructions in the Web License Manager. 
 

 
 

Note 
License Key via e-mail 
If you have an e-mail address, you can have the option (checkbox) of receiving the 
License Key by e-mail. Advantage: the entry of the License Key to the control system is 
simplified. 

 

5. After completing the assignment process, enter the License Key displayed on the Web 
License Manager into the licensing dialog of the HMI user interface.  
HMI Advanced/HMI Embedded: 
Operating-area switchover: Commissioning > Key: etc. (">") > Licenses > Overview 

6. Confirm the entry of the new License Key by pressing the softkey: "Transfer". 

http://www.siemens.com/automation/license
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17.8.2 You can execute an assignment via customer login as follows 

Background 
For the customer login, log on to a computer (PC/PG) connected to the Internet with the user 
name and password in the Web License Manager. All licenses released for this user name in 
the framework of the license management may then be assigned to a piece of hardware. 
After completing the assignment process, the new License Key is displayed. This must then 
be entered in the licensing dialog of the HMI components used. 

Requirements 
The following prerequisites must be met in order to assign a license to a piece of hardware 
via customer login and HMI user interface: 
● The HMI component is connected with the control system (NCU) on which the license 

should be assigned. Both components have been booted. 
● A computer (PC/PG) with Internet connection and browser is available. 
● The login data for the customer login is available: 

– User name 
– Password 
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Assigning a license to a piece of hardware 
1. Determine the hardware serial number and the product name (HMI Advanced/HMI 

Embedded: "Hardware type") via the HMI licensing dialog box. 
HMI Advanced/HMI Embedded: 
Operating-area switchover: Commissioning > Key: etc. (">") > Licenses > Overview 

 

 
 

Note 
Ensure that the hardware serial number displayed is also really the one you want to make 
the assignment for. The assignment of a license to a piece of hardware cannot be 
reversed via the Web License Manager. 

 

2. Go to the Internet page of the Web License Manager: 
http://www.siemens.com/automation/license 

3. Login via "Customer login": 
– User name 
– Password 

4. Follow the additional instructions in the Web License Manager. 
 

 
 

Note 
License Key via e-mail 
If you have an e-mail address, you have the option (checkbox) of receiving the License 
Key by e-mail. Advantage: the entry of the License Key to the control system is simplified.

 

5. After completing the assignment process, enter the License Key displayed on the Web 
License Manager into the licensing dialog of the HMI user interface.  
HMI Advanced/HMI Embedded: 
Operating-area switchover: Commissioning > Key: etc. (">") > Licenses > Overview 

6. Confirm the entry of the new License Key by pressing the softkey: "Transfer". 

http://www.siemens.com/automation/license
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17.9 Assigning via Automation License Manager 

17.9.1 Function Overview 
The following figure provides an overview of the functions available and the sequence in 
which they should be applied.  
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17.9.2 Installing the Automation License Manager 

Background 
The following components need to be installed for the license management of SINUMERIK 
solution line License Keys:  
● Automation License Manager 

The Automation License Manager is loaded by the installation routine only if no manager 
or a manager version with a lower version number is installed on the computer (PC/PG).  

● SINUMERIK plug-in 
The SINUMERIK plug-in is loaded by the installation routine only if it finds a version of the 
Automation License Manager installed on the computer (PC/PG).  

● HMI basic software 
The HMI basic software is loaded by the installation routine only if no HMI software or a 
version with a lower number is installed on the computer (PC/PG).  

 

 
 

Note 
The Automation License Manager is used for all Siemens A&D products, e.g. SIMATIC 
STEP7. As versions of the Automation License Manager are upwards compatible, we 
always recommend using the version with the highest version number, irrespective of the 
source of supply (e.g. SINUMERIK or SIMATIC product CD, download via A&D Mall, 
etc.).  

 

System requirements 
Hardware  
● Computer: Industrial PC, programming device, etc. 
● Work memory: >= 128 MB 
● Free hard-disk storage: 

 5 MB (SINUMERIK plug-in)  
+ 32 MB (Automation License Manager) 
+ 300 MB (HMI basic software) 

● Operating system: Windows XP 

Execution 
1. Launch the installation program for the Automation License Manager from "SETUP.EXE" 

and follow the instructions for the installation. 
2. Launch the installation program for the SINUMERIK plug-in from "SETUP.EXE" and 

follow the instructions for the installation.  
The HMI basic software can be installed as part of this process. 
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17.9.3 Enabling/disabling SINUMERIK plug-ins 

Background 
All of the plug-ins enabled for the Automation License Manager scan the relevant 
communication interfaces when booting and after specific operator inputs. If there is a large 
number of enabled plug-ins, this can result in a significantly longer boot and refresh time for 
the user interface. To prevent this delay, you can disable the plug-in installed for handling 
the SINUMERIK License Keys in dialog: "Connect to target system".    

Procedure 
Perform the following actions to enable/disable the SINUMERIK plug-ins: 
1. Start the Automation License Manager 
2. Open the "Connect to target system" dialog via menu command: Edit > Connect to target 

system > SINUMERIK . . .   
3. In the dialog, open tab: Settings 
4. Enable/disable the plug-in by selecting/deselecting the appropriate checkbox. 
5. Close the dialog by pressing the button: OK 

Result 
The Automation License Manager shows the SINUMERIK-specific license information in 
accordance with the current status of the SINUMERIK plug-in. See Section:   

 

 Note 
How to refresh the view manually 
If the view is not automatically refreshed, you can refresh the view manually. See Section: 
"How to refresh the view: Manage" 
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17.9.4 Assigning parameters to the TCP/IP communication with a control system 

Background 
To be able to read or transfer license information from or to the CF card of a control system, 
the Automation License Manager must communicate with the control system via TCP/IP.  
Requirements: 
● The HMI basic software is installed 
● The SINUMERIK plug-in is enabled 

 

 
 

Note 
HMI Advanced 
If the SINUMERIK user interface "HMI Advanced" is installed on the same computer 
(PC/PG) as the Automation License Manager you can set the IP address using the user 
interface. The IP address for the control system with which both HMI Advanced as well as 
the Automation License Manager communicate is set via the following dialog:  
Operating area switchover > Start-up > HMI > NCU link 
This requires at least the password of protection level 2 (manufacturer) to be set. 

 

General communication parameters 
The default general communication parameters for the HMI basic software are stored in the 
following initialization file:  
<installation drive>:\Siemens\Sinumerik\HMI-Advanced\mmc2\MMC.INI  
User-specific communication parameters 
The user-specific communication parameters for the HMI basic software are stored in the 
following initialization file: 
<installation drive>:\Siemens\Sinumerik\HMI-Advanced\user\MMC.INI 
During evaluation of the initialization data when booting the HMI basic software, user-specific 
communication parameters have priority over general communication parameters.  
Sections of the initialization file: MMC.INI 
The parameters relevant to TCP/IP communication with SINUMERIK control systems are 
stored in the following sections:  
● [ GLOBAL ] 

Section: [ GLOBAL ] specifies the section (e.g. AddressParameter) that contains the 
communication parameters for the current SINUMERIK control system. 

● [ AddressParameter ] 
The name of this section can be any unique ASCII string within the file. The specified IP 
address is crucial for communication with the current SINUMERIK control system: IP 
address. 
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Table 17- 1 User-specific file: MMC.INI 

Statements 

[GLOBAL]  

NcddeMachineName = AddressParameter 

NcddeDefaultMachineName = AddressParameter 

NcddeMachineNames = AddressParameter 

 

[ AddressParameter ] 

ADDRESS0 = IP address, LINE=10,NAME=/NC, SAP=030d, PROFILE=CLT1__CP_L4_INT 

ADDRESS1 = IP address, LINE=10,NAME=/PLC, SAP=0201, PROFILE=CLT1__CP_L4_INT 

ADDRESS2 = IP address, LINE=10, NAME=/DRIVE0, SAP=0900, PROFILE=CLT1__CP_L4_INT 

ADDRESS3 = IP address, LINE=10, NAME=/DRIVE1, SAP=0a00, PROFILE=CLT1__CP_L4_INT 

ADDRESS4 = IP address, LINE=10, NAME=/DRIVE2, SAP=0b00, PROFILE=CLT1__CP_L4_INT 

ADDRESS5 = IP address, LINE=10, NAME=/DRIVE3, SAP=0c00, PROFILE=CLT1__CP_L4_INT 

ADDRESS6 = IP address, LINE=10, NAME=/DRIVE4, SAP=0d00, PROFILE=CLT1__CP_L4_INT 

ADDRESS7 = IP address, LINE=10, NAME=/DRIVE5, SAP=0e00, PROFILE=CLT1__CP_L4_INT 

Multiple SINUMERIK control systems 
If you require communication with multiple SINUMERIK control systems you must create a 
section  
[ AddressParameter ] with a unique name e.g. [ 840D_001 ], [ 840D_002 ], etc. for each 
control system with the relevant IP address. 
In the [ GLOBAL ] section, you must specify the section name for the SINUMERIK control 
system, e.g. [ 840D_001 ], with which communication should occur once the Automation 
License Manager has booted. 

 

NOTICE  
Editing the IP address 
The IP address specified in the user-specific initialization file MMC.INI influences not only 
the Automation License Manager but also all other applications installed on the same 
computer (PC/PG) that use HMI basic software (e.g. HMI Advanced). 
To apply the change to the active IP address, you must close all active applications using 
HMI basic software (e.g. HMI Advanced). Once you have closed all applications, restart the 
computer to activate the new IP address.  

 

Requirements 
The following conditions must be fulfilled: 
● The HMI basic software is installed on the computer (PC/PG) on which the Automation 

License Manager is running. 
● The IP addresses of the SINUMERIK control systems with which the Automation License 

Manager must communicate are known.  
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Procedure: Creating parameters for the first time 
Perform the following actions when creating user-specific communication parameters for the 
first time: 
1. Create the text file: 

<installation drive>:\Siemens\Sinumerik\HMI-Advanced\user\MMC.INI if it does not 
already exist. 

2. Open the file MMC.INI with a text editor. 
3. Copy the [ GLOBAL ] section from the table given above: "User-specific file: MMC.INI" to 

the open file MMC.INI. 
4. Copy the [ AddressParameter ] section from the table given above: "User-specific file: 

MMC.INI" to the open file MMC.INI according to the number of available SINUMERIK 
control systems. 

5. For all [ AddressParameter ] sections replace the string: "AddressParameter" with a 
unique name. 

6. In all [ AddressParameter ] sections replace the string: "IP-Address" with the relevant IP 
address for the corresponding SINUMERIK control system. 

7. In the [ GLOBAL ] section replace the string: "AddressParameter " with the section name 
for the SINUMERIK control system with which the Automation License Manager must 
communicate after booting. (See note "Changing the IP address" above.) 

Procedure: Changing the active control system (online)  
Perform the following actions to change the active control system (online), i.e. the 
SINUMERIK control system with which the Automation License Manager communicates: 
1. Close the Automation License Manager.  

(See note "Changing the IP address" above.) 
2. Open the file: <installation drive>:\Siemens\Sinumerik\HMI-Advanced\user\MMC.INI with 

a text editor. 
3. In the [ GLOBAL ] section, replace the current address string with the section name for 

the SINUMERIK control system with which the Automation License Manager should 
communicate after booting. 

4. Start the Automation License Manager. 

Result 
After booting the Automation License Manager communicates with the SINUMERIK control 
system defined in the user-specific communication parameters. 
The control system to which you have switched is represented by an "online" control system 
file in the navigation area of the Automation License Manager. 
The control system to which the Automation License Manager was connected before 
switching is represented by an "offline" control system file, if a control image (offline) exists. 
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17.9.5 How to refresh the navigation view: "Manage" 

Background 
After actions which add or remove elements in the navigation area of the navigation view: 
"Manage" of the Automation License Manager (e.g. deletion of a control image (offline), 
enabling/disabling of plug-ins), the view is normally refreshed automatically. If the view does 
not refresh automatically after an operation, you can refresh the view manually. 

Execution 
Perform the following actions to refresh the navigation view: "Manage" manually: 
1. Select the following nodes in the navigation area of the Automation License Manager: My 

Computer 
2. Refresh the view using one of the following options: 

– Menu command: View > Refresh 
– Key F5 

– Toolbar:  

Result 
The navigation view of the Automation License Manager is refreshed. All sub-nodes under 
the node: My Computer are closed. 
The object view of the Automation License Manager shows the current nodes and drives of 
the navigation area. 

 

 Note 
All directories are closed when the view is refreshed. When you select key: ' * ' on the 
numeric keypad, you can open all directories with a single key. 
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17.9.6 Displaying the license information of a piece of hardware 

Background 
To perform one of the following tasks with the Automation License Manager: 
● Check the license information for the hardware 
● Ascertain the license requirement for the hardware and align if necessary 
● Assign new licenses to hardware and transfer updated license information including 

License Keys to the hardware 
you must display the license information for a hardware item. 

Requirements 
The license information can only be displayed if the Automation License Manager is 
communicating with the relevant SINUMERIK control system. 

Procedure with current control system (online)  
Perform the following actions to display the license information for the control system 
currently connected to the Automation License Manager: 

1. In the navigation area of the Automation License Manager, open: Technology folder: 
"SINUMERIK online" > Control folder  and choose the control system (online)  by 
clicking with the left mouse button. 

2. Enable the default object view: "SINUMERIK". 

Procedure with control system change over (online)  
Perform the following actions to display the license information for a control system not 
connected to the Automation License Manager: 
1. Exit the Automation License Manager and all other applications using HMI basic software 

(e.g. HMI Advanced). 
2. Switch the active communication parameters to the required control system. See Section: 
3. Start the Automation License Manager 

4. In the navigation area of the Automation License Manager, open: Technology folder: 
"SINUMERIK online" > Control folder  and choose the control system (online)  by 
clicking with the left mouse button. 

Result 
The license information for the control system (online) is displayed in the object area of the 
Automation License Manager. 
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17.9.7 Creating a control image (offline) 

Background 
It is essential to create a control image (offline) in the following situations:  
● The license information must later be transferred to the control system (online). 
● The computer (PC/PG) on which the Automation License Manager is installed is not 

simultaneously connected to the Internet and the control system. This means the license 
information must be transferred to the control system (online) in three separate steps. 
– Intranet or PTP link to control system: Creating a control image (offline) in the 

Automation License Manager 
– Internet connection: Transferring license information to the control image (offline) by 

license requirement alignment  
– Intranet or PTP link to control system: Transferring license information from the control 

image (offline) to the control system (online) in the Automation License Manager 
● The license information for a control system should be saved as an archive file for the 

purpose of archiving or customer support. 

Requirements 
A control image (offline) can only be created if the Automation License Manager is 
communicating with the control system.  

 

 Note 
A PTP link (Peer-To-Peer) via Ethernet and TCP/IP requires a crossed Ethernet cable 
(twisted pair crossed 10baseT/100baseTX Ethernet cable). 

 

Procedure using drag-and-drop 
Perform the following steps to create a control image (offline) of the control system (online) 
by drag-and-drop: 
1. In the navigation area of the Automation License Manager, open:  

Technology folder: "SINUMERIK online" > Control folder  and choose the control 
system (online)  by clicking with the left mouse button. 

2. Select any line from the license information displayed in the object area by clicking with 
the left mouse button. 

3. Drag the selected line to the desired target and release the mouse button. 
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The following objects can be selected as the target: 
●  Computer 
●  Drive 
●  Storage folder 

●  Control folder "offline" 

●  Control image (offline) 

Result 
A control image (offline) has been created from the license information of the control system 
(online) in the selected target: 
●  <computer> → drive C:\<default storage folder> 
●  <drive>:\SINUMERIK\<storage folder>\<control folder "offline"> 
●  <storage folder>\<control folder "offline"> 

●  <control folder "offline"> 
●  Control image (offline): The control image (offline) was overwritten with the license 

information of the control system (online) 

Procedure using menu command: "Upload from target system" 
Perform the following actions to create a control image (offline) of the control system (online) 
using menu command: "Upload from target system": 

1. In the navigation area of the Automation License Manager, open: Technology folder: 
"SINUMERIK online" > Control folder  and choose the control system (online)  by 
clicking with the left mouse button. 

2. Create the control image (offline)  using menu command: License Key > Upload from 
target system 

Result 
A control image (offline) has been created from the license information of the control system 
(online) in the default storage folder: 
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17.9.8 Performing a license requirement alignment for a piece of hardware 

Background 
If one or more options are active on a SINUMERIK control system, you must assign each 
license to the hardware. Next, the updated license information including the new license key 
is transferred to the hardware.  
Via the function: "Align requirement" you can perform the alignment automatically for all 
required licenses based on the control system (online) or a control image (offline). The 
following actions are performed: 
● Determining the hardware serial number for the control system 
● Determining the license requirement for the control system 
● Taking the required licenses from the customer-specific licenses and assigning these to 

the hardware 
● Transferring the updated license information including License Key to the control system 

(online) or the control image (offline) 

Requirements 
The following requirements must be met for the license requirement alignment: 
● The address data for the customer login (personalized login) is available: 

– User name 
– Password 

● Control (online) or control image (offline) 
An "online" control system file or an "offline" control system file with the relevant control 
image (offline) is available.  

Procedure 
Perform the following actions for license requirement alignment with a control system 
(online) or a control image (offline): 
1. In the navigation area of the Automation License Manager, open: 

– For control system (online) 
Technology folder:  SINUMERIK online > Control folder "online"  

– For control image (offline) 
Technology folder:  SINUMERIK offline > storage folder  > control folder "offline" 

 or  

and choose the control system (online)  or the control image (offline)  or  by clicking 
with the left mouse button. 

2. Select the menu command: License Key > Align requirement 
3. Login via your customer login. 
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4. Start the Automation License Manager and perform the following actions: "Align 
requirement", "Confirm requirement list" and "Transfer licenses". Follow the instructions 
displayed on the screen. 

 

NOTICE  
 

Suggested license assignment 
Carefully check the suggested license assignment. An adjustment may be required if: 
• you wish to use a license number that differs from the number suggested 
• you wish to use a license package rather than single licenses 
• you wish to assign greater or fewer licenses than suggested for any reason 
You can no longer undo the assignment independently. 

 

The procedure for transferring the updated license information from a control image (offline) 
to a control system (online) is described in Subsection:  

Result 
A new License Key has been generated and loaded to the control (online) or the control 
image (offline). 
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17.9.9 Transferring license information for a control image (offline) to a control system 
(online) 

Background 
It is essential to transfer the license information for a control image (offline) to a control 
system (online), i.e. the hardware for a SINUMERIK control, in the following situations:   
● The computer (PC/PG) on which the Automation License Manager is installed is not 

simultaneously connected to the Internet and the control system. License information is 
initially only updated based on a control image (offline). The computer on which the 
Automation License Manager is running is then disconnected from the Internet and 
connected to the relevant SINUMERIK control system to transfer the license information.   

● After a service call, the license information should be transferred from an archive file to a 
SINUMERIK control system. 

Requirements 
The following conditions must met for transmission of a control image (offline) to the control 
system (online): 
● The Automation License Manager must be communicating with the control system. 
● The hardware serial number of the control image (offline) and the control system (online) 

must be identical. 

Procedure using drag and drop  
Perform the following steps to transfer a control image (offline) to the control system (online) 
by drag-and-drop: 
1. In the navigation area of the Automation License Manager, open:  

Technology folder:  "SINUMERIK online" > Control folder  and left-click on the 
control (online)  to select it. 

2. In the navigation area of the Automation License Manager, open:  
Technology folder:  "SINUMERIK offline" > storage folder:  > control folder  . 
Choose the control image (offline)  by clicking with the left mouse button. 

3. Select any line from the license information displayed in the object area by clicking with 
the left mouse button. 

4. Drag the selected line to the control system (online)  release the mouse button.  
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Procedure using menu commands  
Perform the following actions to transfer a control image (offline) to the control system 
(online) using menu command: "Download to target system":   
1. In the navigation area of the Automation License Manager, open:  

Technology folder  SINUMERIK offline > storage folder:  > control folder:  and 
choose the control image (offline) by clicking with the left mouse button: . 

2. Select the menu command: License Key > Download to target system 

Result 
The license information of the control system (online) is now identical to the information for 
the control image (offline), including the license key. 

17.10 Internet links 
Overview of Internet links used: 

 
No. Topic Address 
1 Web License Manager http://www.siemens.com/automation/license 
2 Siemens A&D Mall: Customer login http://mall.automation.siemens.com/ 
3 Download server http://software-download.automation.siemens.com 

http://www.siemens.com/automation/license
http://mall.automation.siemens.com
http://software-download.automation.siemens.com
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Fundamentals 18
18.1 Basic information on SINAMICS S120 

Reference 

18.1.1 Rules for wiring the DRIVE-CLiQ interface 

Introduction 
When wiring components with DRIVE CLiQ, the following rules apply: The rules are 
subdivided into obligatory rules, which must be observed, and optional rules, which enable 
automatic topology detection if they are adhered to. 

Obligatory rules: 
● A maximum of 198 DRIVE-CLiQ node components can be connected for each NCU. 
● Up to 16 nodes can be connected to a DRIVE-CLiQ socket. 
● A maximum of 7 nodes can be connected in one row. A row is always considered from 

the perspective of the closed-loop control module. 
● Ring wiring is not permitted. 
● Components must not be double-wired. 

Optional rules: 
If you follow the optional rules for wiring DRIVE-CLiQ, the components associated with the 
encoder are automatically assigned to the drives (see figure below) if commissioning is 
performed via macro 150xxx. 
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Figure 18-1 Optional rules 

● For one motor module, the related motor encoder must also be connected. 
● Due to the improved performance utilization, use as many of the DRIVE-CLiQ points on 

the NCU as possible. 
● It is essential you comply with the optional rules when using the macro. This is the only 

way to achieve a proper assignment of the drive components. 
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18.1.2 Drive Objects (DO's) and Drive components 

Introduction 
The components that belong to the drive group are refelcted in the parameterization in a 
drive object. 
Each drive object has its own parameter list.  

General procedure 
The figure below uses the example of a SINAMICS S120 drive group to illustrate the 
meaning of the drive components and drive objects.  

Example 
Drive object 3 is made up of the components Single Motor Module (No. 3), Motor (No. 10), 
Encoder (No. 9) and SMC (No. 8). 
The component number is assigned by the drive after DRIVE-CLiQ topology recognition. 
The component number in each case can be viewed in the parameter list for the relevant 
drive object. E.g.: under operating area "Commissioning > Machine data > Drive MD > Axis 
+". 

Table 18- 1 Component numbers in the DO 3 

Parameter Name of the parameter 
p121 Component number of power module 
p131 Component number of motor 
p141 Component number of encoder interface 
P142 Component number of encoder 
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Figure 18-2 Drive group 
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18.1.3 BICO interconnection 

Introduction 
Each drive unit contains a large number of interconnectable input and output variables as 
well as internal control variables. 
BICO technology ( binector connector technology) allows the drive to be adapted to a wide 
variety of conditions. 
Digital and analog signals, which can be connected freely by means of BICO parameters, 
are identified by the prefix BI, BO, CI, or CO in their parameter name. 
These parameters are identified accordingly in the parameter list or in the function diagrams. 
There are: 
● Binectors (digital), with 

BI: binector input, BO: binector output 
● Connectors (analog), with  

CI: connector input, CO: connector output 

Interconnecting signals using BICO technology 
To interconnect two signals, a BICO input parameter (signal sink) must be assigned to the 
required BICO output parameter (signal source). 

Literature 
Commissioning Manual or List Manual for SINAMICS S120 Documentation 
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Visualization of BICO connections on the HMI   
Accessing the following menu allows you to perform a BICO connection of the SINAMICS 
drive group associated components. 
● "Commissioning" > "Drive system" > "Drives/Drive units" > "Connections" menu 

 
Figure 18-3 "Connections" menu  
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18.2 Transfer telegrams 

Introduction 
The transfer telegrams from NCK to the drive are transferred via an internal PROFIBUS on 
the NCU. They are: 
● Send telegrams (drive->NCK) 
● Receive telegrams (drive->NCK) 

Telegrams 
The telegrams are standard telegrams with pre-defined assignment of the process data. 
These telelgrams are interconnected in the drive object using BICO technology. 
The drive objects that can exchange process data include the following: 
1. Active line module (A_INF) 
2. Basic line module (B_INF) 
3. Motor module (SERVO) 
4. Control unit (CU) 
The order of the drive objects in the telegram is displayed on the drive page via the 
parameter list in the "Commissioning" > "Machine data" > "Control Unit MD" operating area 
in p978[0...15] and may also be changed through it. 

Literature 
SINAMICS S120 Commissioning Manual 

Receive words/send words 
By selecting a telegram via p922 of the related drive object (operating 
area  "Commissioning" > "Machine data" > "Drive MD"), the process data is determined 
which is transferred between the master and slave. 
From the perspective of the slave, the received process data comprises the receive words 
and the process data to be sent the send words. 
The receive and send words are comprised of the following elements: 
● Receive words: Control words or setpoints 
● Send words: Status words or actual values 



Fundamentals  
18.2 Transfer telegrams 

 IBN CNC: NCK, PLC, drive 
342 Commissioning Manual, 03/2009, 6FC5397-2AP10-5BA0 

Message frame types 
The message frame length for communication with the drive must be defined in the hardware 
configuration. The message frame length to be chosen depends on the axis functions 
required, e.g., the number of encoders or DSC, or the functions in the drive used. 

 

 Note 
If you change the message frame length of a drive component in HW config, you also must 
adjust the selection of the message frame type in the configuration of the interface in the 
NCK. 

 

What types of message frames are available? 
● Standard telegrams  

The standard telegrams are structured in accordance with the PROFIdrive Profile V3.1. 
The internal process data links are set up automatically in accordance with the message 
frame number setting. 

● Manufacturer-specific telegrams  
The manufacturer-specific telegrams are structured in accordance with internal company 
specifications. The internal process data links are set up automatically in accordance with 
the message frame number setting. 
The following vendor-specific telegrams can be set via p0922: 
– For axes (SERVO) 

116 DSC with torque reduction, 2 position encoders, supplementary data (also 
parameterization) 

– For axes (SERVO) 
118 DSC with torque reduction, 2 independent position encoders per axis, 
supplementary data (also parameterization) 

– For Control Unit 
390 telegram without probe (for NX) 
391 message frame for up to 2 probes (for NCU) 
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18.2.1 Structure of the telegram with the process data for SINUMERIK 840D sl 

Introduction 
SINUMERIK 840D sl uses the following preferred message frame types: 
● For axes 

116 DSC with torque reduction, 2 position encoders, supplementary data (also 
parameterization) 

● For NX 
390 message frame without probe (NX) 

● For NCU 
391 message frame for up to 2 probes (only valid for NCU) 

 

 
 

Note 
The telegram types 116, 390 and 391 are preset by default via HW Config. It is 
recommended not to change these.  

 

Telegrams for receiving   
The following table contains the structure of the telegrams with the process data for receiving 
the control words and setpoints (NCK->drive). 

Table 18- 2 Telegrams with the process data for receiving (NCK->drive) 

PZD receive word Message frame 116 Message frame 118 Message frame 390 Message frame 391 
PZD 1 STW1 STW1 STW1 STW1 
PZD2 NSET_B Digital outputs Digital outputs 
PZD 3  

NSET_B 
 STW_PROBES 

PZD 4 STW2 STW2   
PZD 5 M_RED M_RED   
PZD 6 G1_STW G2_STW   
PZD 7 G2_STW G3_STW   
PZD 8 XERR   
PZD 9  

XERR 
  

PZD 10 KPC   
PZD 11  

KPC 
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Telegrams for sending  
The following table contains the structure of the telegrams with the process data for sending 
the status words and actual values (drive->NCK). 

Table 18- 3 Telegrams with the process data for sending (drive->NCK) 

PZD sending word Message frame 116 Message frame 118 Message frame 390 Message frame 391 
PZD 1 ZSW1 ZSW1 ZSW1 ZSW1 
PZD2 NACT_B Digital inputs Digital inputs 
PZD 3  

NACT_B 
 ZSW_PROBES 

PZD 4 ZSW2 ZSW2  TIMESTAMP_PROBE
_1N 

PZD 5 MELDW MELDW  TIMESTAMP_PROBE
_1P 

PZD 6 G1_ZSW G2_ZSW  TIMESTAMP_PROBE
_2N 

PZD 7 G1_XIST1  TIMESTAMP_PROBE
_2P 

PZD 8  

G2_XIST1 

  
PZD 9 G1_XACT2   
PZD 10   

G2_XACT2 
  

PZD 11 G2_ZSW G3_ZSW   
PZD 12 G2_XACT1   
PZD 13  

G3_XACT1 
  

PZD 14 G2_XACT2   
PZD 15  

G3_XACT2 
  

PZD 16 LOAD LOAD   
PZD 17 TORQUE TORQUE   
PZD 18 POWER POWER   
PZD 19 CURR CURR   
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18.2.2 Process data for receiving and sending 

Process data for receiving  
The process data for the control words and setpoints are interconnected in the receive 
buffer. 

Overview of control words and setpoints 
The table below provides an overview of the process data that are interconnected as target 
at the receive buffer. 

Literature 
SINAMICS S120 Commissioning Manual 
 
Abbreviation Name 
STW1  Control word 1 
STW2  Control word 2 
NSET_A  Speed setpoint A (16-bit) 
NSET_B  Speed setpoint B (32-bit) 
G1_STW  Encoder 1 control word 
G2_STW  Encoder 2 control word 
G3_STW  Encoder 3 control word 
XERR  Positional deviation 
KPC  Positon controller gain factor 
M_RED  Torque reduction 
A_CSW1  Control word for A_INF/B_INF (infeed) 
STW_PROBES Control word probes 

 
 

 Note 
The drive signals are interconnected to the PZD automatically when a telegram type is 
allocated (parameter p922). 
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Process data for sending  
The process data for the control words and setpoints are interconnected in the send buffer. 

Overview of status words and actual values 
The table below provides an overview of the process data that are interconnected as source 
at the transmit buffer. 

Literature 
SINAMICS S120 Commissioning Manual 
 
Abbreviation Name 
ZSW1 Status word 1 
ZSW2 Status word 2 
NACT_A Speed setpoint A (16 bit) 
NACT_B Speed setpoint B (32 bit) 
G1_ZSW Encoder 1 status word 
G1_XIST1 Encoder 1 actual position value 1 
G1_XIST2 Encoder 1 actual position value 2 
G2_ZSW Encoder 2 status word 
G2_XIST1 Encoder 2 actual position value 1 
G2_XIST2 Encoder 2 actual position value 2 
G3_ZSW Encoder 3 status word 
G3_XIST1 Encoder 3 actual position value 1 
G3_XIST2 Encoder 3 actual position value 2 
MELDW Message word 
A_ZSW1 Status word for A_INFEED 
LOAD Drive load 
TORQUE Drive torque setpoint 
POWER Drive efficiency 
CURR Drive actual current 
ZWS_PROBES Status word probe 
TIMESTAMP_PROBE_1N Time stamp probe 1 falling edge 
TIMESTAMP_PROBE_1P Time stamp probe 1 rising edge 
TIMESTAMP_PROBE_2N Time stamp probe 2 falling edge 
TIMESTAMP_PROBE_2P Time stamp probe 2 rising edge 
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18.3 Control- and status-word bits for NCK<->drive communication 

18.3.1 NCK to drive 

Introduction 
The NCK transfers data to the drive using message frames via a PROFIBUS interface 
(internal PROFIBUS). Setpoints exist for speed control and torque and are preceded by a 
control word in the message frame. 

PLC interface for STW1 
 
Signal provided by NCK VDI interface 

(PLC) 
Remarks Bit in 

STW1 
Meaning 

Axis controllable from NCK: 
• Servo enable 
• Measuring system selected 

and OK 
• Pulse enable 
• … 

DB(AX).DBX2.1 
DB(AX).DBX1.5/6
DB(AX).DBX21.7 

 0 OFF1 

Always "1", "TRUE" No signal  1 OFF2 
Always "1", "TRUE" No signal  2 OFF3 
VDI signal pulse enable DB(AX).DBX21.7  3 Enable inverter 
RFGIS DB(AX).DBX20.1  4 Ramp-function generator 

enable 
RFGIS DB(AX).DBX20.1  5 Ramp-function generator 

Start 
  NCK controlled parallel to 

STW1 bit0 
6 Setpoint enable 

(DriveReset) is generated by: 
• "RESET signal" or CANCEL 

KEY, if a simultaneous drive 
fault is present (ZSW1.bit3 or 
ZSW1.bit6) 

No signal Signal "OFF1" is 
automatically set to 
FALSE internally, 
simultaneously to 
"DriveReset" (user must 
NOT manipulate the servo 
enable separately!). 

7 Reset fault memory 

Selection of NC function 
generator (via PI service from 
HMI) 

No signal The user cannot influence 
the function generator 
selection via the VDI 
interface. 

8 Activate function generator 

Always "0", "FALSE" No signal Signal not used 9 Reserved 
Is "1", "TRUE", if the NC can 
control the associated drive AND 
the drive itself requests that 
control (ZSW1.bit9) 

No signal  10 Control from the PLC 

Always "0", "FALSE" No signal Signal not used 11 Reserved 
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Signal provided by NCK VDI interface 
(PLC) 

Remarks Bit in 
STW1 

Meaning 

"Release holding brake" DB(AX).DBX20.5  12 Open holding brake 
Always "1", "TRUE" No signal Signal is used as the 

identifier to shut down the 
drive's ramp-function 
generator (isochronous 
Profibus drive) 

13 Ramp-up time zero for 
controller enable 

Always "1", "FALSE" No signal Signal not used 14 Open-loop torque-
controlled mode 

Customer-specific signal No signal for 
SINAMICS 

 15 Signal not used in 
conjunction with 
SINUMERIK, no 
PROFIDRIVE standard 
signal 
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PLC interface for STW2 
 
Signal provided by NCK VDI interface (PLC) Remarks Bit in 

STW2 
Meaning 

DB(AX).DBX21.0 Bit A 0 Parameter-set switchover, 
bit0 

DB(AX).DBX21.1 Bit B 1 Parameter-set switchover, 
bit1 

Drive-parameter-set switchover 

DB(AX).DBX21.2 Bit C 2 Parameter-set switchover, 
bit2 

1. Speed setpoint filter DB(AX).DBX20.3 Not used for 
SINUMERIK or 
SINAMICS 
(ineffective) 

3 1. Speed setpoint filter 

Ramp-function generator disable DB(AX).DBX20.4 Not used for 
SINUMERIK or 
SINAMICS 
(ineffective) 

4 Ramp-function gen. 
inactive 

Always "FALSE"  not used 5 Reserved 
Integrator inhibit, speed controller DB(AX).DBX21.6  6 Integrator inhibit, speed 

controller 
Selection of "parking axis" by 
shutting down the encoder bit on 
the VDI interface 

DB(AX).DBX1.5 = 
FALSE & 
DB(AX).DBX1.6 = 
FALSE 

 7 Selection of "parking axis" 

Traversing to fixed endstop No signal Drive fault "speed 
controller at limit" 
deactivated 

8 Suppress fault 608, 
"speed controller at limit" 

DB(AX).DBX21.3 Bit A 9 Motor changeover, bit0 Motor changeover/selection 
DB(AX).DBX21.4 Bit B 10 Motor changeover, bit1 

Motor selection in progress DB(AX).DBX21.5  11 Motor selection in 
progress 

 12 
 13 
 14 

Master sign-of-life No signal 

 15 

Master sign-of-life 

18.3.2 Drive to NCK 

Introduction 
The drive transfers the data to the NCK using message frames via a PROFIBUS interface 
(internal PROFIBUS). Actual values exist for the speed control and torque and are preceded 
by a status word in the message frame. 
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PLC interface for ZSW1 
 
Meaning Bit in 

ZSW1 
Remarks VDI interface (PLC) Signal processing in the NCK 

Ready to start 0  No signal  
Ready-to-operate/no fault 1  No signal  
Status, controller enable 2 For a combination Bit2 

from ZSW1 = 0 and 
simultaneously 
Bit11 from the MedW = 
1, 
the drive is in 
autonomous drive 
status. 

DB(AX).DBX92.4  

Fault active 3  No signal Alarm 25201/25202, is used to 
activate error deletion on the 
NCK. 

No OFF2 pending. 4  No signal Not used 
No OFF3 is active 5  No signal Not used 
Power-on inhibit 6  No signal Used on the NCK to generate 

the "Acknowledge fault 
memory" signal. 

Warning present 7  No signal No evaluation 
nset = nact 8  No signal No evaluation 
Control from the PLC 9 Signal is primarily set 

by the drive. 
No signal The NCK itself then sets the 

associated STW1.bit9, if the 
drive in the NC is known to be 
"operational" and "ready" (e.g., 
bus booted, etc.). 

Comparison value reached 10  No signal No evaluation 
Reserved 11  No signal No evaluation 
Reserved 12  No signal No evaluation 
Function generator active 13  DB(AX).DBX61.0 Drive test "travel request" 
Only used in "positioning 
mode": Open-loop torque-
controlled mode 

14 Irrelevant for 
SINUMERIK 

No signal No evaluation 

Only used in "positioning 
mode": Spindle positioning ON 

15 Irrelevant for 
SINUMERIK 

No signal No evaluation 
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PLC interface for ZSW21 
 
Meaning Bit in 

ZSW2
1 

Remarks VDI interface (PLC) Signal processing in the NCK 

0 Bit A DB(AX).DBX93.0 
1 Bit B DB(AX).DBX93.1 

Parameter set 

2 Bit C DB(AX).DBX93.2 

active drive parameter set 

1. speed-setpoint filter inactive 3 Signal from SINAMICS 
not operated 

DB(AX).DBX92.3 As signal from SINAMICS not 
operated: Signal always "0", 
"FALSE" 

Ramp-function gen. inactive 4  DB(AX).DBX92.1 Ramp-function-generator 
disable active 

Holding brake open 5  DB(AX).DBX92.5 Holding brake open 
Integrator inhibit, speed 
controller 

6  DB(AX).DBX93.6 Speed controller integrator 
disabled 

Status: Parking axis 7 Axis parked via 
SINAMICS 

No signal NCK cannot respond to the 
"axis parked" state => alarm 
25000, 
An alarm is output if the drive 
parks even though parking was 
not requested.  

Suppress "speed controller at 
limit" fault 

8  No signal  

9 Bit A DB(AX).DBX93.3 Motor data set  
10 Bit B DB(AX).DBX93.4 

Active motor 

Motor being changed over 11  No signal  
12  
13  
14  

Slave sign-of-life 

15  

No signal Drive sign-of-life 
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PLC interface for signalW 
 
Meaning Bit in 

signal
W 

Remarks VDI interface (PLC) Signal processing in the NCK 

Ramp-up function completed 0  DB(AX).DBX94.2 Ramp-up function completed 
M<Mx 1  DB(AX).DBX94.3 M<Mx 
Nact<Nmin 2  DB(AX).DBX94.4 Nact<Nmin 
Nact<Nx 3  DB(AX).DBX94.5 Nact<Nx 
DC link overvoltage 4  DB(AX).DBX95.0 Signal not available for 

SINAMICS 120! 
Variable signaling function 5  DB(AX).DBX94.7 Signal not available for 

SINAMICS 120! 
Motor temperature pre-
warning 

6  DB(AX).DBX94.0 Motor temperature pre-warning 

Heatsink-temperature 
prewarning 

7  DB(AX).DBX94.1 Heatsink-temperature 
prewarning 

Nsetp=Nact 8  DB(AX).DBX94.6  
Reserved 9  No signal No evaluation 
Power module current not 
limited 

10  DB(AX).DBX95.7 Signal not available for 
SINAMICS 120! 

Reserved 11 Speed controller active DB(AX).DBX61.6& 
DB(AX).DBX61.7 

 

Reserved 12 Drive Ready DB(AX).DBX93.5  
Pulses enabled 13 Only for SINAMICS 

S120 with message-
frame types 101ff direct 
on VDI interface 

DB(AX).DBX93.7  

Reserved 14 Only in conjunction with 
positioning mode, 
irrelevant for 
SINUMERIK 

No signal No evaluation 

Reserved 15 Only in conjunction with 
positioning mode, 
irrelevant for 
SINUMERIK 

No signal No evaluation 
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18.4 PLC program 

Introduction 
The PLC program is constructed modularly. It comprises the two parts: 
● PLC basic program 

The PLC basic program organizes the exchange of signals and data between the PLC 
user program and the NCK, HMI, and machine control panel components. The PLC basic 
program is a part of the tool box delivered with the SINUMERIK 840D sl. 

● PLC user program 
The PLC user program is the user-specific part of the PLC program by which the basic 
PLC program has been added to or extended. 

PLC basic program 
For a complete description of the basic PLC program, its structure and all modules including 
their call parameters, please refer to: 

Literature 
Function Manual Basic Functions; Basic PLC Program 

PLC user program 
The organization blocks of the basic machine contain the entry points for the appropriate 
parts of the PLC user program. 
● OB100 (cold restart) 
● OB1 (cyclic processing) 
● OB40 (process alarm) 
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The following diagram shows the structure of the PLC program: 

 

Figure 18-4 PLC program structure 

PLC status 
The PLC always starts up in RESTART mode, i.e. the PLC operating system runs OB100 
after initialization and starts cyclic operation at the beginning of OB1. There is no re-entry at 
the point of interruption (e.g. on power failure). 
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Start-up behavior of the PLC 
There are both remanent and non-remanent areas for the markers, times and counter. The 
areas are continuous and are divided by a parameterizable limit, where the area with the 
higher-value address range is defined as the non-remanent area. Data blocks are always 
remanent. 

Start-up mode COLD RESTART (OB 100) 
If the remanent area has no battery backup (backup battery is empty) start-up is prevented. 
The following operations are performed during a cold restart: 
● UStack, BStack and non-retentive flags, timers and counters are deleted 
● The process output image (POI) is deleted 
● Process and diagnostics alarms are cancelled 
● The system status list is updated 
● Parameterization objects of modules (from SD100 onwards) are evaluated or default 

parameters are output to all modules in single-processor mode 
● Execute cold restart (OB100) 
● Read in process input image (PII) 
● Cancel command ouptput inhibit (BASP) 

Basic program, start-up part (FB1) 
FB 1 (start-up block of the PLC program) must be assigned variables.  

Parameter FB 1 
A precise description of the variables and options for modifying their parameterization is 
given in: 

Literature 
Function Manual Basic Functions; Basic PLC Program 

Cyclical mode (OB 1) 
From a chronological viewpoint, the basic program runs ahead of the PLC user program. 
The complete processing of the NCKPLC interface is carried out in cyclic mode.  
A cyclic monitoring function is activated between PLC and NCK once power-up and the first 
OB1 cycle have been completed. A PLC failure produces alarm ”2000 Sign-of-life monitoring 
PLC”. 

See also 
Creating a PLC program (Page 55) 
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18.4.1 Fundamentals of creating a PLC user program 

Introduction 
The following points must be observed when creating a PLC user program: 
● Software and hardware prerequisites 
● Installing the toolbox (PLC basic program, slave OEM, GSD files) 
● Editing the blocks in the PLC basic program 

Software and hardware requirements 
● SIMATIC STEP 7 as from Version 5.3, Service Pack 3 
● SIMATIC STEP 7 is installed on the PG/PC 

Installing the PLC basic program library 
To be able to use the blocks of the basic PLC program (OBs, FBs, DBs, etc.) in a SIMATIC 
S7 project, the library must first be installed in the SIMATIC manager.  

Editing the blocks in the PLC basic program 
The individual blocks in the basic PLC program can be processed as follows in the SIMATIC 
manager: 
● Select the appropriate block, e.g. OB 100 in the folder Blocks of the corresponding 

Module 
● Use the "Edit" > "Open object" menu command to open the block or double-click the 

block with the left mouse button 
● Edit the block using the LAD/STL/CSF editor. Switch over to the block display using the 

"View" > "LAD" or STL or CSF menu command 

See also 
Creating a PLC program (Page 55) 
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18.5 Machine and setting data 

Introduction 
Adaption of the control at the machine is carried out using the machine and setting data. 

Parameter assignment 
● Machine data 

The machine data (MD) are divided into the following areas: 
– General machine data 
– Channel-specific machine data 
– Axis-specific machine data 
– Machine data for control unit 
– Machine data for infeed 
– Machine data for drives 

● Setting data 
The setting data (SD) are divided into the following areas: 
– General setting data 
– Channel-specific setting data 
– Axis-specific setting data 

● Option data 
For enabling options. The option data are included in the scope of delivery. 
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Overview of machine and setting data 
The table below lists the areas for machine and setting data. The List Manual contains a 
detailed description. 

Table 18- 4 Overview of machine and setting data 

Range Name 
from 1000 to 1799 Machine data for drives ($MD_...) 
from 9000 to 9999 Machine data for operator panel front ($MM_....) 
from 10000 to 18999 General machine data ($MN_...) 
from 19000 to 19999 Reserved 
from 20000 to 28999 Channel-specific machine data ($MC_...) 
from 29000 to 29999 Reserved 
from 30000 to 38999 Axis-specific machine data ($MA_...) 
from 39000 to 39999 Reserved 
from 41000 to 41999 General setting data ($SN_...) 
from 42000 to 42999 Channel-specific setting data ($SC_...) 
from 43000 to 43999 Axis-specific setting data ($SA_...) 
from 51000 to 61999 General machine data for compile cycles 
from 62000 to 62999 Channel-specific machine data for compile cycles 
from 63000 to 63999 Axis-specific machine data for compile cycles 

See also 
Overview Commissioning NCK (Page 109) 
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18.5.1 Machine data fundamentals 

Introduction 
Machine and setting data are parameterized via:  
● Number and identifier 
● Activation 
● Protection levels 
● Unit 
● Default value 
● Value range (minimum and maximum) 

Number and identifier 
Machine data and setting data are identified using the number or the name (identifier). The 
number and name are displayed at the HMI. 
The identifier of a machine data is subject to the scheme: 
● $ M k _IdentifierString 

where the following applies: 
– $System variable 
– MMachine data 
– kComponent 

k identifies the components of the NC parameterizing the appropriate machine data: 
– NNC 
– CChannel 
– AAxis 

The identifier of a setting data is subject to the scheme: 
● $ S k _IdentifierString 

where the following applies: 
– $ System variable 
– SSetting data 
– k Component 

k identifies the components of the NC parameterizing the appropriate machine data: 
– N NC 
– CChannel 
– AAxis 
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Activation 
Activation when referring to a machine data indicates the NC status in which a change to a 
machine data becomes active.  
The levels of effectiveness have been listed below in order of priority. Modification of the 
machine data takes effect after: 
● POWER ON (po) NCK RESET 
● NEWCONF (cf) 

– "Set MD to active" softkey on MMC 
– <RESET> key on the MSTT 
– It is possible to modify block limits during program operation 

● RESET (re) 
– at end of program M2/M30 or 
–  <RESET> key on the MSTT 

● IMMEDIATE (so) 
– After entry of value 

 

 
 

Note 
Unlike machine data, changes to setting data always become effective immediately. 

 

Protection levels 
Access level 4 (keyswitch position 3) or more is required to display machine data. 
To start up the system, the appropriate protection level must generally be enabled by 
entering the password "EVENING". 

Unit 
The unit refers to the standard setting of the machine data: 
● MD10220 $MN_SCALING_FACTOR_USER_DEF_MASK 
● MD10230 $MN_SCALING_FACTOR_USER_DEF 
● MD10240 $MN_SCALING_SYSTEM_IS_METRIC = 1. 
If the machine data is not based on an engineering unit, then the field is marked with "-". 
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Default value 
The machine data/setting data is preset to this value. 

 

 Note 
Inputs via HMI are limited to ten digits plus comma and sign. 

 

Value range (minimum and maximum) 
Specifies the input limits. If no range of values is specified, the data type determines the 
input limits and the field is marked with "∗∗∗". 

18.5.2 Handling the machine data 

Introduction 
To display and input machine data, appropriate screen forms are provided.  

Example 
Selection of displays: 
When you press the <Area switchover> key on the HMI, the menu bar appears with the 
following areas: "Machine", "Parameter", "Program", "Services", "Diagnostics" and 
"Commissioning". Press "Commissioning" > "Machine data". 

 

 Note 
For the input of machine data, the protection level 2 password "EVENING" has to be set at 
the least. 

 

Screen editor for HEX machine data 
A bit editor has been implemented to simplify the matter of setting certain machine data bits. 
If the input cursor is on a machine data in HEX format in the MD list, you can call up the bit 
editor by pressing the <Toggle> key (in the middle of the cursor keys). 
You can set or reset single bits by clicking on them with the mouse or by selecting them with 
the cursor keys and then pressing the <Toggle> key. 
● With the "Ok" softkey, you can terminate the bit editor and accept the value set. 
● With the "Abort" softkey, you can reject the bit editor and accept the value set. The 

previous setting is then valid again. 
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18.6 Protection levels 

Introduction 
Access to programs, data and functions is useroriented and controlled via eight hierarchical 
protection levels. These are divided into 
● 4 password levels for Siemens, machine manufacturer, start-up personnel, and end user 
● 4 key switch positions for end user 

Protection levels 
There are protection levels 0 to 7 (see table below), where 
● 0 is the highest and 
● 7 is the lowest level. 

Table 18- 5 Protection level concept 

Protection level Locked by Range 
0 Password Siemens 
1 Password: SUNRISE (default) Machine manufacturer 
2 Password: EVENING (default)  Installation engineer, service 
3 Password: CUSTOMER (default) End user 
4 Key switch position 3 Programmer, machine setter 
5 Key switch position 2 Qualified operator 
6 Key switch position 1 Trained operator 
7 Key switch position 0 Semi-skilled operator 
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Interlock 
Protection levels 
● 0 to 3 are locked by means of a password and 
● 4 to 7 by means of keyswitch positions (see table below). 

Table 18- 6 Keyswitch settings 

Keyswitch  
setting 

Retraction pos. NC password level User group 

 

 

0 or 1 or 2 or 3  
Red key 

4 
(highest access level) 

Programmer, machine 
setter 

 

 

0 or 1 or 2 
Green key 

5 
(increasing access rights) 

 
Qualified operator 

 

 

0 or 1 
Black key 

6 
(increasing access rights) 

 
Trained operator 

 

 

- 7 
(lowest access level) 

 
Semi-skilled operator 

Protection levels for machine data 
The machine data is assigned different protection levels by default. 
Access level 4 (keyswitch position 3) or more is required to display machine data. 

 

 Note 
To start up the system the appropriate access level must generally be enabled by entering 
the password "EVENING". 

 

You can find additional change options of protection levels at: 

Literature 
Function Manual Basic Functions; Diverse Interface Signals 
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18.6.1 Protection level fundamentals 

Introduction 
You can influence the protection levels used with passwords via softkeys.  
Press the "HMI" -> "Password" softkey in the “Startup” operating area. The following softkeys 
are available: 
● Setting the password 
● Change password 
● Delete password 

Set password 
1. Press the softkey "Set password." The "Please enter password:" input window appears. 
2. Enter one of the possible default passwords (see table "Protection levels concept") and 

confirm the entry with the softkey "OK." A permissible password is set and the valid 
access level is displayed. Invalid passwords will be rejected. 

Change password 
For secure access protection, you should change the default passwords 
1. Press the "Change password" softkey. The current access level is displayed in the 

window that opens. 
2. Mark the area for which you would like to assign the new password. You can select the 

following areas here: 
– System 
– Vendor 
– Service 
– User 

3. Enter the new password in the input fields "New password" and "Repeat password." 
4. Confirm the entry with the softkey "OK." Both entered passwords must match for the 

modified password to become valid. 
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Delete password 
1. Press the softkey "Delete password" in order to reset the access authorization. 
Access authorization is not automatically deleted at POWER ON! 

 

NOTICE  
For a system boot in which standard machine data is loaded, the passwords are set to the 
default values. 
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18.7 Axis data 

Introduction 
The term "axis" is often used either as a single term in conjunction with SINUMERIK 840D sl 
or in compounded form, e.g. machine axis, channel axis, etc. To provide an overview of the 
philosophy used as the basis, here is a brief explanation of this term. 

Definition 
Generally, 4 types of axes are distinguished: 
1. Machine axes 
2. Channel axes 
3. Geometry axes 
4. Special axes 

Machine axes 
Machine axes are the motion units existing on a machine, which can also be designated as 
linear or rotary axes, depending on their usable movement. 

Channel axes 
The total of all machine, geometry and special axes assigned to a channel is designated as 
channel axes. 
In this context, the geometry and special axes constitute the program-technological part of 
the machining process, i.e. they are used for programming in the parts program. 
The machine axes constitute the physical part of the machining process, i.e. they carry out 
the programmed traversing movements on the machine. 

Geometry axes 
The geometry axes constitute the rectangular Cartesian basic coordinate system of a 
channel. 
Generally, (Cartesian arrangement of the machine axes) direct imaging of the geometry axes 
to the machine axes is possible. If the arrangement of the machine axes, however, is not 
Cartesian at right angles, the imaging is performed using a kinematic transformation. 

Special axes 
Additional axes are all other channel axes that are not geometry axes. Unlike for geometry 
axes (Cartesian coordinate system), no geometric context is defined for additional axes, 
neither between additional axes or with respect to geometry axes. 

Literature 
Function Manual Basic Functions; Axes, Coordinate Systems, Frames, Workpiece numbers 
IWS: Axes 
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18.7.1 Axis configuration 

Introduction 
The figure below shows the assignment between the geometry axes, special axes, channel 
axes and machine axes as well as the names of the individual axis types. MD are used for 
assignment.   

 
Figure 18-5 Axis configuration 
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 Note 
Leading zeroes in user-defined axis identifiers are ignored. 
Example: 
MD10000 $MN_AXCONF_MACHAX_NAME_TAB[0] = X01 corresponds to X1  
The geometry axes must be assigned to the channel axes in ascending order leaving no 
gaps. 

 

Special features 
● Three geometry axes are assigned to the channel axes in the MD. 
● All channel axes that are not assigned to the three geometry axes are special axes. 
● The channel axes are assigned to machine axes. 
● The spindles are also assigned to machine axes. 

Channel axis gaps 
Channel axes need not be defined contiguously in ascending order, in other words, not each 
channel axis needs to have a machine axis assigned to it (local or link axis). The assignment 
occurs as follows: 
● MD20080 $MC_AXCONF_CHANAX_NAME_TAB 

via: 
● MD20070 $MC_AXCONF_MACHAX_USED 

Application:      
Consistent, semidefined channel axes for various machine versions of a manufacturer's 
machine series. 
Advantages: 
● Uniform basic configuration of various machines 
● Simple reconfiguration on removal of a machine 
● Portability of programs 



 Fundamentals 
 18.7 Axis data 

IBN CNC: NCK, PLC, drive 
Commissioning Manual, 03/2009, 6FC5397-2AP10-5BA0 369 

Reliability of channel axis gaps 
Channel axis gaps must be disconnected via the machine data: 
● MD11640 $MN_ENABLE_CHAN_AX_GAP = 1 (channel axis gap allowed). 
 If this is not carried out, an entry of 0 in the machine data 
MD20070 $MC_AXCONF_MACHAX_USED 
prevents other machine axes being assigned to channel axes.    

Literature 
Function Manual, Expanded Functions; Several Control Panels on Multiple NCUs, 
Decentralized Systems 

Example 

 
Figure 18-6 Axis configuration with channel axis gap 
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 Note 
The gaps count as axes with reference to the number of channel axes and their indices. 
If an attempt is made to define a channel axis gap on the geo axis via the machine data 
MD20050 $MC_AXCONF_GEOAX_ASSIGN_TAB 
, the attempt is 
rejected without an alarm.   
Using channel axes in  
MD24120ff.  $MC_TRAFO_GEOAX_ASSIGN_TAB1...8 
and 
MD24110ff.  $MC_TRAFO_AXES_IN1...8 , to which no machine axes are defined using  
MD20070 $MC_AXCONF_MACHAX_USED (gap), 
triggers alarms 4346 or 4347.     

 

18.7.2 Axis assignment 

Introduction 
The assignment of machine, channel and geometry axes is carried out using the relevant 
machine data. 

Axis assignment 
The following diagram illustrates the assignment of the relevant machine data: 
● Machine axes of the NC 
● Channel axes of the channel 
● Geometry axes of the channel 
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Figure 18-7 Axis assignment 

 
(1) The I/O addresses of the drives defined in the S7 project using "HW Config" are 

contained in the following machine data. 
MD13050 $MN_DRIVE_LOGIC_ADDRESS[n] (I/O address of the drive) 
The machine data index (n+1) is the logical drive number for the NC. 

(2) Te following machine data are used to assign each individual machine axis to a 
drive. 
MD30110 $MA_CTRLOUT_MODULE_NR[0] (setpoint assignment) 
MD30220 $MA_ENC_MODULE_NR[0] (actual value assignment) 
The logical drive number m to be entered in the two machine data refers to the entry 
with the index n=(m-1) in the list described under Point 1 MD13050 
$MN_DRIVE_LOGIC_ADDRESS[n]. 
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(3) Which channel axis uses which machine axis (explicite) and how many channel 
axes are present in the channel (implicite) is detemined through the following 
machine date: 
MD20070 $MC_AXCONF_MACHAX_USED[n] (machine axis number valid in 
channel) 
The machine axis number m to be entered in the machine data (with m=1,2,3...) is 
referred to the appropriate machine axis m. 

(4) Which channel axis uses which machine axis (explicitly) and how many channel 
axes can be implicitly available in a channel is defined by the following machine 
data: 
MD20050 $MC_AXCONF_GEOAX_ASSIGN_TAB[n] (assignment geometry axis - 
channel axis) (n = 0...2)  
The channel axis number k to be entered in the machine data (k=1,2,3...) refers to 
the entry with the index n (n=(k-1)=0,1,2...) in the list of the channel axes MD20070 
$MC_AXCONFIG_MACHAX_USED[n] (see Point 3) 

Machine data 
The following machine data are relevant for the axis configuration: 

Table 18- 7 Axis configuration: Machine data 

Number Name of identifier Name / remarks 
General ($MN_ ... ) 
13050 DRIVE_LOGIC_ADDRESS I/O address of drive 
Channelspecific ($MC_ ... ) 
20050 AXCONF_GEOAX_ASSIGN_TAB Assignment of geometry axis to 

channel axis 
20070 AXCONF_MACHAX_USED Machine axis number valid in 

channel 
Axisspecific ($MA_ ... ) 
30110 CTRLOUT_MODULE_NR Setpoint assignment 
30220 ENC_MODULE_NR Actual-value assignment 
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18.7.3 Axis names 

Introduction 
Each machine, channel and geometry axis can/must be assigned an individual name 
unambiguously identifying it in its name range. 

Machine axes 
The name of the machine axes are defined via the following machine date: 
MD10000 $MN_AXCONF_MACHAX_NAME _TAB [n] (machine axis name) 
Machine axis names must be unambiguous for the entire NC. 
The names and the corresponding index defined in the machine date above is used for: 
● Accessing axis-specific machine data (loading, saving, displaying) 
● Reference point approach from the parts program G74 
● Measuring 
● Test point traversing from the parts program G75 
● Traversing the machine axis from PLC 
● Display of axis-specific alarms 
● Display in the actual-value system (machine-related) 
● DRF handwheel function 

Channel axes 
The name of the channel axes are defined via the following machine date: 
MD20080 $MC_AXCONF_CHANAX_NAME_TAB[n] (name of the channel axis in the 
channel) 
Channel axis names must be unambiguous for the entire channel. 
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Geometry axes 
The name of the geometry axes are defined via the following machine data: 
MD20060 $MC_AXCONF_GEOAX_NAME_TAB [n] (geometry axis in the channel) 
Geometry axis names must be unambiguous for the entire channel. 
The axis names for channel and geometry axes are used in the parts program for 
programming general traversing movements or to describe the workpiece contour. The axis 
names are used for 
● Path axes 
● Synchronized axes 
● Positioning axes 
● Command axes 
● Spindles 
● Gantry axes 
● Coupled axes 
● Guide value coupling axes 

Machine data 
The following machine data are relevant for the axis names: 

Table 18- 8 Axis names: Machine data 

Number Identifier Name/remarks 
General ($MN_ ... ) 
10000 AXCONF_MACHAX_NAME_TAB Machine axis name 
Channelspecific ($MC_ ... ) 
20060 AXCONF_GEOAX_NAME_TAB Geometry axis name in channel 
20080 AXCONF_CHANAX_NAME_TAB Channel axis name/special axis 

name in channel 
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18.7.4 Setpoint/actual value channels 

Introduction 
The following points must be observed for setpoint/actual value channels: 

 

 Note 
In order to guarantee that the control runs up reliably, all machine axes are declared as 
simulation axes (without hardware). 
• MD30130 $MA_CTRLOUT_TYPE (output type of setpoint value) = 0 
• MD30240 $MA_ENC_TYPE (actual value acquisition mode) = 0 
Traversing of the axes in servo mode is simulated without speed setpoint output, and no 
hardware-specific alarms are output.    
Machine data 
• MD30350 $MA_SIMU_AX_VDI_OUTPUT (output of axis signals with simulation axes) 
can be used to select whether the interface signals of a simulation axis are output at the PLC 
interface (e.g. during program test, if there is no drive hardware, used in FC18 in PLC). 

 

Assignment of the setpoint/actual value channels 
For each machine axis to which a drive is assigned, the following parameters must be set:    
● a setpoint channel and 
● at least one actual-value channel 
A second actual-value channel can be set up as an option. 

 

NOTICE  
The motor measuring system is always used for the speed control function. Motor and 
motor measuring system must therefore always be connected to the same drive (SERVO). 

 

Index m to the MD13050 $MN_DRIVE_LOGC_ADRESS of the drive which represents the 
machine axis must be entered in the two axis-specific machine data: 
● MD30110 $MA_CTRLOUT_MODULE_NR[0] (setpoint assignment: logical drive number) 
● MD30220 $MA_ENC_MODUL_NR[n] (actual value assignment: logical drive number) 
The entered value m refers to the drive whose I/O address is defined under the index n = (m-
1) in MD13050 $MN_DRIVE_LOGIC_ADDRESS[n] (see "Drive configuration" section). 
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NCK Reset 
Once the drive configuration and setpoint/actual value assignment have been 
parameterized, an NCK reset must be executed to initiate a warm restart of the NC. After the 
NC has powered up, the set configuration is effective.   

Measuring system switchover 
The following interface signals can be used to switch between the two position measuring 
systems of a machine axis from the PLC.  
● DB31, ... DBX1.5 (position measuring system 1 selected) 
● DB31, ... DBX1.6 (position measuring system 2 selected) 

Literature 
Function Manual Basic Functions; Diverse Interface Signals 

Machine data 

Table 18- 9 Setpoint/actual value channels: Machine data 

Number Name of identifier Name/remarks Reference
Axisspecific ($MA_ ... ) 
30110 CTRLOUT_MODULE_NR Setpoint assignment: Logical drive number  
30130 CTRLOUT_TYPE Output of setpoint value 

0 = Simulation 
1 = Output of speed setpoint 

 

30200 NUM_ENCS Number of measuring channels 
1 = One position measuring system present 
2 = Two position measuring systems present 

 

30220 ENC_MODULE_NR[0] Actual value assignment: Logical drive number for 
position measuring system 1 

 

30220 ENC_MODULE_NR[1] Actual value assignment: Logical drive number for 
position measuring system 2 

 

30230 ENC_INPUT_NR[0] Actual value assignment: Position measuring 
system 1 
1 = G1_XIST encoder 1 actual position value 1 
2 = G2_XIST encoder 1 actual position value 2 

 

30230 ENC_INPUT_NR[1] Actual value assignment: Position measuring 
system 2 
1 = G1_XIST encoder 2 actual position value 1 
2 = G2_XIST encoder 2 actual position value 2 

 

30240 ENC_TYPE[0] Type of actual value recording 
0 = Simulation 
1 = Incremental encoder 
4 = Absolute encoder with EnDat interface 
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Interface signals 

Table 18- 10 Switchover of position measuring system: Interface signals 

DB number Bit, byte Name Reference
Axis/spindle-specific Signals from PLC to axis/spindle 
31, ... 1.5 Position measuring system 1  
31, ... 1.6 Position measuring system 2  

Literature 
Function Manual Basic Functions; 
Speeds, Setpoint/actual-value systems, Control: Setpoint/actual-value system 
Function Manual Basic Functions; 
Diverse Interface Signals: Interface signals to axis/spindle 
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18.8 Spindle data 

Introduction 
The spindle mode of a machine axis is a subset of the general axis functionality. For this 
reason, the machine data required to start up an axis have also to be set for a spindle. 
The machine data to parameterize a spindle are therefore to be found under the axis-specific 
machine data (from MD 35000 onwards). 

 

 Note 
After the default machine data have been loaded, no spindle is defined. 

 

Spindle definition 
With the following machine data, a machine axis is declared to be an endlessly rotating 
rotary axis whose programming and display is carried out modulo 360 degrees.  
● MD30300 $MA_IS_ROT_AX (rotary axis/spindle) 
● MD30310 $MA_ROT_IS_MODULO (modulo conversion for rotary axis/spindle) 
● MD30320 $MA_DISPLAY_IS_MODULO (modulo 360 degrees display for rotary 

axis/spindle) 
The machine axis is converted to a spindle by defining the spindle number x (with x = 1, 2, 
...max. number of channel axes) in machine data 
● MD35000 $MA_SPIND_ASSIGN_TO_MACHAX (spindle number) 
The spindle number must be unique within the channel axes of the channel to which the 
spindle is assigned.  
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18.8.1 Spindle modes 

Spindle modes   
The spindle can have the following modes: 
● Control mode 
● Oscillation mode 
● Positioning mode 
● Synchronous mode, synchronous spindle 

References: 
Function Manual, Extension Functions, Synchronous Spindle (S3) 

● Rigid tapping 
References: 
Programming Manual, Fundamentals; Chapter: Motion commands 

Axis mode 
The spindle can be switched from spindle mode to axis mode (rotary axis) if the same motor 
is used for spindle and axis operation. 
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18.8.2 Initial spindle state 

Initial spindle state 
The following machine data is used to specify a spindle mode as initial state: 
MD35020 $MA_SPIND_DEFAULT_MODE 
 
Value Initial spindle state 
0  Speed control mode, position control deselected 
1  Speed control mode, position control activated 
2  Positioning mode 
3  Axis mode 

Time when the initial spindle state takes effect 
The time when the initial spindle state takes effect is set in the machine data: 
MD35030 $MA_SPIND_DEFAULT_ACT_MASK 
 
Value Effective time 
0  POWER ON 
1  POWER ON and program start 
2  POWER ON and RESET (M2 / M30) 
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18.8.3 General functionality 

Why axis mode? 
For certain machining tasks (e.g. on lathes with end-face machining), the spindle not only 
has to be rotated with M3, M4 and M5 and positioned with SPOS, M19 and SPOSA, but also 
addressed as an axis with its axis identifier (e.g. "C"). 

Prerequisites 
● The same spindle motor is used for spindle mode and axis mode. 
● The same position measurement system or separate position measurement systems can 

be used for spindle mode and axis mode. 
● A position actual-value encoder is a mandatory requirement for axis mode. 
● If the axis is not synchronized, e.g. M70 is programmed after POWER ON, the axis must 

first be referenced with G74. Only then does the mechanical position match the 
programmed one. 
Example: 

 
M70 

G74 C1=0 Z100 

G0 C180 X50 

Configurable M function   
The M function used to switch the spindle to axis mode can be configured in the machine 
data: 
MD20094 $MC_SPIND_RIGID_TAPPING_M_NR   
The value on delivery is 70. 

 

 Note 
From software version 2.6, the control system detects the transition to axis mode 
automatically from the program sequence (see ""). Therefore, there is no need at all for the 
explicit programming in the part program of the configured M function for switching the 
spindle to axis mode (default: M70). However, the M function can continue to be 
programmed, e.g. to increase the readability of the part program. 
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Functionality 
If the axis mode is active and the rotary axis homed, all axis functions can be used. 
The most important functions are: 
● Programming with axis name 
● Use of zero offsets (G54, G55, TRANS, etc.) 
● G90, G91, IC, AC, DC, ACP, ACN 
● Use of kinematic transformations (e.g. TRANSMIT) 
● Interpolation with other axes (path interpolation) 
● Programming as a positioning axis 
References: 
Function Manual, Extension Functions; Rotary Axes (R2) 

Special points to be noted 
● The feed override switch is active. 
● NC/PLC IS: 

DB21, ... DBX7.7 (Reset) 
does not terminate axis mode as standard.  

● The NC/PLC interface signals: 
DB31, ... DBB16 to DBB19 and DBB82 to DBB91 
are not important if: 
DB31, ... DBX60.0 (axis / no spindle) = 0    

● Axis mode can be activated in all gear steps. 
If the position actual value encoder is installed on the motor (indirect measuring system), 
the positioning and contouring accuracy can vary for the different gear steps. 

● The gear step cannot be changed when the axis mode is active.  
The spindle must be switched to control mode.  
This is done with M41 ... M45 or M5, SPCOF. 

● In axis mode, the machine data from the servo parameter set with index zero are 
effective in order to carry out adaptations in this mode. 
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Servo parameter set 
The relevant machine data from the servo parameter set are: 
 
Machine data Meaning 
MD31050 $MA_DRIVE_AX_RATIO_DENOM   Measuring gear denominator 
MD31060 $MA_DRIVE_AX_RATIO_NUMERA   Numerator load gearbox 
MD32200 $MA_POSCTRL_GAIN   KV factor 
MD32452 $MA_BACKLASH_FACTOR   Weighting factor for backlash 
MD32610 $MA_VELO_FFW_WEIGHT   Weighting factor for feedforward control 
MD32800 $MA_EQUIV_CURRCTRL_TIME   Equivalent time constant current control 

loop for feedforward control 
MD32810 $MA_EQUIV_SPEEDCTRL_TIME   Equivalent time constant speed control 

loop for feedforward control 
MD32910 $MA_DYN_MATCH_TIME   Time constant for dynamic matching 
MD36012 $MA_STOP_LIMIT_FACTOR   Factor for exact stop coarse/fine and zero 

speed control 
MD36200 $MA_AX_VELO_LIMIT   Velocity monitoring threshold value 

Other notes on the servo parameter set: 
References: 
Function Manual, Basic Functions; Velocities, Setpoint/Actual-Value System, Closed-Loop 
Control (G2) 

Dynamic response 
The dynamic limits of the axis stored in the machine data are applicable in axis operation. 
The axis switches to the current feedforward control mode as designated by the MD and the 
commands FFWON and FFWOF. 
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Use of resolution changes 
When using resolution changes in (analog) drive actuators, the following NC program steps 
are required: 
1. Changeover to axis mode 
 
Programming Comment 

SPOS=...   

M5 ; Controller enable off (by PLC) 
→ is output on PLC 

M70 ; Switch actuator (by PLC on account of M70) 
Controller enable on (by PLC) 

C=... ; NC traverses with axis parameter set 

 
2. Switch back to spindle mode 
 
Programming Comment 

C=...   

M71 ; → Output to PLC 

Closed-loop controller enable off (by PLC) 

Switch actuator (by PLC)  

Switched to spindle parameter set (1-5) internally in 
the NC, controller enable on (by PLC) 

M3/4/5 or SPOS=... ; NC traverses with spindle parameter set 

Change to spindle mode 
The interpolation parameter (set 1 ... 5) is selected according to the currently valid gear step. 
The feedforward control function is always activated, except for tapping with compensating 
chuck.  
Machine data: 
MD32620 $MA_FFW_MODE (feedforward control type) 
must always be not equal to 0.   
Feedforward control should always be operated with the value 100% to avoid alarms being 
output during positioning. 
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Figure 18-8 Validity of parameter sets for axis and spindle modes 

Master spindle 
In order to use diverse spindle functions in one channel, like for instance  
● Revolutional feed (G95) 
● Tapping with compensation chuck (G63) 
● Thread cutting (G33) 
● Dwell time in spindle revolutions (G4 S...) 
it is necessary to define a master spindle in each channel:  
● MD20090 $MC_SPIND_DEF_MASTER_SPIND (master spindle initial setting in channel) 
The spindle number of the channel spindle which is to be the master spindle defined in 
machine data MD35000 $MC_SPIND_ASSIGN_TO_MACHAX (spindle number) is entered in 
this machine data. 

Spindle reset 
The following machine data defines whether the spindle is to remain active after reset (IS: 
DB21,... DBX7.7) or end of program (M02/M30). 
● MD 35040 $MC_SPIND_ACTIVE_AFTER_RESET (spindle active after reset) 
To cancel spindle movements, an independent spindle reset is required: 
● IS: DB31,... DBX2.2 (spindle reset) 

Literature 
Function Manual Basic Functions; Spindles 
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Appendix A
A.1 Abbreviations 
 
ACX Compressed format from XML 
ALM Active Line Module 
AS Automation System 
Command 
output disable 

Command output disable 

BERO Proximity limit switch 
BI Binector input 
BICO Binector connector 
BO Binector output 
CF CompactFlash 
CI Connector input 
CNC Computerized Numerical Control Computerized numerical control 
CO Connector output 
CoL Certificate of License 
CP  Communications Processor: Communication processor 
CPU Central Processing Unit Central processing unit 
CU Control unit 
DHCP Dynamic Host Configuration Protocol: Protocol for automatic assignment of IP addresses from a DHCP 

server to a client computer 
DIP Dual In–Line Package: dual in-line arrangement 
DO Drive objects: Drive object 
DP Distributed I/O 
DRAM Dynamic Random Access Memory 
DRF Differential resolver function: differential-synchro transmitter function 
DRIVE-CLiQ Drive Component Link with IQ 
DSC Dynamic servo control 
DWORD Doubleword 
ESD Electrostatic Sensitive Device 
EQN Designation for an absolute encoder with 2048 sine signals per revolution 
EMC Electro-Magnetic Compatibility 
EN European standard 
GC Global Control 
GSD Device master file 
GUD Global User Data 
HMI Human Machine Interface: SINUMERIK operator interface for operating, programming, and simulation 
IBN Start up 
IPO Interpolator cycle 
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JOG JOG mode: manual mode for setting up the machine 
LAN Local Area Network 
LED Light Emitting Diode: light-emitting-diode display 
LR Position controller 
LUD Local User Data 
MAC Media Access Control 
MCIS Motion Control Information System 
MCP Machine Control Panel 
MD Machine data 
MSGW Message word 
MLFB Machine-readable product designation 
MM Motor module 
MCP Machine control panel 
NC NCK 
NCK Numerical Control Kernel: NC kernel with block preparation, travel range, etc. 
NCU Numerical Control Unit: NCK hardware unit 
IS Interface signal 
NX Numerical Extension (axis extension module) 
OB Organization block 
OLP Optical Link Plug Optical link plug 
PIO Process output image 
PII Process input image  
PCU PC Unit: computer unit 
PELV Protective Extra-Low Voltage 
PG Programming device 
PLC Programmable Logic Control: programmable logic control (component of the CNC controller) 
PUD Global Program User Data 
PD Process date 
RAM Random Access Memory: Random Access Memory (can be read and written) 
RDY Ready 
REF Reference point 
RES Reset 
RTCP Real Time Control Protocol 
SD Setting Data 
SH Safe standstill 
SIM Single Inline Module 
SBC Safe brake activation 
SLM Solution Line Module 
SMC Sensor Module Cabinet-Mounted 
SME Sensor Module Externally Mounted 
SMI Sensor Module Integrated 
SRAM Static RAM: static RAM (battery-backed) 
STW Control word 
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GWPS Grinding wheel peripheral speed 
TCU Thin Client Unit (communication with operator panels) 
USB Universal Serial Bus 
VDE Association of Electrical Engineering, Electronics and Information Technology 
VO Voltage output 
STW Status Word 
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A.2 Feedback on the documentation 
 
This document will be continuously improved with regard to its quality and ease of use. 
Please help us with this task by sending your comments and suggestions for improvement 
via e-mail or fax to: 
 
E-mail: mailto:docu.motioncontrol@siemens.com 
  
Fax: +49 9131 - 98 2176 

Please use the fax form on the back of this page. 
 

mailto:docu.motioncontrol@siemens.com
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Glossary 

Active Line Module  
Controlled, self-commutating feed/feedback unit (with -"IGBT"s in feed/feedback direction), 
which supplies the DC link voltage for the -> "Motor module". 

CompactFlash card  
Memory card for non-volatile storage of the drive software and corresponding –> 
"Parameters". The memory card can be plugged into the –> "Control Unit" from outside. 

Control unit  
Central control module in which the closed-loop and open-loop control functions for one or 
more -> ”SINAMICS” -> ”Line Module”s and/or -> ”Motor Module”s are implemented. 
There are three types of Control Unit: 
- SINAMICS Control Units, e.g. -> ”CU320” 
- SIMOTION Control Units, e.g. -> ”D425” and -> ”D435” 
- SINUMERIK solution line Control Units, e.g. NCU710, NCU720 and NCU730 

Control Word  
Bit-coded -"Process data" word, transmitted by -> "PROFIdrive" at cyclic intervals to control 
the drive states. 

Double Motor Module  
Two motors can be connected to and operated with a Double Motor Module. 
See –> "Motor Module" –> "Single Motor Module" 
Former term: –> "Double-axis module" 

Drive  
The drive includes the motor (electric or hydraulic), the actuator (converter, valve), the 
control unit, measuring system, and supply components (line infeed module, pressure 
reservoir). 
For electric drives, a distinction is made between a converter system and an inverter system. 
With a converter system (e.g. -> "MICROMASTER 4"), from the point of view of the user the 
line infeed, actuator, and control component form a single device; with an inventor system 
(e.g. -> "SINAMICS S"), the supply is ensured by means of -> "Line Module", thereby 
realizing a DC line to which the -> "Invertors" (-> "Motor Module"s) are connected. The (–> 
"Control unit") is implemented as a separate device and connected to the other components 
by means of –> "DRIVE-CLiQ". 
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Drive component  
Hardware component connected to a –> "Control Unit" via –> "DRIVE-CLiQ", for example. 
Drive unit are for instance: -> "Motor Module"s, -> "Line Module"s, -> "Motor"s, -> "Sensor 
Module"s and -> "Terminal Module"s. 
The overall layout of a Control Unit together with the connected drive components is called -
> "Drive unit". 

Drive group  
A drive group comprises a -> "Control Unit" and the and the -> "Motor Module"s and -> "Line 
Module"s connected via -> "DRIVE-CLiQ". 

Drive object  
A drive object is an autonomous, individual software function with its own -> "Parameters" 
and may also have its own -> "Fault"s and -> "Alarm"s. Drive objects may exist by default 
(e.g. On Board I/O) can be created individually (e.g. –> "Terminal Board" 30, TB30) or also 
as multiples (e.g. –> "Servo Control"). As a rule, each drive object has its own window for 
parameterization and diagnostic purposes. 

drive parameters  
Parameters of a drive axis that include, for example, the parameters of the corresponding 
controllers, as well as the motor and encoder data. The parameters of the higher-level 
technology functions (positioning, ramp-function generator), however, are called –> 
"Application Parameters". 
See –> "Basic Unit System". 

Drive system  
The drive system includes all the components in a product family (e.g. SINAMICS). A drive 
system comprises, for example, -The drive system includes all the components in a product 
family (e.g. SINAMICS). A drive system comprises, for example, SINAMICS. A drive system 
comprises -> "Line Module"s, -> "Motor Module"s, -> "Sensors", -> "Motors", -> "Terminal 
Module"s and -> "Sensor Module"s as well as additional components (reactors, filters, 
cables, etc.). 
See -> "Drive unit" 

Drive unit  
The drive unit includes all the components connected via –> "DRIVE-CLiQ" that are required 
for carrying out a drive task: -> "Motor Module" –> "Control Unit" –> "Line Module" and the 
required –> "Firmware" and –> "Motor"s, but not additional components, such as filters or 
reactors. 
Several –> "Drive"s can be implemented in a drive unit. 
See –> "Drive System". 

DRIVE-CLiQ  
Abbreviation of "Drive Component Link with IQ". 
Communication system for connecting the different components of a SINAMICS drive 
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system (e.g. -> "Control Unit", -> "Line Module"s, -> "Motor Module"s, -> "Motor"s, and 
speed/position sensors. 
The DRIVE-CLiQ hardware is based on the Industrial Ethernet standard with twisted-pair 
lines. The DRIVE-CLiQ line provides the transmit and receive signals, as well as the +24 V 
power supply. 

DRIVE-CLiQ Hub Module Cabinet  
The DRIVE-CLiQ Hub Module Cabinet (DMC) is a star coupler for multiplying –> "DRIVE-
CLiQ sockets. The DMC can be clipped onto a rail. The DMC20 is available, for example: 
See –> "Hub" 

Encoders  
An encoder is a measuring system that captures actual values for the speed and/or 
angular/position values and makes them available for electronic processing. Depending on 
the mechanical construction, encoders can be integrated in the –> "Motor" (–> "Motor 
Sensor") or mounted on the external mechanics (– "External Sensor"). Depending on the 
type of movement, a distinction is made between rotary sensors ("rotary transducers") and 
translatory sensors (e.g. - Linear Sensors). In terms of measured value provision, a 
distinction is made between –> "Absolute Sensor"s (code sensors) and –> "Incremental 
Sensors"s. 
See –> "Incremental Sensor TTL/HTL" –> "Incremental Sensor sin/cos 1 Vpp" –> "Resolver". 

External Encoder  
Position encoder that is not built in or mounted on the –> "Motor", but fitted instead via a 
mechanical transmission element or mechanical intermediate element. 
The external encoder (see –> "Externally-Mounted Sensor") is used for –> "Direct Position 
Detection". 

Hub 
Central connection device in a network with star-shaped topology. A hub distributes 
incoming data packages to all connected end devices. 
See –> "DRIVE-CLiQ Hub Module Cabinet" (DMCxx)  

Line Module  
A Line Module is a power component that generates the DC link voltage for one or more –
> "Motor Module"s from a 3-phase mains voltage. 
In SINAMICS, the following three types of Line Module are available: 
–> "Basic Line Module", –> "Smart Line Module" –> "Active Line Module". 
The overall function of an infeed, including the required additional components like –> "Line 
Reactor", proportional computing power in a –> "Control Unit", switching devices, etc., is 
called –> "Basic Infeed", –> "Smart Infeed", and –> "Active Infeed". 
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Motor  
For the electric motors that can be driven by –> "SINAMICS", a basic distinction is made 
between rotary and linear motors with regard to their direction of motion, and between 
synchronous and induction motors with regard to their electromagnetic operating principle. In 
SINAMICS, the motors are connected to a –> "Motor Module". 
See –> "Synchronous Motor" –> "Induction Motor" –> "Built-In Motor" –> "Motor Encoder" -
> "External Encoder" –> "Third-Party Motor". 

Motor Encoder  
A –> "Sensor" (e.g. –> "Resolver", –> "Incremental Sensor TTL/HTL", or –> "Incremental 
Sensor sin/cos 1 Vpp" that is integrated in or attached to the motor. 
The sensor detects the motor speed. In the case of synchronous motors, it can also detect 
the rotor position angle (of the commutation angle for the motor currents). 
For drives without an additional –> "Direct Position Measuring System", it is also used as a –
> "Position Sensor" for position control. 
In addition to the motor encoders, –> "External Sensor"s for –> "Direct Position Sensing" are 
available. 

Motor Module  
A Motor Module is a power component (DC-AC inventor) that supplies the power for the 
connected motor(s). 
Power is supplied through the –> "DC Link" of the –> "Drive Unit". 
A Motor Module must be connected to a –> "Control Unit" via –> "DRIVE-CLiQ". The open-
loop and closed-loop control functions for the Motor Module are stored in the Control Unit. 
–> "Single Motor Module"s and –> "Double Motor Module"s are available. 

Option Slot  
Slot for an optional module (e.g. in the –> "Control Unit"). 

Parameters  
Variable quantity within the drive system that the user can read and, in some cases, write. 
For –> "SINAMICS", all specifications defined in the –> "PROFIdrive" profile are defined by a 
parameter. 
See –> "Visualization Parameters" and –> "Adjustable Parameters". 

PROFIBUS  
Field bus to IEC 61158, Sections 2 to 6. 
The abbreviation "DP" is no longer included because PROFIBUS FMS is not standardized 
and PROFIBUS PA (for Process Automation) is now part of the "general" –> "PROFIBUS". 
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Sensor Module  
Hardware module for evaluating speed/position encoder signals and providing detected 
actual values as numerical values at a -> DRIVE CLiQ Socket". 
Three mechanical Sensor Module variants are available: 
- SMCxx = Sensor Module Cabinet-Mounted 
- SME = Sensor Module Externally Mounted (with a high degree of protection) 

Servo Control  
For -> "Motor"s equipped with a -> "Motor Encoder", this control type allows operation with a 
high level of -> "Accuracy" and -> "Dynamic Response". 
In addition to speed control, position control can also be implemented. 

Servo Drive  
An electric servo drive comprises a motor, a –> "Motor Module", a –> "Servo Control" and, in 
most cases, a speed and position –> "Sensor" 
Electric servo drives are normally extremely precise and have a high dynamic response. 
They are designed for cycle times to less than 100 ms, and often have a short-time overload 
capacity, which enables quick acceleration. Servo drives are available as rotary and linear 
drives and are used for machine tools, handling robots, and packaging machines. 

SITOP Power  
Components for –> "Electronics Power Supply". 
Example: 24 V DC 

Smart Line Module  
Unregulated line infeed/feedback unit with a diode bridge for the infeed and stall-protected, 
line-commutated feedback via -> "IGBT"s. 
The Smart Line Module supplies the DC link voltage for the -> "Motor Module"s. 

Status Word  
Bit-coded -> "Process data" word, transmitted by -> "PROFIdrive" at cyclic intervals to 
control the drive states. 

Supply  
Input component of a converter system for generating a DC link voltage to supply one or 
more -> "Motor module"s, including all the required components (e.g. -> "Line module"s, 
fuses, reactors, line filters, and firmware, as well as proportional computing power (if 
required) in a -> "Control unit". 
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Vector Control  
Vector control (field-oriented control) is a high-performance control type for induction 
machines. It is based on an exact model calculation of the motor and two current 
components that simulate and accurately control the flux and torque by means of software 
algorithms, thereby enabling predefined speeds and torques to be observed and limited 
accurately and with a good dynamic response. 
Two vector control types exist: 
Frequency control (–> "Sensorless Vector Control") and speed-torque control with speed 
feedback (–> "Sensor"). 
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Index 

8 
840Di sl, 311 

A 
Absolute encoders, 173 

Calibration of multiple axes, 175 
Operator-assisted calibration, 174 
Recalibration, 175 

Absolute measuring systems 
Parameterization, 138 

Acceleration, 150 
Checking, 150 

Actual value inversion, 141 
Assign axis, 106 
Assigning actual-value channels, 375 
Assigning setpoint channels, 375 
Assignment 

General and axis-specific machine data, 104 
Automatic servo optimization, 224 

Axis selection, 224 
Controller data overview, 224 
Measurement, 224 
Options, 224 
Park position, 224 
Reconfigure measurement, 224 
Strategy selection, 224 

Automation License Manager, 313, 322 
Axis 

Monitoring functions, 158 
Parameter sets, 132 
Reference point approach, 166 
Velocity matching, 155 

Axis configuration, 367 
Axis selection, 224 

B 
BICO connections on the HMI, 340 
Brake behavior OFF3, 222 

C 
CF card, 311, 315 

Changing the password, 364 
Changing topology, 243 
Channel axes, 366 
Circularity test, 198 
Clamping tolerance, 159 
CoL, 311, 315 
Cold restart, 376 
Communication parameters, 324 
CompactFlash card, 315 
Computational resolution, 110 
Contour monitoring, 163 
Control direction, 147 
Control image (offline), 333 
Control system (online), 322, 328, 333 

Switchover, 326, 328 
Controller data overview, 224 
Current control loop 

Measurement, 202 
Customer login, 314 
Cycle times, 122 

D 
Data backup DRIVE-CLiQ motors, 232 
DB 31, ... 

DBB16-19, 382 
DBB82-91, 382 
DBX60.0, 382 

DB21, ... 
DBX7.7, 382 

Deleting the password, 365 
Detailed view, 45 
Direct access, 314 
Display resolution, 110, 111 
Distancecoded reference marks, 170 
Download to target system, 334 
drift compensation, 154 
Drive components, 337 
Drive object, 337 
Drive states, 268 
DSC, 140 
Dynamic monitoring functions, 161 

Velocity monitoring, 162 
Dynamic servo control, 140 
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E 
Encoder Monitoring 

Cut-off frequency, 164 
Cyclic monitoring of position tolerance, 165 
Position tolerance when switching over the 
encoder, 165 
Zero mark monitoring, 164 

Encoder types 
Absolute measuring system, 138 

Endlessly rotating rotary axis, 142 
EQN 1325, 138 
Ethernet connection, 313 
Exact stop 

Coarse, 158 
Fine, 158 

external HMI, 15, 17 

F 
Factory settings, 68 
Firmware version drive components, 273 
Firmware version measuring systems, 273 
Function Overview, 321 

G 
GEAR_STEP_PC_MAX_VELO_LIMIT, 179 
Geometry axes, 366 

H 
Hardware, 311 
Hardware limit switches, 160 
Hardware reference, 316 
Hardware serial number, 311, 315 
Hirth axes, 145 
HMI Advanced, 17, 315, 324 
HMI basic software, 322, 324 
HMI Embedded, 16 
HW-Config, 45 

I 
Identification of the ALM, 275 
Incremental measuring systems 

Parameter ization, 134 
Indexing axes, 145 
Indexing position tables, 145 
Input limits, 111 
Input resolution, 110 

Inputs/outputs, 298 
Installed components, 322 
Interface signals, 41 
Interlock, 363 
internal HMI, 15 
Internal HMI, 16 
Internet, 333 
Internet connection, 329 
Interpolation cycle, 124 
Intranet, 329 
Intranet connection, 313 
IP address, 325 

J 
JOG axis velocity, 155 

K 
Key 

*, 327 
F5, 327 

KV factor 
Definition, 148 

L 
License, 311 
License database, 313, 314 
License information, 315, 328 
License key, 312 
License Key, 316 

copying, 316 
SINUMERIK, 316 

License number, 311 
License requirement, 328 
Linear axis 

With linear scale, 136 
With rotary encoder on motor, 134 
With rotary encoder on the machine, 135 

Linear measuring system, 136 

M 
M70, 381 
Machine axes, 366 
Machine data 

Changing scaling, 117 
Loading of default data, 118 
Normalization of physical quantities, 113 

Manufacturer-specific telegrams, 342 
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Max. axis velocity, 155 
MCI board, 311 
MD10000, 368 
MD10002, 368 
MD10050 $MN_SYSCLOCK_CYCLE_TIME, 126 
MD1061 $MD_POSCTRL_CYCLE_TIME, 126 
MD1070 $MD_IPO_SYSCLOCK_TIME_RATIO, 126 
MD1071 $MD_IPO_CYCLE_TIME, 126 
MD11640, 369 
MD20050, 370 
MD20070, 368, 369, 370 
MD20080, 368 
MD20094, 381 
MD24110, 370 
MD24120, 370 
MD31050, 383 
MD31060, 383 
MD32200, 383 
MD32452, 383 
MD32610, 383 
MD32620, 384 
MD32800, 383 
MD32810, 383 
MD32910, 383 
MD35020, 380 
MD35030, 380 
MD36012, 383 
MD36200, 383 
Measurement of autom. servo optimization, 224 
Measurement of speed control loop, 204 
Measuring functions, 198, 199 

Cancel, 201 
Start, 200 

Measuring system switchover 
Interface signals, 376 

Menu command 
Connect to target system, 323 
Download to target system, 334 
Edit, 323 
PlugIn SINUMERIK, 323 
Refresh, 327 
Upload from target system, 330 
View, 327 

MMC.INI, 324 
Modular machine, 243 
Modulo axis, 142 
Modulo display, 142 
My Computer, 327 

N 
NC utilization, 126 

O 
Option, 312 
Options for autom. servo optimization, 224 
Overview of functions, 321 

P 
Parameter sets of the position controller, 132 
Park position, 224 
Peer-to-Peer, 313 
Position control loop 

Measurement, 207 
Overshoots, 150 
Reference frequency response, 209 
Setpoint step change, 210 
Step height, 211, 212 

Position controller cycle, 122 
Positioning accuracy of the control system, 121 
Positioning axes, 144 
Process data 

Actual values: G1_XACT1, 346 
Actual values: G1_XACT2, 346 
Actual values: G2_XACT1, 346 
Actual values: G2_XACT2, 346 
Actual values: G3_XACT1, 346 
Actual values: G3_XACT2, 346 
Actual values: NACT_A, 346 
Actual values: NACT_B, 346 
Control words: A_STW1, 345 
Control words: STW1, 345 
Control words: STW2, 345 
Control words:G1_STW, 345 
Control words:G2_STW, 345 
Control words:G3_STW, 345 
Setpoints: NSET_A, 345 
Setpoints: NSET_B, 345 
Setpoints: TRQRED, 345 
Setpoints:KPC, 345 
Setpoints:XERR, 345 
Status words: A_ZSW1, 346 
Status words: G1_ZSW, 346 
Status words: G2_ZSW, 346 
Status words: G3_ZSW, 346 
Status words: MELDW, 346 
Status words: ZSW1, 346 
Status words: ZSW2, 346 

Process data for receiving, 345 
Process data for sending, 346 
Product, 312 
Protection levels, 362 

for machine data, 363 
Influence via softkeys, 364 
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PTP link, 313, 329 
Pulse multiplication factor, 180 

R 
Ramp-up time, 323 
Rapid traverse in the JOG mode, 155 
Reference point approach, 166 
Resolutions, 110 
Rotary axes 

Drive Optimization, 142 
Rotary axis 

With rotary encoder on motor, 135 
With rotary encoder on the machine, 136 

Rotary measuring system, 134 

S 
safe operation, 21 
Safety Integrated, 13 
Section, 324 
Servo gain, 148 

Checking, 149 
Servo trace, 198 
Setting data 

Normalization of physical quantities, 113 
Setting the axis-specific setpoint parameters, 375 
Setting the axis-specific setpoint/actual value 
parameters, 375 
Setting the password, 364 
Signal distortion, 163 
SIMATIC, 322 
SIMATIC Manager, 39 

start, 39 
SIMATIC S7 project, 41 
SinuCom Update Agent, 232 
SINUMERIK 840Di sl, 311 
SINUMERIK plug-in, 322, 324 

enable/disable, 323 
Software limit switches, 160 
Software product, 311 
Speed adjustment, 222 
Speed setpoint matching, 152 
Speed setpoint monitoring, 161 
spindle 

modes, 379 
Spindle 

Encoder matching, 180 
Gear stages, 179, 182 
Measuring systems, 180 
Monitoring functions, 189 
Parameter sets, 132, 179 

Positioning, 185 
Setpoint matching, 183 
setpoint/actual value channels, 178 
Synchronization, 187 
Velocities, 182 

Spindle data, 192 
Standard telegrams, 342 
Static monitoring functions, 158 
Strategy selection, 224 
Switching over the measuring system, 119 
System basic cycle, 122 
System data, 110 
System requirements, 322 
System resources, 126 
System software SINAMICS S120, 272 

T 
TCP/IP, 313 
Telegram assignment, 303 
Telegrams 

Manufacturer-specific, 342 
Standard, 342 

Telegrams for receiving, 343 
Telegrams for sending, 344 
Terminal assignment 

Inputs/outputs, 298 
Support on the HMI, 298 
X122, 294, 297 
X132, 296 

Thread 
Tapping/thread cutting, 132 

Toolbox, 27 
Topology of individual drive components, 267 
Transfer license information 

Drag-and-drop, 333 
using menu commands, 334 

Traversing direction, 147 
traversing ranges, 121 

V 
Velocities, 128 

Max. axis velocity, 128 
Max. tool path velocity, 128 
Maximum spindle speed, 128 
Upper limit, 128 
Voltage limit, 129 

Velocity monitoring 
Actual, 162 
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W 
Working area limitation, 159 

Z 
Zero speed tolerance, 158 
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